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Предисловие

Обзор
В этой главе описывается структурная организация данного руководства и
разъясняется где можно найти необходимую информацию.

Торговые марки
Следующие наименования являются зарегистрированными торговыми
марками Siemens AG:

•  SIMATIC

•  SIMATIC HMI

•  HMI

•  ProTool/Pro

•  ProTool

•  ProTool/Lite

•  ProAgent

•  SIMATIC Multi Panel

•  MP270

•  SIMATIC Multifunctional Platform

1
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1.1 Как использовать данное руководство

Содержание
В данном руководстве приводятся все сведения, необходимые для того,
чтобы

•  инсталлировать и конфигурировать ProTool

•  конфигурировать операторский терминал в соответствии с
функциональными требованиями

•  закачивать исполняемый файл проекта в систему и тестировать его

•  управлять проектами

Необходимые знания и навыки
В данном руководстве предполагается, что Вы имеете опыт работы с
приложениями Windows®. В связи с этим, приведенная в руководстве
информация ограничивается описанием функций и процедур,
выполняемых в ProTool, не затрагивающих уровень работы операционной
системы.

Также подразумевается, что Вы имеете общее представление о
конфигурации используемого PLC, например, SIMATIC S5 или SIMATIC
S7.

Структура руководства
Главы данного руководства расположены по темам в следующем
порядке:

•  Во Введении разъясняются преимущества конфигурационного
пакета ProTool и показывается насколько легко с его помощью можно
создать исполняемый файл проекта для операторского терминала.

•  В главе Инсталляция и конфигурирование ProTool изложены
требования, которым должна удовлетворять Ваша система, а также
описывается, как интегрировать ProTool в STEP 7 и как
инсталлировать ProTool на конфигурационном компьютере.

•  В главе Создание проектов перечисляются основные аспекты,
которые стоит принять во внимание перед созданием проекта и
основные составляющие самого проекта. Здесь также объясняется,
для каких задач используются различные области данных PLC,
задаваемые в ProTool указателями областей.

•  В главе Приемы конфигурирования показывается, как
конфигурировать элементы управления и отображения, как
осуществлять руководство оператором терминала и предоставлять
информацию о состоянии процесса. Кроме того, Вы узнаете, как
просматривать информацию о проекте, определять полномочия
операторов и создавать многоязычные проекты.
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•  В главе Тестирование проектов объясняется, как проверить
результаты Вашей работы. Здесь показывается, как
откомпилировать Ваш проект, получить исполняемый файл и
закачать его в систему.

•  В главе Документирование и управление проектами дается
описание менеджера проектов. Здесь показывается, как, например,
распечатать данные проекта.

•  И, наконец, в Приложении более подробно описаны системные
ограничения и дан обзор документации SIMATIC HMI.

Другие источники информации
•  Большее количество примеров с пояснениями и справочным
материалом, например, по функциям, библиотекам и драйверам PLC
Вы найдете в онлайновой справке.

•  Информацию по конкретным устройствам следует искать в
соответствующих технических руководствах.

•  Подробная информация о пакете визуализации ProTool/Pro RT
приведена в руководстве пользователя среды исполнения ProTool/Pro
(ProTool/Pro Runtime User's Guide).

•  Основы организации связи между операторским терминалом и PLC
изложены в руководстве пользователя по связи в системах на базе
Windows (Communication for Windows-based Systems User's Guide).

•  В ознакомительном файле ProTool ReadMe содержатся важные
замечания по установке и конфигурированию.
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1.1.1 История

Данное руководство описывает конфигурирование систем на базе
Windows при помощи ProTool.

Различные издания руководства пользователя соответствуют следующим
версиям ProTool:

Версия от 07/98 Конфигурирование систем на базе Windows
Действительно для ProTool/Pro CS 5.0 и выше

Версия от 01/99 Добавление MP270 и редакторская переработка
руководства.
Программное обеспечение работает в Windows® 95,
Windows® 98, and WindowsNT® 4.0 и выше.
Действительно для ProTool/Pro CS 5.1 и выше

Версия от 12/99 Расширение и добавление новых операторских
терминалов.
Программное обеспечение работает в Windows® 95/98,
Windows® 2000 and WindowsNT® 4.0 и выше.
Действительно для ProTool/Pro CS 5.2 и выше

1.1.2 Нотация

Для удобства читателя в руководстве используется несколько различных
форматов текста.

Output Текст, напечатанный шрифтом Courier, представляет
входные и выходные данные, отображаемые на экране
операторского терминала.

F1 Названия клавиш выделяются жирным шрифтом.

File → Edit Пункты меню выделяются курсивом. Последующие
уровни отделяются стрелками. Всегда приводится
полная последовательность пунктов меню, ведущая к
последнему искомому элементу.

Диалоговое окно
Messages

Названия диалоговых окон, закладок и кнопок
выделяются курсивом.
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1.2 Другие источники информации

Горячая линия поддержки клиентов SIMATIC
Круглосуточная поддержка по всему миру:

Johnson City

Nuremberg

Singapore

SIMATIC Basic Hotline

Нюрнберг
Горячая линия
SIMATIC BASIC

Джонсон–Сити
Горячая линия
SIMATIC BASIC

Сингапур
Горячая линия SIMATIC
BASIC

Местное время:
Пнд - Птн 7:00 – 17:00
Тел.:
+49 (911) 895-7000
Факс:
+49 (911) 895-7002
E-mail:
simatic.support@
nbgm.siemens.de

Местное время:
Пнд – Птн 8:00 – 19:00
Тел.:
+1 423 461-2522
Факс:
+1 423 461-2231
E-mail:
simatic.hotline@
sea.siemens.com

Местное время:
Пнд – Птн 8:30 – 17:30
Тел.:
+65 740-7000
Факс:
+65 740-7001
E-mail:
simatic.hotline@
sae.siemens.com
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Привилегированная
горячая линия
SIMATIC Premium

(на платной основе,
доступна только при
наличии карточки
SIMATIC)
Время:
Пнд – Птн 0:00 – 24:00
Тел.:
+49 (911) 895-7777
Факс:
+49 (911) 895-7001

Онлайновые службы поддержки клиентов SIMATIC
Онлайновые службы поддержки клиентов SIMATIC предоставляют
исчерпывающую дополнительную информацию по продуктам SIMATIC.

•  Регулярно обновляемая общая информация доступна

− в Internet на http://www.ad.siemens.de/simatic

− по факсу 08765–93 02 77 95 00

•  Регулярно обновляемая информация по продуктам и загружаемые
файлы  для практического использования могут быть получены

− в Internet на http://www.ad.siemens.de/support/html-00/

− на электронной доске объявлений (BBS) в Нюрнберге (Почтовый
ящик службы поддержки клиентов SIMATIC)
по +49 (911) 895–7100.

 Для подключения к почтовому ящику Вы должны использовать
модем со скоростью передачи до V.34 (28.8 kbd) со следующими
настройками: 8, N, 1, ANSI, или Вы можете подключиться по ISDN
(x.75, 64 kbit).
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2.1 Что такое ProTool?

Конфигурирование Windows–систем
ProTool/Pro состоит из системы конфигурирования ProTool/Pro CS
(Configuration System)  и пакета для визуализации технологического
процесса ProTool/Pro RT (Runtime).

•  Конфигурационное ПО

 ProTool/Pro CS служит для конфигурирования на PC под управлением
Windows® 95, Windows® 98 или Windows® NT.

 Данное ПО используется для конфигурирования всего семейства
устройств. Независимо от того, для какого устройства Вы создаете
проект, ProTool предоставляет Вам всегда одинаковый, знакомый
интерфейс.

•  Среда исполнения для визуализации процесса

 ProTool/Pro RT служит для исполнения сконфигурированного проекта в
Windows® 95, Windows® 98 или Windows® NT. ProTool/Pro RT может
запускаться как на обычном PC, так и на OP37/Pro.

 Среда исполнения ProTool/Pro RT защищена программным способом.
Это означает, что каждая инсталляция среды исполнения на PC
требует наличия прав для запуска в режиме без ограничений, в
противном случае ProTool/Pro RT запустится в демонстрационном
режиме.

Замечание
Лицензия не требуется для следующих устройств: TP170A, MP270,
OP37/Pro, FI25, FI45, PC670 и PC670T.
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Пример системы:

PLC

PC

ProTool/Pro CS

PC

ProTool/Pro RT

Пример: один PC для конфигурирования, второй используется в качестве
операторского терминала:

Гибкость и простота использования ProTool
Графический интерфейс пользователя ProTool/Pro CS позволяет легко
создавать объектно–ориентированные, символьные проекты с помощью
мыши. Никаких специальных познаний в области программирования не
требуется. ProTool/Pro предоставляет следующие возможности:

•  Удобную систему визуализации процесса с большим выбором
стандартных элементов: полей ввода/вывода, гистограмм, графиков
трендов, растровой и векторной графики и динамических атрибутов.

•  Интегрированную систему сообщений

•  Архивацию переменных процесса и сообщений

•  Пользовательские функции на основе Visual Basic Script®

•  Драйвера для связи с SIMATIC S5, SIMATIC S7, SIMATIC 505 и
множества PLC других производителей.
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ProTool и SIMATIC STEP 7
ProTool может быть интегрирован в конфигурационное ПО SIMATIC
STEP 7, позволяя таким образом использовать символы и блоки данных
как теги в ProTool. Это не только экономит время и деньги, но также
уменьшает возможность ошибок при повторном вводе одних и тех же
данных.

Дополнительную информацию о конфигурировании ProTool с SIMATIC
STEP 7 можно найти в руководстве Конфигурирование в ProTool,
интегрированном в STEP 7 (Configuring with ProTool integrated in STEP 7)
(Глава 3.2).

Автономное конфигурирование
В ProTool редактирование проектов происходит автономно. Устройство в
этот момент не обязательно должно быть доступно. Конфигурационный
компьютер отображает данные проекта так, как они отображались бы
устройством.

После того, как конфигурирование завершено, исполняемый файл
проекта может быть загружен из конфигурационного компьютера в
целевое устройство.
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2.2 Что поставляется с ProTool

Драйверы PLC
Стандартный комплект поставки включает драйверы для следующих PLC:

•  PLC производства Siemens
− SIMATIC S5
− SIMATIC S7
− SIMATIC 505
− SIMATIC WinAC (версии 2 или выше)

•  сети OPC

•  PLC других производителей:
− Allen–Bradley DF1
− MITSUBISHI FX
− Telemecanique Uni–Telway

Примеры проектов
ProTool поставляется с готовыми проектами для различных PLC.

Для систем на базе Windows специально приведены примеры для
SIMATIC S7–300/400, для PC и MP270.

Примеры находятся в каталоге ProTool ..\SAMPLES. Также там находятся
соответствующие программы PLC. Каждому примеру проекта
сопоставлена своя программа PLC.

Библиотеки
После установки ProTool в каталоге ..\Library должны находиться
следующие библиотеки:

•  PC–Dynamic–Objects.lib
•  PC–MP–Pipes–and–more.lib
•  PC–MP–Switches.lib
•  Symbol–bmp.lib

Данные библиотеки открываются в окне редактора с помощью Edit →
Libraries → Open. (Правка→ Библиотеки → Открыть)

Microsoft® Visual Basic® Script
VBScript используется для создания пользовательских функций и
скриптов.
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2.3 Азы конфигурирования систем на базе Windows

Если Вы не знакомы с визуализационным ПО ProTool/Pro, мы
рекомендуем Вам прочитать это краткое введение и начать работу с
ProTool/Pro с помощью примера. Печатная версия поставляется с данным
руководством.

Требования к работе и краткое введение
Для выполнения упражнений с ProTool/Pro CS Вам понадобятся

•  PC в качестве конфигурационного компьютера

•  пакет программ SIMATIC ProTool/Pro 5.2

 ProTool/Pro включает конфигурационное ПО ProTool/Pro CS и среду
исполнения  ProTool/Pro RT.

•  операторский терминал, например, OP37/Pro.

Другие документы по ProTool/Pro CS
Вы найдете электронные руководства на ProTool CD в каталоге:
Docs\..\UsersManual_Win.pdf

Всю информацию, содержащуюся в данном руководстве, Вы сможете
найти в онлайновой справке к ProTool.
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Инсталляция и конфигурирование
ProTool

Введение
В данной главе Вы узнаете

•  какие требования предъявляются к конфигурационному компьютеру и

•  как инсталлировать ProTool.

3
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3.1 Инсталляция ProTool

Системные требования
В приведенной ниже таблице перечислены рекомендуемые системные
требования для работы с конфигурационным ПО  ProTool.

Компонент Рекомендации

CPU Pentium 133 MHz

Оперативная память 64 MB

Свободное место на диске 150 MB для ProTool/Pro CS
20 MB для ProTool/Pro RT
5 MB для каждого последующего языка

Привод CD–ROM

Операционная система Microsoft  Windows  95 с Service Pack 1
(Build 950a)
Microsoft  Windows  95 OSR 2 (Build 950b)
Microsoft  Windows  98
Microsoft  Windows NT  4.0 с Service Pack
3
Microsoft  Windows  2000

Примечание
Service Pack 1 не нужно инсталлировать в Windows 95 OSR 2 (Build
950b) или выше.

Интеграция в STEP 7
Если у Вас установлен пакет STEP 7 версии 4 и выше, Вы также можете
интегрировать ProTool в STEP 7.

Это дает следующие преимущества:

•  Вы можете управлять проектами ProTool используя SIMATIC Manager
(т.е. ту же программу, что и для управления проектами STEP 7).

•  Вы можете использовать символы и блоки данных STEP 7 из таблицы
символов S7 как теги. Тип данных и адрес в данном случае
проставляются автоматически.

•  ProTool отображает список всех PLC в Вашем проекте STEP 7 и, после
выбора PLC, определяет соответствующие параметры адреса.

•  В STEP 7 Вы можете конфигурировать сообщения ALARM_S и
выводить их на операторский терминал.

Выбор языков
Программа инсталляции спрашивает Вас об опциях и языках, которые
следует установить.
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Если Вы хотите совместно использовать несколько языков, выберите при
инсталляции опцию User defined (Определяется Пользователем). Вы
сможете сменить язык ProTool позднее без повторной инсталляции
ProTool запустив Start → Simatic → ProTool CS → ProTool Setup (Пуск → 
Simatic → ProTool CS → Установка ProTool). В процессе инсталляции
выберите язык, который Вы хотите сделать активным после инсталляции.

Инсталляция ProTool с CD–ROM
Для инсталляции ProTool выполните следующие действия:

1. Вставьте инсталляционный CD в дисковод CD–ROM. Если функция
автозагрузки для вашего CD–ROM включена, браузер запустится
автоматически как только Вы вставите CD.

 В противном случае выберите CD–ROM в Проводнике и дважды
щелкните на install.exe для запуска программы инсталляции.

2. Выберите желаемый язык инсталляции в разделе Language (Язык).

3. Выберите Installation и инсталлируйте вначале ProTool/Pro CS, а затем
ProTool/Pro RT.

 При инсталляции следуйте инструкциям на экране.

 Замечание:
При инсталляции ProTool/Pro RT убедитесь, что Вы не используете
пробелы в имени пути, если Вы устанавливаете ProTool/Pro RT не в
каталог по умолчанию.

4. Если у Вас STEP 7 версии 4 или выше, Вы также можете при
инсталляции интегрировать ProTool в STEP 7.

 ProTool при инсталляции проверяет, установлен ли STEP 7, и если он
установлен, у Вас появляется возможность выбора между Integrated
(Интегрированным) или Stand–alone (Автономным) режимами.

5. После появления соответствующего запроса установите лицензию.
Если у Вас нет лицензии в момент инсталляции, Вы можете установить
ее позже.

 Данная процедура описана в инструкциях по установке (защита ПО).

6. Перезагрузите компьютер для того, чтобы все изменения вступили в
силу.

Инсталляция ProTool с жесткого диска
Для инсталляции ProTool с жесткого диска Вы должны скопировать все
каталоги и подкаталоги, включая все файлы главного каталога, с CD на
жесткий диск.
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Инсталляция ProTool с дискет
Инсталляционные дискеты могут быть заказаны отдельно. Вы также
можете создать их сами, скопировав подкаталоги с DISK 1 по DISK n из
каталога \PROTOOL  с CD на отдельные дискеты.

Инсталляцию начните с дискеты DISK 1.

Деинсталляция ProTool
Из главного меню Windows выберите Settings → Control Panel →
Add/Remove Programs (Настройки → Панель Управления → Установка и
удаление программ), выберите ProTool и инсталлированные опции, и
нажмите Add/Remove (Добавить/Удалить).

Запуск ProTool
После инсталляции ProTool в основном меню Вы найдете каталог Simatic,
в котором находятся следующие компоненты:

ProTool Pro CS V5.20
 ProTool Help

 ProTool Pro CS

 ProTool ReadMe

 ProTool Setup

ProTool Pro RT V5.20
 ProTool Pro Disk – Transfer

 ProTool Pro RT

 ProTool Pro RT ReadMe

 ProTool Pro Simulator
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3.2 Конфигурирование в ProTool, интегрированном в
STEP 7

Требования
Если в качестве PLC Вы используете SIMATIC S7 и у Вас инсталлирован
конфигурационный пакет STEP 7, Вы можете интегрировать ProTool в
STEP 7.

Преимущества интеграции в STEP 7
Если Вы используете ту же базу данных, что и в STEP 7, у Вас
появляются следующие преимущества:

•  Вы назначаете символьное имя только один раз, и затем используете
его где угодно.

 Замечание
Если Вы используете экземпляр DB в программе STEP 7,
соответствующий экземпляр FB также должен быть определен в
таблице символов STEP 7, в противном случае данный DB не будет
предлагаться для выбора в ProTool.

•  Когда Вы конфигурируете переменные и указатели на области данных,
Вы обращаетесь к таблице символов STEP 7. Изменения в таблице
символов автоматически обновляются ProTool (см. рисунок в
Главе 5.3.2 — Свойства тегов).

•  Данные синхронизируются при компиляции проекта.

•  В STEP 7 Вы можете конфигурировать сообщения ALARM_S и
выводить их на операторский терминал.

•  Коммуникационные параметры PLC передаются в Ваш проект
автоматически.
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Пример: диалоговое окно Driver Parameters (Параметры Драйвера) для
интегрирования STEP 7

Интегрирование проектов ProTool
Проекты, созданные в ProTool как stand–alone (автономные) не могут
вызываться непосредственно из SIMATIC Manager. Для того чтобы
получить доступ к ним из STEP 7, их нужно интегрировать.

Для этого выберите пункт меню File → Integrate (Файл → Интегрировать)
в ProTool. В конфигурации STEP 7 задайте проекту ProTool имя,
отличающееся от старого.

Замечание
Наоборот, проекты, созданные в ProTool как интегрированные не должны
редактироваться в ProTool как автономные, в противном случае будет
потеряна связь с таблицей символов STEP 7.

Запуск ProTool
Запустите ProTool из Windows. Выберите File → New (Файл → Создать).
Откроется диалоговое окно, выберите в нем проект STEP 7 и создайте
проект ProTool, затем выберите операторский терминал.
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Пример диалогового окна New (Создать) для  интеграции в STEP 7
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Создание проектов

Введение
В данной главе дается общее представление о

•  структуре проекта и

•  процедуре создания проекта.

4
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4.1 Принципиальные аспекты создания проекта

Цель
Мониторинг и управление машиной или процессом. Для этого Вам
следует отобразить машину или процесс на операторском терминале
настолько точно, насколько это необходимо.

Конфигурация системы
Связь между операторским терминалом и машиной или процессом
осуществляется с использованием тегов PLC. Значение тега
записывается в область памяти (адрес) PLC, откуда оно считывается
операторским терминалом.

Приведенная ниже схема демонстрирует основную структуру:

Операторский
терминал

Принтер
Машина,
процесс

Связь через теги
PLC

Базовая схема

Выбор философии управления
Определите, какие значения процесса или состояния машины Вы хотите
отображать на операторском терминале, и какие типы объектов Вам
понадобится для этого сконфигурировать.

1. Создание пользовательского интерфейса

 Экранные формы являются центральными составляющими проекта,
с их помощью Вы визуализируете состояния машины или процесса и
определяете для них обязательные условия функционирования.
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Стартовая
экранная
форма

Экранная
форма 1

Экранная
форма 2

Экранная
форма n

Экранная
форма 3

Пример создания экранных форм

 Вы можете создать несколько экранных форм с элементами
отображения и управления для переключения между ними, например,
для формирования пользовательского интерфейса оператора.

2. Ввод и передача данных процесса

 Для ввода данных процесса и установки новых значений Вам
необходимо сконфигурировать поля ввода/вывода; для этого также
может использоваться символьный дисплей.

3. Информация о состоянии процесса

 Для ввода, архивации или занесения в протокол состояний процесса и
режимов функционирования операторского терминала используются
сообщения.

4. Определение коммуникационных областей

 Определенное адресное пространство PLC, использующееся для
обмена данными с операторским терминалом, адресуется как
указатель на область данных

 Количество доступных указателей зависит от конкретного
операторского терминала (см. Задание указателя области
(Глава 4.5)).
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4.2 Из чего состоит проект ProTool?

Когда Вы открываете новый или существующий проект, появляется окно
проекта.

Какие объекты есть в ProTool?
В окне проекта типы объектов, которые Вы можете конфигурировать,
находятся слева, а сами объекты — справа. То, какие объекты Вы
можете конфигурировать, зависит от конкретного операторского
терминала.

Различные объекты в ProTool непосредственно связаны с программами
для их редактирования.

Что отображается в окне проекта?
Данные проекта в ProTool хранятся в виде объектов. Объекты в проекте
организованы в древовидную структуру.

Окно проекта отображает типы объектов относящихся к проекту, которые
Вы можете редактировать на данном операторском терминале. Окно
проекта похоже на Проводник (Windows® Explorer). Классы объектов
содержат объекты, свойства которых Вы можете изменять.

Окно проекта организовано следующим образом:
•  Заголовок окна содержит имя проекта.
•  Левая половина экрана отображает типы объектов, которые Вы
можете конфигурировать, а содержащиеся в них объекты
отображаются в правой половине.

Пример окна проекта с тегами

Замечание
Если Вы разворачиваете (команда maximize) окно проекта, закладки
открытых окон отображаются вдоль нижнего края, позволяя Вам легко
переключаться с одного окна на другое.
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4.3 Действия по созданию проекта

Для создания проекта выполните следующие действия:

1. Создайте новый проект (File → New или File → Open) (Файл →
Создать или Файл → Открыть)

 Выберите File → New (Файл → Создать) для создания нового проекта.
Помощник проекта проведет Вас через несколько диалоговых окон.

2. Выберите PLC

 Выберите драйвер для Вашего PLC. Отображаются только те
драйверы, с которыми может быть запущен операторский терминал.

3. Помощник проекта предлагает вам ввести информацию о проекте в
резюме (summary). Если Вы нажмете кнопку Create (Создать),
откроется окно проекта.

4. Выберите области указателей (System → Area Pointers).

 Для того чтобы установить связь между операторским терминалом и
PLC, Вы должны определить области связи (Задание указателя
области (Setting up area pointers) (Глава 4.5)).

5. Создание проекта

 Это самая сложная часть работы. Вы можете выполнить ее двумя
способами: либо вначале создать отдельные части и затем соединить
их в единое целое (подход снизу → вверх), либо создать каркас и
затем заполнить его отдельными частями (подход сверху → вниз).

 Для этого Вам следует выполнить следующие действия:

− Создайте интерфейс пользователя с элементами отображения и
управления.

− Сконфигурируйте теги для того, чтобы можно было обмениваться
данными с PLC.

− Сконфигурируйте сообщения для того, чтобы получать
информацию о состоянии машины или процесса.

− Разбейте экран операторского терминала на логические части.

В зависимости от конкретного операторского терминала Вы также можете
сконфигурировать дополнительные объекты, например, скрипты.
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4.4 Выбор драйвера PLC

Выберите драйвер PLC используя Помощник в диалоговом окне Select
PLC (Выбор PLC).

В дальнейшем Вы также сможете задать или отредактировать эти
параметры выбрав PLC Properties (Свойства PLC) в окне проекта.

Доступные драйверы PLC
Вы можете выбрать следующие драйверы для систем на базе Windows:

•  SIMATIC S5 – AS511

•  SIMATIC S5 – DP

•  SIMATIC S7–300/400

•  SIMATIC S7–200

•  SIMATIC WinAC

•  SIMATIC 500/505

•  OPC

•  Allen–Bradley DF1

•  MITSUBISHI FX

•  Telemecanique Uni–Telway

Зависимость тегов
Адрес тега PLC и способ его отображения зависят от используемого PLC.

Выберите нужные типы и форматы данных в диалоговом окне Tag (Тег) в
разделе Type (Тип) или Format (Формат).
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4.5 Задание указателя области

Для чего нужны указатели областей?
Определенное адресное пространство PLC для обмена данных с
операторским терминалом адресуется при помощи указателя области.

Выберите System → Area Pointers  (Система → Указатели области) для
настройки указателей областей.

Какие бывают указатели областей?
Число доступных указателей областей зависит от конкретного
операторского терминала.

Для получения информации о том, какого размера должны быть
указатели областей, когда Вы их создаете, и о том, какую структуру они
должны иметь, обратитесь к руководству Связь в системах на базе
Windows. Руководство пользователя (Communication for Windows–based
Systems User's Manual).

Приведенная ниже вводная информация дает представление о различных
указателях областей и помогает понять их назначение. Порядок
перечисления указателей областей совпадает с их порядком в ProTool.

Указатель области Объяснение

Номер экранной
формы (Screen
number)

В этой области данных операторский терминал
хранит информацию об активной экранной форме.
Вы можете использовать эту информацию в
программе PLC, например, для того чтобы
вызывать другую экранную форму.

Сообщения о
событиях (Event
messages)

Вы можете конфигурировать сообщения о
событиях для каждого бита этой области. Биты
назначаются номерам сообщений в порядке
возрастания.

Как только PLC устанавливает бит в этой области
данных, операторский терминал определяет, что
"пришло" соответствующее сообщение. Наоборот,
операторский терминал определяет, что сообщение
"ушло", как только данный бит сбрасывается PLC.

Аварийные
сообщения (Alarm
messages)

Вы можете конфигурировать сообщения о
событиях для каждого бита из этой области. Биты
назначаются номерам сообщений в порядке
возрастания.

Как только PLC устанавливает бит в этой области
данных, операторский терминал определяет, что
"пришло" соответствующее сообщение. Наоборот,
операторский терминал определяет, что сообщение
"ушло", как только данный бит сбрасывается PLC.
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Указатель области Объяснение

Подтверждение PLC

(PLC
acknowledgement)

PLC использует эту область для информирования
операторского терминала о том, какие аварийные
сообщения были подтверждены.

Подтверждение OP

(OP
acknowledgement)

Операторский терминал использует эту область
для информирования PLC о том, какие аварийные
сообщения были подтверждены.

Назначение
светодиодов (LED
assignment)

PLC может использовать этот указатель области
для управления светодиодами функциональных
клавиш операторского терминала.

Запрос тренда
(Trend request)

PLC может использовать этот указатель области
для получения информации о том, какой тренд в
данный момент отображается операторским
терминалом.

Область передачи
тренда 1 (Trend
transfer area 1)

Данная область данных используется для
активизации трендов. Как только программа PLC
устанавливает назначенный тренду бит и
коммуникационный бит тренда в области
пересылки тренда, операторский терминал
определяет активизацию и, в зависимости от
конфигурации, считывает отдельное значение или
весь буфер.

Область передачи
тренда 2 (Trend
transfer area 2)

Данная область данных нужна при использовании
трендов с переключаемым буфером (switch buffer).
Эта область данных имеет ту же структуру, что и
область передачи тренда 1.

Согласование
(Coordination)

PLC может использовать эту область данных для
опроса состояния операторского терминала
(например, запуск операторского терминала,
нормальный режим функционирования, готовность
к связи).

Почтовый ящик
заданий (Job
mailbox)

PLC использует эту область данных для пересылки
задач в операторский терминал с целью
активизации специальных функций (например,
отображения экранной формы).

Дата/Время
(Date/Time)

Операторский терминал записывает дату и время в
этой области данных в соответствии с задачей
PLC. Программа PLC может опрашивать эти
данные.

Дата/Время PLC
(Date/Time PLC)

Операторский терминал считывает из этой области
данных установленные значения даты/времени для
синхронизации с PLC.

Дата и время должны хранится в PLC в формате
S7_DATE_AND_TIME.
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Подробную информация о структуре отдельных коммуникационных
областей можно найти в руководстве пользователя Связь в системах на
базе Windows. (Communication for Windows–based systems User's Guide).
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4.6 Разбиение экрана операторского терминала

Экран операторского терминала может быть разбит на несколько
областей.

Где настраиваются области?
Выберите System → Screen/Keys (Система → Экранная форма/Клавиши)
для настройки областей. Произведенные здесь настройки применяются ко
всему проекту, поэтому настройте области перед началом
конфигурирования.

Приведенный ниже пример демонстрирует возможный способ разбиения
экрана операторского терминала:

Индикатор
сообщения

Окно сообщений о событиях

Основная область

Назначение функциональных клавиш

Фиксированное окно

Пример разбиения экрана

Основная область
Основная область покрывает весь экран. Все остальные области
накладываются на ее части. Расположение и размер основной области
менять нельзя. Все экранные формы располагаются в основной области,
и ее содержимое, таким образом, меняется в зависимости от вызываемой
экранной формы.
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Фиксированное окно
Фиксированное окно отображается всегда. Оно использует верхнюю часть
основной области, и может быть выключено или включено выбором меню
Screen/Keys (Экранная форма/Клавиши). Если окно включено, оно
отображается вместе с экранной формой, таким образом, уменьшая
размер области, доступной для экранных форм. Размер статического окна
может быть изменен, но его расположение всегда одно и то же: в верхней
части экрана. Статическое окно конфигурируется редактором Screens
(Экранные формы).

Индикатор сообщений
Индикатор сообщений — это символ, который сигнализирует о наличии
аварийных сообщений на операторском терминале. Вы можете выключать
или включать индикатор сообщений с помощью System → Screen/Keys
(Система → Экранная форма/Клавиши). Вы не можете изменять размер
фиксированного окна , но можете изменять его расположение.

Окно аварийных сообщений
Это окно, в котором появляются аварийные сообщения. Окно открывается
только при прибытии аварийного сообщения, когда Вы его подтверждаете,
окно пропадает.

Отображение аварийных сообщений не может быть выключено. Либо
окно аварийных сообщений, либо строка сообщений обязательно должны
быть сконфигурированы.

Расположение и размер окна аварийных сообщений не может
настраиваться.

Окно сообщений о событиях
В этом окне появляются сообщения о событиях. Окно отображается
только когда вызывается соответствующая функция. Вы можете включить
или выключить окно сообщений о событиях с помощью System →
Screen/Keys (Система → Экранная форма/Клавиши). Вы можете менять
расположение окна.

Строка сообщений
Строка сообщений это область, в которой отображаются аварийные
сообщения и сообщения о событиях. Вы можете включить или выключить
строку сообщений с помощью System → Screen/Keys (Система
→ Экранная форма/Клавиши). Вы можете менять расположение строки
сообщений.
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Иконки (не на PC)
Иконки могут быть помещены на дисплей для контекстно–зависимых
клавиш (клавиш, с локальным функциональным присваиванием) FX,
расположенных вокруг экрана.

Для того чтобы узнать, как назначать клавиши глобально или локально,
обратитесь к главе Что такое функциональные клавиши? (Глава 5.2.7)
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4.7 Редактирование проектов

4.7.1 Какие проекты Вы можете конвертировать?

Windows–система →→→→ Windows–система
Вы можете использовать пункт меню File → Convert (Файл →
Конвертировать) для конвертирования проекта ProTool, который Вы
создали для другого устройства на базе Windows. Необходимо чтобы
исходное и конечное устройства имели одинаковое разрешение экрана.

Вы можете конвертировать следующие проекты:

Источник Конечное устройство (с тем же разрешением экрана):

OP37/Pro → PC, MP270

PC → OP37/Pro, MP270

MP270 → PC, OP37/Pro

TP070 → TP170

TP170 → TP070

Устройство с графическим дисплеем →→→→ Windows–система
Вы можете создавать новый проект для Windows–системы (такой, как
OP37/Pro) из существующего проекта для устройства с графическим
дисплеем (такого, как OP37). Это делается путем "перетаскивания" в окно
конечного проекта тех экранных форм и объектов, которые Вы хотите
повторно использовать. ProTool сообщит Вам, есть ли объекты или
функции, которые нельзя конвертировать.

После завершения процесса копирования Вы можете изменить порядок и
расположение отображаемых объектов экранных форм, и переназначить
функциональные клавиши.

Замечание
Глобальные назначения функциональных клавиш и сконфигурированные
указатели областей не копируются. Вы должны сконфигурировать их
вновь на конечном устройстве.

Информацию о копировании объектов можно найти в главе Копирование
объектов.
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4.7.2 Пример конвертирования проекта OP37/Pro

Для конвертирования проекта OP37/Pro в проект MP270, выполните
следующие действия:

1. Откройте существующий проект OP37/Pro.

2. Выберите пункт меню File → Convert (Файл → Конвертировать).

3. Введите начальный каталог и имя для нового проекта.

4. В Device type (Тип устройства) укажите MP270.

5. Нажмите Save (Сохранить). Если Вы подтвердите появившийся
запрос, будет произведено конвертирование проекта, после чего
откроется окно проекта MP270.

4.7.3 Пример конвертирования проекта OP37/Pro для PC

Предположим, что Вы хотите произвести конвертирование проекта OP37
для стандартного PC с другим типом соединения.

Даже если Вы используете тот же PLC, при изменении типа соединения,
адреса тегов могут быть сброшены.

Для предотвращения этого, следуйте приведенной схеме:

Источник: проект OP37 используя SIMATIC S5 L2–DP

(Промежуточный шаг 1: проект OP37 используя SIMATIC S5–AS511)

(Промежуточный шаг 2: проект PC используя SIMATIC S5–AS511)

Конечный проект: проект PC используя SIMATIC S5–DP

Выполните следующие действия:

1. Откройте существующий проект OP37.

2. Выберите PLC и с помощью Edit → Properties (Правка → Свойства)
укажите новый драйвер: SIMATIC S5–AS511.

3. Сохраните проект под новым именем.

4. Создайте новый проект для PC и в диалоговом окне Select PLC (Выбор
PLC) укажите в качестве драйвера SIMATIC S5–AS511.

5. Скопируйте все объекты из проекта OP37 в проект PC.

6. В проекте PC выберите PLC и в Edit → Properties (Правка → Свойства)
укажите новый драйвер: SIMATIC S5–DP.

7. Сохраните проект с новым драйвером.
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4.7.4 Копирование объектов внутри и между проектами

Принцип
Вы можете использовать команды вырезания и вставки для копирования
частей вашего проекта через буфер обмена. Например, Вы можете
скопировать текст и поля из редактора аварийных сообщений в редактор
сообщений о событиях, или графические элементы из одной экранной
формы в другую.

Для успешного копирования между проектами необходимо, чтобы не
были превышены системные ограничения конечного проекта.

Подготовка нового проекта
Перед запуском копирования объектов из существующего проекта Вы
должны успешно произвести приведенные ниже глобальные настройки
нового проекта. Это гарантирует, что при копировании не произойдет
утери данных из–за несоответствия настроек.

•  В System → Screen/Keys (Система → Экранная форма/Клавиши)
выполните разбиение экранных форм точно так же, как и в исходном
проекте.

•  Установите имя и драйвера PLC такими же, как и в исходном проекте.

Действия
Есть два способа вставки объектов из буфера обмена в конечный проект:

•  Команда меню Edit → Paste (Правка → Вставка)

 Объект вставляется из буфера обмена в конечный проект. Если объект
с таким именем уже есть, объект вставляется под новым именем.

•  Команда меню Edit → Paste Special (Правка → Специальная вставка)

 Вставляются только объекты, отличающиеся от имеющихся. Если в
конечном проекте уже есть идентичный объект с тем же именем, то он
и используется. Если есть объект с тем же именем, но не идентичный
объекту из буфера обмена, последний вставляется под новым именем.
Вы можете использовать этот вариант копирования, например, для
того, чтобы сделать конечный проект точной копией исходного.

Замечание
При использования Paste и Paste Special (Вставка и Специальная
вставка), ProTool всегда проверяет дочерние объекты (такие, как уставки
для копируемого тега), чтобы удостовериться в том, что объект можно
будет использовать.
Если объект с таким именем уже есть, вставляемый объект будет
переименован: ему будет дано первое свободное имя в конечном проекте.



Создание проектов

ProTool: Конфигурирование систем на базе Windows
4–16 Версия от 12/99

Пример:
Тег VAR_4 будет переименован в VAR_11, если теги с VAR_1 по VAR_10 в
конечном проекте уже есть.

Что копируется?
Вы можете копировать через буфер обмена следующие элементы:

•  Все объекты, перечисленные в окне проекта, такие, как экранные
формы, текстовые и графические списки, теги и т.д.

•  Объекты из экранных форм (тренды, поля, графику и т.д.) в редакторе
экранных форм.

•  Сообщения и объекты сообщений (тест сообщений, поля, пояснения и
т.д.) в редакторе сообщений.

Объект копируется со всеми его атрибутами и связанными объектами.
Если встречается особая ситуация, об этом появляется уведомление в
окне системных сообщений под названием Clipboard (Буфер обмена). По
этой информации можно понять, что, например, объект не был
скопирован, или был переименован.

Особые ситуации с экранными формами
Если копируемый объект относится к экранной форме, которой не
существует в конечном проекте, соответствующая экранная форма не
копируется, а вместо нее создается пустая временная экранная форма.

Это гарантирует, что Вы не скопируете по ошибке весь проект вместе со
стартовой экранной формой.

Затем, когда Вы вставляете экранную форму из буфера обмена,
временная экранная форма ей замещается.
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Что не копируется?
Не копируются следующие объекты:

•  Неизвестные в конечном проекте объекты (такие, как функции или
управляющие клавиши (command buttons) при копировании с TP27 на
OP27)

•  Указатели областей

•  Глобальные назначения функциональных клавиш

•  Наборы символов (character sets)

•  В случае многоязыкового проекта копируются только языки,
доступные в конечном проекте. Новых языков не создается.

4.7.5 Отмена и повтор действий

Назначение
В процессе конфигурации иногда возникает необходимость отменить
некоторые действия , или произвести снова те действия, которые были
отменены. Для этого используются команды Undo (Отмена)  и Redo
(Повтор) соответственно.

•  Отмена
Команда Отмена (комбинация клавиш Ctrl–Z) отменяет последнее
совершенное действие. Если Вы будете продолжать выбирать эту
команду, Вы сможете отменить до 30 произведенных изменений.

•  Redo
Команда Повтор (комбинация клавиш Ctrl–Y) повторяет последнее
отмененное действие, таким образом, возвращая то состояние,
которое имело место перед выполнением команды Отмена.
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Принцип
Каждый редактор (окно проекта, редактор экранных форм) имеет свою
историю. Например, если были открыты три окна, создаются три истории
отмены (Undo Histories). Когда экранная форма закрывается,
соответствующая история удаляется. При сохранении проекта удаляются
все истории.

Последнее записанное действие отображается в сокращенной форме в
меню. Подсказка (Tooltips) содержит более подробную информацию о
кнопках Undo и Redo и о строке статуса (status bar).

Пример:

•  Меню
Undo: VAR_5 edited

(редактирована VAR_5)
Ctrl–Z

Redo: PIC_2 edited
(редактирована PIC_2)

Ctrl–Y

•  Подсказка/Статусная строка
Undo: property edited of tag VAR_5 (редактировано

свойство тега VAR_5)
Redo: contents edited of screen PIC_2 (редактировано

содержимое экранной формы PIC_2)

Пока не удалена история отмены, удаленные объекты все еще будут
перечислены в списке перекрестных ссылок cross–reference (Глава 4.8.1)
как используемые. Статус этих объектов приводится в скобках после
каждого из них, например, PIC_5 (deleted).

Общая информация
Команды Отмена и Повтор работают только с действиями,
совершенными после последнего сохранения проекта. Например, если
Вы двигаете объект экранной формы, а затем сохраняете проект, Вы не
сможете позднее отменить это действие.

Существуют некоторые правила, применяющиеся к Отмене/Повтору:

•  Настройки в диалоговых окнах (свойствах полей) могут быть отменены
только все вместе. Нельзя открыть диалоговое окно и отменить
отдельное изменение.

•  В случае вложенных диалоговых окон записываются только изменения
основного объекта. Изменения вложенных объектов, их создание или
удаление не могут быть отменены.

 Пример (окно проекта):
Редактирование тега → Редактирование уставок тега.
Могут быть отменены только действия с тегом.

•  Отмена/Повтор в ProTool действуют только в нем. Буфер отмены
интегрированного в STEP 7 проекта недоступен для отмены из
Менеджера Step 7.
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4.7.6 Отмена последнего действия

Для отмены Вашего последнего действия в ProTool можно
воспользоваться одним из  трех перечисленных способов:

•  Выбрав команду меню Edit → Undo (Правка → Отмена).
Последнее действие, которое может быть отменено, показывается в
сокращенной форме в команде меню. Подробное описание дается в
строке статуса.

•   Нажав кнопку Отмена на панели инструментов.
При этом откроется Подсказка, в которой будет показано последнее
действие, которое можно отменить. Та же самая информация дается в
строке статуса.

•  Нажав одновременно клавиши CTRL и Z.
В отличие от предыдущих двух способов, Вам не будет показана
информация о том, какое действие отменяется.

Повторным выполнением команды Отмена Вы сможете отменить все
записанные изменения.

4.7.7 Повтор предыдущего действия

Для повтора предыдущего действия в ProTool можно воспользоваться
одним из  трех перечисленных способов:

•  Выбрав команду Edit → Redo (Правка → Повтор).
Последнее действие, которое может быть отменено показывается в
сокращенной форме в команде меню. Подробное описание дается в
строке статуса.

•   Нажав кнопку Повтор на панели инструментов.
При этом откроется Подсказка, в которой будет показано последнее
действие, которое можно повторить. Та же самая информация дается в
строке статуса.

•  Нажав одновременно клавиши CTRL и Y.
В отличие от предыдущих двух способов, вам не будет показана
информация о том, какое действие повторяется.

Повторным выполнением команды Повтор Вы сможете возвратить все
записанные отмены.
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4.8 Получение информации о проекте

4.8.1 Что отображается в окне перекрестных ссылок "Cross–
Reference"?

Использование
Когда Вы должны дополнить или модифицировать проект, и Вам нужно
узнать, где и как в проекте используются отдельные объекты, Вам следует
воспользоваться окном Cross–Reference (Перекрестные ссылки).

При выборе объекта в этом окне отображаются все ссылки на этот объект
в данном проекте.

Пример взят из проекта

Окно Cross–Reference открывается с помощью команды меню View →
Cross–Reference (Вид → Перекрестные ссылки). Активный объект
выделяется красной рамкой.

Выбранный объект отображается на верхнем уровне, а все объекты, где
он используется, отображаются под ним.

Список перекрестных ссылок содержит также информацию о текущем
состоянии объекта в истории отмены (Отмена действий (Глава 4.7.5)).
Статус объектов приводится в скобках после каждого из них, например,
PIC_5 (deleted).
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Совет
Окно Cross–Reference можно эффективно использовать для выявления
ошибок.

4.8.2 Что можно узнать в окне информации о проекте "Project
Information"?

Для получения информации о проекте при его изменении или адаптации,
откройте  диалоговое окно Project Information (Информация о проекте).
Для этого, выберите пункт меню File → Project Information.

Диалоговое окно Project Information отображает общие данные о проекте
и требуемую для проекта память. Информация о проекте
рассредоточена по трем разделам с соответствующими закладками:

•  Общая информация (General)

•  Описание (Description)

•  Статистика (Statistics)

Общая информация
Закладка General предоставляет информацию о типе устройства, имени
проекта, пути к каталогу проекта и создателе проекта. После заполнения
поля Creator (Создатель) все остальные поля заполняются ProTool
автоматически при сохранении.

Описание
Закладка Description (Описание) содержит поле ввода для описания
проекта. Здесь Вы можете ввести всю информацию о проекте, которую
считаете важной.

Статистика
Закладка Statistics показывает, когда проект был создан, изменен,
сгенерирован и загружен, версию ProTool, которая использовалась при
последнем редактировании проекта, и память, необходимую для загрузки
во flash–память операторского терминала. Требования к памяти
определяются и отображаются в соответствии с последней операцией
загрузки.

Исключение:
в случае использования устройств с текстовыми экранами OP3, OP5 и
OP15A/C, требования к памяти определяются при начальной
компиляции.
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Приемы конфигурирования

Обзор
В данной главе приводится информация о том как

•  создавать экранные формы

•  конфигурировать элементы отображения и управления

•  использовать теги

•  конфигурировать сообщения

Будут описаны приемы

•  использования функций

•  создания архивов

•  создания рецептов

•  установки авторизации оператора

•  создания многоязыковых проектов

5
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5.1 Создание экранных форм

5.1.1 Что такое экранные формы?

Пример
Экранные формы являются представлением технологического процесса.
Различные процессы могут отображаться на форме графически и в виде
набора цифровых значений. На рисунке ниже представлен пример
установки для смешивания соков. Составляющие попадают в установку
из различных баков, а затем смешиваются. На форме отображаются
уровни жидкостей в баках и в установке. Впускные клапаны могут быть
открыты и закрыты с операторского терминала. Аналогично, двигатель
установки для смешивания может быть включен и выключен.

Уровень в баке (в л)
Бак 1:
Бак 2:

Бак 3:
Разливочный агрегат:

Бак 1 Бак 2 Бак 3

Уровень в Клапан 4

в разливочный агрегат

ВЫКЛ ВКЛ

Установка для смешивания

Фиксированное окноКонтекстно-зависимая клавиша/Кнопка

Справка ESC

баке (в л)

Пример экранной формы: установка для смешивания
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Компоненты экранных форм
Экранная форма может состоять из статических и динамических
компонентов. Статические компоненты, например, текст и рисунки, не
обновляются контроллером. Динамические же компоненты связаны с PLC
и визуализируют текущие значения в памяти PLC. Визуализация может
быть реализована в виде буквенно–цифровых индикаторов, трендов и
гистограмм. Динамическими компонентами также являются поля ввода, с
помощью которых значения, вводимые оператором с операторского
терминала, попадают в память PLC. Связь с PLC осуществляется
посредством тегов (см. Использование тегов (Глава 5.3.1))

Редактор экранных форм
Экранные формы создаются с помощью отдельного редактора в ProTool.
После запуска данного редактора отображается экран операторского
терминала. Редактор экранных форм можно запустить следующими
способами:

•  двойным щелчком мыши на слове Screens (Экранные формы) в левой
половине окна проекта (при этом создастся новая экранная форма)

•  двойным щелчком мыши в правой половине окна проекта на одной из
существующих экранных форм (при этом указанная форма откроется
для редактирования).

Изображение можно увеличивать и уменьшать посредством меню View →
Zoom (Просмотр → Масштаб). Если, к примеру, необходимо
редактировать мелкие детали изображения, это значительно проще
сделать, увеличив их.

Экранные формы имеют символьное имя. Имя экранной формы можно
задать в меню Edit → Properties (Редактирование →Свойства). Данное
имя используется при редактировании, удалении и обращении к экранной
форме. В дополнение к символьному имени все экранные формы
автоматически нумеруются.

Стартовая экранная форма
Одна экранная форма в любом проекте должна быть объявлена
стартовой. Стартовая экранная форма отображается сразу после запуска
операторского терминала.

Для того чтобы сделать экранную форму стартовой, необходимо
выделить ее и установить ей соответствующий признак в меню Edit →
Properties (Редактирование →Свойства).
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Фиксированное окно
Фиксированное окно – это окно, постоянно присутствующее у верхней
границы экрана операторского терминала. Выбрав в меню System →
Screen/Keys (Система →Экран/Привязки) можно открывать/закрывать
фиксированное окно, а также редактировать его размеры с помощью
мыши. Поскольку содержимое фиксированного окна не зависит от
текущей экранной формы, оно может содержать значения наиболее
важных тегов или дату и время, к примеру.

Содержимое фиксированного окна задается с помощью редактора
экранных форм. Для доступа к фиксированному окну необходимо
щелкнуть на нем мышью.

Контекстно–зависимые клавиши/кнопки
Контекстно–зависимые клавиши – это функциональные клавиши,
привязанные к определенным экранным формам (см. Что такое
функциональные клавиши? (Глава 5.2.7)). Кнопки – это виртуальные
клавиши на экране операторского терминала (см. Что такое кнопки?
(Глава 5.2.10)). Контекстно–зависимые клавиши и кнопки создаются в
привязке к определенной экранной форме. Им присваиваются различные
функции. Назначение конкретного элемента управления может быть
проиллюстрировано с помощью текста или рисунка.

Контекстно–зависимые клавиши и кнопки могут использоваться для
переключения экранных форм, включения/выключения двигателя,
отображения буфера сообщений и др.

Переключение экранных форм
Каждая экранная форма в проекте должна быть интегрирована в систему
таким образом, чтобы она могла быть открыта в процессе исполнения
проекта на операторском терминале. Для этих целей служит функция
Select Screen (Сменить экранную форму). Данная функция может быть
назначена полю ввода, функциональной клавише или кнопке. В качестве
параметра должно быть передано символьное имя экранной формы.
Таким образом, смена экранной формы может быть осуществлена с
помощью поля ввода, функциональной клавиши или кнопки.

Функция, назначенная полю ввода, контекстно–зависимой клавише или
кнопке, может быть вызвана только локально (т.е. с соответствующей
экранной формы). Если необходимо сделать функцию доступной
глобально, надо назначить ее глобальной функциональной клавише или
кнопке, находящейся в фиксированном окне.
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5.1.2 Экранные формы в ProTool

Экранные формы состоят из отдельных объектов. Существуют различные
типы объектов, которые можно использовать как угодно. “Как угодно”
означает, что есть возможность задания количества и типа объектов, а
также их положения на форме и размера.

В следующей таблице представлены основные объекты экранных форм с
кратким описанием. Однако не все ниже перечисленные объекты могут
быть доступны для конкретного типа целевого устройства.

Объект
экранной
формы

Название Описание

Графический
элемент

Предназначен для вставки в проект
рисунков из других графических
редакторов.

Текст Предназначен для отображения
статического текста. Доступны различные
форматы текста. Возможно
использование различных шрифтов,
отображение текста в несколько строк,
вертикальное и горизонтальное
выравнивание.

Поле вывода Предназначено для прямого отображения
параметров технологического процесса.
Допустимы различные форматы
отображения, например, десятичный,
двоичный и др. Доступен ряд опций
отображения, таких как трехмерные
эффекты, цвета, мигание и т.д.

Поле ввода Предназначено для ввода значений
различных форматов с операторского
терминала. Для поля ввода могут быть
назначены уставки, ввод может быть
защищен паролем.

Дата/Время Используется для отображения в
цифровом виде и изменения системной
даты и времени.
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Символьное поле
вывода

Вместо цифрового значения символьное
поле вывода отображает текст или
рисунок, делающий текущее состояние
параметра более наглядным для
оператора.

Связь между значениями тегов и текстом
или графикой осуществляется
посредством текстового или графического
списка.

Пример:   
Вместо значений 0 и 1, можно отображать
на операторском терминале текст
Двигатель ВЫКЛ и Двигатель ВКЛ.

Список выбора Списки выбора позволяют изменять
значения тегов путем выбора
определенного пункта из текстового
списка, что делает выбор наглядным для
оператора.

Пример:
Вместо значений 0 и 1, можно предлагать
оператору выбор Двигатель ВЫКЛ и
Двигатель ВКЛ.

Графический список Графический список отображает рисунок
из списка для представления текущего
значения параметра в наглядной форме.

Пример:
Вместо значений 0 и 1, можно отображать
рисунок закрытого и открытого клапана
соответственно.

Кнопка Кнопки предназначены для вызова
присвоенных им функций посредством
щелчка мыши или с помощью сенсорного
экрана. Кнопки могут содержать
произвольный текст или рисунок.

Фиксирующаяся
кнопка

Фиксирующиеся кнопки предназначены
для отображения и изменения
параметров с двумя состояниями: ВКЛ и
ВЫКЛ или нажата и не нажата. Такая
кнопка может быть с защелкиванием или
без защелкивания.
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Переключатель Переключатели используются для ввода
и отображения параметров с двумя
состояниями. Переключатель может быть
только включен или выключен.

Невидимая кнопка Невидимые кнопки не отображаются на
экранных формах. Невидимая кнопка
может быть помещена поверх рисунка,
позволяя вызывать присвоенные ей
функции щелчком на этом рисунке.

Окно трендов В окне трендов может отображаться
несколько трендов одновременно. Окно
трендов содержит настройки для системы
координат (для осей X и Y).

Гистограмма Гистограммы отображают значение
параметров из PLC в виде
прямоугольника. Гистограммы могут
использоваться, к примеру, для
отображения уровней жидкостей.

Обзор сообщений В обзоре сообщений определяется
собственный фильтр для буфера
сообщений или архива сообщений. Для
отображения архива сообщений
необходимо настроить обзор сообщений.

Все средства отображения сообщений по
умолчанию работают с изменяемым
буфером сообщений.

Окно просмотра/
изменения
переменных
контроллера

Данный объект реализует
функциональность Тега просмотра
(Monitor Tag) и Тега изменения (Control
Tag) контроллеров SIMATIC S5 и SIMATIC
S7 (контроллером S7–200 не
поддерживается).

Данные функции используются в
основном на этапе отладки проекта.

Список паролей В ProTool есть возможность защитить
паролями операции ввода. Паролям
назначаются уровни доступа от 0 (без
пароля) до 9 (администратор).

Список паролей необходим для ввода
паролей для различных уровней доступа.

Обзор рецептов С помощью обзора рецептов
отображаются и редактируются записи на
операторском терминале.

Цифровые/
аналоговые часы

С помощью данного объекта системное
время отображается в виде часов со
стрелками или в цифровом виде.
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Бегунок Бегунок используется для ввода и
отображения числовых параметров.

Для ввода значений необходимо сместить
указатель бегунка с помощью мыши или
клавиатуры в требуемую позицию.

При отображении числового значения
указатель бегунка смещается в
соответствующую текущему значению
позицию.

Аналоговый
индикатор

Используется для отображения цифровых
значений в виде табло со стрелкой.

Объекты для векторной графики
Обзор объектов векторной графики можно найти в разделе Что такое
векторный графический элемент? (Глава 5.2.4)

5.1.3 Использование библиотек

Библиотеки – это коллекции заранее созданных объектов экранных форм.
Это могут быть рисунки, поля или группы рисунков и полей. В редакторе
экранных форм можно поместить любой объект из библиотеки на
текущую редактируемую экранную форму и изменить его. Кроме того,
можно помещать объекты с экранной формы в библиотеку.

Назначение
Библиотеки предназначены для расширения набора доступных объектов
экранных форм. Используя повторяющиеся “законченные элементы”
можно сделать работу по созданию экранных форм более эффективной.
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Стандартные библиотеки
После инсталляции системы ProTool следующие библиотеки становятся
доступны в каталоге \Library:

Имя файла Содержимое Поддерживается
устройствами

PC–Dynamic–Objects.lib Аналоговые часы,
аналоговые указатели и
бегунки

OP37Pro, FI25/45,
PC670, PC, MP270

PC–MP–Pipes–and–
more.lib

Трубы, насосы, баки и
клапаны

PC, MP270

PC–MP–Switches.lib Переключатели PC, MP270

Symbol–bmp.lib Стандартные технические
символы

все

Touch–Switches.lib Кнопки TP27, TP37

Имеется возможность добавлять новые библиотеки в указанный каталог и
затем использовать их в ProTool. Файлы должны иметь расширение
*.lib и иметь формат библиотеки ProTool.

Работа с библиотеками

Сразу после открытия экранной формы для редактирования,
становится доступным пункт меню Edit → Libraries (Редактирование
→Библиотеки) или соответствующая кнопка на панели
инструментов.

При открытии первой библиотеки активизируется окно библиотек на
экране. Открытая библиотека и все, что открывается вместе с ней,
представляется в этом окне в виде дерева.

Следующие функции доступны для работы с библиотеками:
•  Добавление дополнительных библиотек:

− Добавить файл с расширением *.lib в формате библиотеки
ProTool в каталог \Library .

− При помощи пункта меню быстрого вызова New (Новая) создать
новую, пустую библиотеку.
Сохранить библиотеку под другим именем и редактировать ее.

•  Переименование библиотеки:
Осуществляется путем переименования соответствующего файла
стандартными средствами Windows.
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•  Реструктуризация библиотеки:
Осуществляется перетаскиванием посредством мыши или с помощью
функций Windows.
Пункт меню быстрого вызова New Folder (Новая папка) используется
для добавления новой папки.
Для переименования папок или объектов библиотеки необходимо
дважды щелкнуть на них мышью или нажать F2.

•  Удаление папок и объектов библиотеки: Осуществляется с помощью
меню быстрого вызова.

•  Удаление библиотеки: Осуществляется путем удаления
соответствующего файла стандартными средствами Windows.

Замечание
Нельзя редактировать защищенную от записи библиотеку.

Редактирование объектов библиотеки
Нельзя явным образом редактировать объекты библиотеки, можно
редактировать их только в рамках проекта.

Совет
Для внесения изменений в объект библиотеки поместите требуемый
объект из библиотеки на экранную форму в проекте, отредактируйте
его там и поместите обратно в нужную библиотеку. Затем удалите
исходный объект, а новому объекту дайте прежнее имя.
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5.1.4 Определение цветов для объектов экранных форм

Категории цветов
Можно задать один или несколько цветов для каждого объекта экранной
формы в ProTool. В зависимости от объекта экранной формы, можно
настроить различные цвета, например для следующих атрибутов:

•  Фон

•  Основной цвет

•  Цвет, означающий превышение уставок

Цвета
Можно присвоить свой цвет каждому из цветовых атрибутов. Следующие
цвета доступны для этого:

•  Цвета по умолчанию
16 цветов по умолчанию всегда определены и не могут быть изменены.

•  Цвета проекта
Можно задать 8 цветов проекта по своему усмотрению. Данные цвета
будут доступны во всем проекте.
Для задания цвета проекта необходимо выбрать пункт меню Tools →
Colors (Сервис →Цвета) или нажать кнопку Colors (Цвета) на панели
инструментов и дважды щелкнуть на одном из восьми полей цветов
проекта.

•  Различные цвета
Для любого цветового атрибута может быть задан свой собственный
произвольный цвет. Этот цвет будет применен только для данного
атрибута и не будет глобально доступен.
Для выбора индивидуального цвета, на странице Color (Цвет)
щелкните на кнопке Different Color (Другой цвет).
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5.1.5 Установка шрифтов

Назначение
Для всех объектов экранных форм, содержащих статический или
динамический текст, можно задать параметры отображения текста для
выделения отдельных текстовых элементов экранной формы. К примеру,
можно задать шрифт, стиль, размер, и дополнительные эффекты, такие
как зачеркивание и подчеркивание.

Установка
Все необходимые настройки отображения текста производятся в
параметрах объекта экранной формы на странице Font (Шрифт). Для
объектов с набором различных текстов (например, обзор сообщений, окно
просмотра/изменения тегов контроллера, обзор рецептов) могут быть
заданы различные параметры для разных типов текста, например, для
заголовков и для обычного текста. Набор доступных шрифтов
определяется целевым устройством. Набор доступных параметров
шрифта определяется выбранным шрифтом.

Замечание
Параметры текста, такие как стиль (жирный, курсив и др.), эффекты
(зачеркивание, подчеркивание) всегда относятся к выбранному свойству
объекта целиком. Это означает, что, к примеру, можно отобразить все
заголовки в объекте экранной формы жирным шрифтом, но нельзя
выделить жирным отдельные буквы или слова в заголовке.
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5.1.6 Отображение и установка даты/времени

Дата и время могут быть отображены и изменены на операторском
терминале.

Замечание
Реальный формат даты и времени зависит от системных настроек
Windows.

Для этого доступны следующие средства:

•  Можно использовать объект Дата/Время для экранных форм и отчетов.
Это позволяет отображать и изменять дату и время с операторского
терминала.

•  Объект Цифровые/Аналоговые часы предназначен только для
отображения.
Существует возможность выбора между цифровой и аналоговой
формой представления.

•  Можно использовать задачи PLC 14 и 15 для получения даты/времени,
и задачи 40 и 41 для записи даты/времени в PLC.

 Полный список задач PLC можно найти в справочной системе ProTool.
•  Можно создать поле ввода/вывода, связанное с тегом в формате даты
или времени.
Таким образом, можно менять дату/время с операторского терминала
посредством поля ввода.
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5.2 Конфигурирование элементов отображения и
управления

5.2.1 Обзор элементов отображения и управления

Назначение
Элементы отображения могут использоваться для наблюдения за
какой–либо технологической установкой или системой с операторского
терминала.   Существует возможность отображения текущей
информации, такой как значения параметров из PLC, операционные
режимы и нарушения техпроцесса, в виде цифровых значений, в
символьном или графическом виде.

Элементы управления предназначены для прямого вмешательства в
ход процессов с операторского терминала. Они могут использоваться, к
примеру, для задания уставок, активизации функций, переключения
экранных форм (Что такое экранные формы? (Глава 5.1.1)) и
подтверждения сообщений. Элементам управления может быть назначен
требуемый уровень паролей с целью предотвращения
несанкционированного доступа.

Обзор
В ProTool существует два типа элементов отображения:

•  Статические элементы отображения

 Статические элементы отображения – это текст и рисунки, не
связанные с PLC. Они никак не реагируют на действия пользователя и
не могут быть изменены в процессе исполнения системы на
операторском терминале. Статические элементы отображения могут
использоваться для системных экранных форм или в качестве
пояснений к динамическим элементам отображения и элементам
управления.

 К статическим элементам отображения относятся

− Статический текст (Что такое статический текст?
(Глава 5.2.2))

− Графический элемент (Что такое графический элемент?
(Chapter 5.2.3))

− Векторный графический элемент (Что такое векторный
графический элемент? (Глава 5.2.4))
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•  Динамические элементы отображения

 Динамические элементы отображения могут быть связаны с PLC
посредством тегов. Они отображают текущие значения параметров из
PLC в символьном, цифровом или графическом виде. Динамические
элементы отображения могут менять свой вид в процессе исполнения
проекта на операторском терминале без вмешательства оператора.

 Динамические элементы отображения могут использоваться для всех
задач, связанных с мониторингом техпроцесса и системы.

 К динамическим элементам отображения относятся

− Поле вывода (Что такое поле вывода? (Глава 5.2.5))

− Гистограмма (Что такое гистограмма? (Глава 5.2.9))

− График тренда (Что такое график тренда? (Глава 5.2.8))

− Индикатор даты/времени (Что такое индикатор даты/времени?
(Глава 5.2.15))

− Цифровые/аналоговые часы (Что такое цифровые/аналоговые
часы? (Глава 5.2.16))

− Аналоговый индикатор (Что такое аналоговый индикатор?
(Глава 5.2.14))

Следующие элементы управления доступны в ProTool:

•  Поле ввода (Глава 5.2.6)

•  Функциональная клавиша (Глава 5.2.7)

•  Кнопка (Глава 5.2.10)

•  Фиксирующаяся кнопка (Глава 5.2.11)

•  Переключатель (Глава 5.2.12)

•  Бегунок (Глава 5.2.13)

С помощью динамических атрибутов (Что такое динамические
атрибуты? (Глава 5.14.4)), например, с помощью изменения цвета или
мигания элемента управления, можно отображать факт необходимости
вмешательства оператора в определенных ситуациях. Более того, можно
динамически отображать или прятать элемент управления на
операторском терминале (Скрытие объектов (Глава 5.14.3)).

Подробное описание всех шагов конфигурирования можно найти в
системе справки ProTool.
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5.2.2 Что такое статический текст?

Статический текст – это текст, никак не связанный с PLC. Такой текст не
может быть изменен в процессе исполнения проекта на операторском
терминале . Статический текст может использоваться в качестве подписей
для элементов управления и полей вывода. Отдельные текстовые строки
на экранной форме могут быть выделены посредством установки
различных шрифтов и свойств текста (размер, цвет, мигание и т.д.).

Замечание для MP270
Символ табуляции в тексте на MP270 будет заменен другим символом.

Статический текст можно сконфигурировать на любом из доступных на
операторском терминале языков.

Для конфигурирования статического текста нажмите на
изображенную иконку.

5.2.3 Что такое графический элемент?

Назначение
Графический элемент – это статический элемент отображения, не
связанный с PLC. Он не может быть  изменен в процессе исполнения
проекта на операторском терминале. Графические элементы могут
использоваться для иллюстрирования контролируемой системы или в
качестве пояснений к динамическим элементам отображения и элементам
управления.
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Создание графических элементов
В ProTool имеется возможность встраивания графических элементов из
других редакторов посредством интерфейса OLE. Таким образом,
имеется возможность создавать все графические элементы в привычных
редакторах без необходимости изучения нового редактора.

Созданный графический объект встраивается в ProTool в качестве
растрового или векторного рисунка, в зависимости от программы, в
которой он был создан.

Для конфигурирования графического элемента нажмите на
изображенную иконку.

Совет
Для создания графических элементов управления можно использовать
кнопку с графическим списком.

Представление цветов в проекте ProTool
Данная опция доступна лишь для операторских терминалов под
Windows CE.

Если глубина цвета на компьютере, с помощью которого проводится
конфигурирование, имеет значение более 256 цветов, то имеется
возможность выбора между двумя режимами вставки графических
объектов с целью достижения наилучшей передачи цвета:
•  Имитация диффузии (режим по умолчанию):
Цвета на экране смешиваются для передачи полутонов.

•  Близкие цвета:
Цвет на экране заменяется наиболее близким к оригиналу цветом из
системной палитры.

Для векторной графики лучше использовать режим близких цветов, а для
растровой – режим имитации диффузии.

Представление цветов на операторском терминале
Если для растровой графики заметно различие в цвете между тем, что
отображается на операторском терминале и тем, что было
сконфигурировано в ProTool, то необходимо выполнить следующие
действия:

На компьютере, с которого производится конфигурирование, в меню
Windows выбрать Settings → Control Panel → Display (Настройка
→Панель управления →Экран) и на вкладке Settings (Параметры),
установить в поле Colors (Цветовая палитра) значение True Color.

Данный режим должен быть установлен в процессе конфигурирования и
компиляции проекта.
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5.2.4 Что такое векторный графический элемент?

Назначение
Векторные графические элементы включают в себя простые
геометрические примитивы, например, прямые, окружности и
прямоугольники. Используя эти примитивы можно создавать простые
векторные рисунки прямо в ProTool, без использования внешних
графических редакторов. Векторные графические элементы могут
использоваться для иллюстрирования контролируемой системы или в
качестве пояснений к динамическим элементам отображения и элементам
управления.

Графические элементы могут быть изменены динамически, их положение
может быть изменено в процессе исполнения проекта (Динамическое
позиционирование объектов (Глава 5.14.7)).

Выбор векторных графических элементов
Для создания простых векторных графических элементов можно
выбирать следующие инструменты из панели инструментов Screen
Elements (Элементы экранных форм):

Прямая

Данный инструмент используется для рисования различных линий.
Есть возможность задать цвет, толщину, стиль и тип концов линии.
Можно, например, создать непрерывную или пунктирную линию с
закругленными концами или с концами в виде квадратов или
стрелок..

Ломаная

Данный инструмент используется для рисования ломаных и
многоугольников. Можно задать цвет, толщину и стиль линий. Для
многоугольников можно также задать цвет заливки.

Эллипс/окружность

Данный инструмент используется для рисования эллипсов и
окружностей. Можно задать цвет, толщину и стиль линий, и цвет
заливки.

Прямоугольник/квадрат

Данный инструмент используется для рисования прямоугольников и
квадратов. Можно задать цвет, толщину и стиль линий, и цвет
заливки.
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Скругленный прямоугольник/квадрат

Данный инструмент используется для рисования прямоугольников и
квадратов со скругленными углами. Можно задать цвет, толщину и
стиль линий, цвет заливки и радиус скругления

5.2.5 Что такое поле вывода? (текстовое/графическое)

Назначение
Поля вывода отображают на операторском терминале текущие значения,
получаемые из PLC. Данные значения могут отображаться по выбору в
цифровом, символьно–цифровом или символьном виде.

Цифровой и символьно–цифровой вывод
Цифровые и символьно–цифровые поля вывода отображают значения в
виде чисел или текста. Пример численного значения — число 80 в
качестве текущего значения температуры. Символьно–цифровое
значение — это, например, строка Valve_12 (Клапан_12).

Для конфигурирования цифрового или символьно–цифрового поля
вывода нажмите на изображенную иконку.

Символьный вывод
Символьные поля вывода не отображают текущие значения, а служат для
вывода текстовых строк или графики из текстовых или графических
списков. Вы, например, можете представить два состояния клапана в
виде текстового или графического списка. Когда клапан открыт, поле
вывода указывает текстовую строку OPEN (Открыт), или на
соответствующую картинку.

Используя поля вывода или символьные значения, Вы в значительной
мере устраняете возможность неверного восприятия информации
оператором, т.к. символьные значения зачастую представляют состояние
более ясно, чем, скажем, абстрактная числовая величина.

Для конфигурирования символьного поля вывода нажмите на
изображенную иконку.

Для конфигурирования графического поля вывода нажмите на
изображенную иконку.



Приемы конфигурирования

ProTool: Конфигурирование систем на базе Windows
5–20 Версия от 12/99

5.2.6 Что такое поле ввода? (поле выбора)

Назначение
Поля ввода служат для ввода значений на операторском терминале,
которые затем пересылаются в PLC. Значения могут быть в цифровом,
символьно–цифровом или символьном виде. Если Вы задаете уставки
для тега поля ввода, Вы можете отклонять вводимые значения лежащие
вне заданного диапазона.

Поля ввода
В цифровые или символьно–цифровые поля ввода на операторском
терминале значения вводятся посимвольно. Пример численного значения
— число 80 в качестве уставки для температуры. Символьно–цифровое
значение — это, например, строка Valve_12 (Клапан_12).

Для создания цифровых и символьно–цифровых полей ввода
нажмите изображенную иконку или выберите в меню Insert → Input
Field (Вставка → Поле ввода).

Списки выбора
В списках выбора Вы не вводите значение посимвольно, а выбираете его
на операторском терминале из текстового списка. Во время
конфигурирования каждому значению тега Вы присваиваете символьную
строку текстового списка. Таким образом, Вы можете, например, включать
и выключать двигатель двумя элементами: ON и OFF (ВКЛ и ВЫКЛ).

Используя списки выбора, Вы в значительной мере устраняете
возможность неверного ввода информации оператором, т.к. операторский
терминал принимает только значения, сконфигурированные в текстовом
списке.

Для создания списков выбора нажмите на изображенную иконку или
выберите в меню Insert → List Box (Вставка → Список выбора).
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5.2.7 Что такое функциональная клавиша?

Функциональная клавиша — это клавиша с заданным функциональным
назначением. В ProTool каждой функциональной клавиши Вы можете
присвоить одну или несколько функций . Функции активизируются по
нажатию клавиши. Функциональное присваивание клавиш может быть
глобальным или локальным. Для функциональных клавиш Вы можете
задать уровень пароля для предотвращения их использования
неуполномоченными лицами.

Глобальное назначение
Функциональные клавиши с глобальным назначением всегда
активизируют одну и ту же функцию, вне зависимости от текущей
ситуации. С их помощью Вы можете, например, открывать заданную
экранную форму, отображать очередь сообщений или распечатывать
содержимое экранной формы.

Используя глобально определенные функциональные клавиши, Вы
значительно сокращаете процедуру конфигурирования, т.к. Вам не нужно
отдельно назначать те же самые функции глобально определенным
клавишам на каждой экранной форме.

Для глобального назначения функциональной клавиши выберите в
меню System → Screen/Keys (Система → Экранная
форма/Клавиши). Для этого в диалоге Screen/Keys (Экранная
форма/Клавиши) щелкните на нужную функцию.

OP37/Pro: Клавиши K1 – KX или F1 – FX.

При желании Вы можете указать функции, присвоенные конкретным
клавишам используя маркировочные полосы.

Стандартный PC: Клавиши F1 – FX.

Замечание
Выбирая в меню System → Screen/Keys (Система → Экранная
форма/Клавиши) Вы задаете для клавиш глобальные настройки,
действующие на всех экранных формах. Иконки появляются в каждой
сконфигурированной экранной форма, при условии, что настройки в
последствии не были изменены для конкретной экранной формы. В этом
случае, изменения настроек действуют только для данной конкретной
экранной формы.
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Локальное назначение
Функциональные клавиши с локальным назначением активизируют на
операторском терминале различные действия в зависимости от экранной
формы. Функциональная клавиша, действие которой может меняться от
экрана к экрану, называется контекстно–зависимой клавишей.

Производите локальное назначение функциональных клавиш в
редакторе экранных форм. Для этого щелкните на одну из
функциональных клавиш F1 – FX на экранной форме.

В OP37/Pro для каждой контекстно–зависимой клавиши Вы можете
задать иконку, иллюстрирующую ее функцию текстом или картинкой.

Вы также можете глобально назначать контекстно–зависимые клавиши.
Глобальное назначение действует во всех экранных формах, в которых не
производится индивидуальное переопределение. Используйте глобально
назначенные контекстно–зависимые клавиши, например, для перехода с
любой экранной формы на один и тот же системный экран.

Замечание
Не назначайте функции, которые должны быть постоянно доступны на
операторском терминале, контекстно–зависимым клавишам.

5.2.8 Что такое график тренда?

Назначение
График тренда — это динамический элемент отображения. Графики
трендов предоставляют исключительно ясную форму отображения
непрерывных данных процесса на операторском терминале.

График тренда на операторском терминале может одновременно
отображать несколько различных трендов.

Для конфигурирования графика тренда нажмите на изображенную
иконку.
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5.2.9 Что такое гистограмма?

Назначение
Гистограмма — это динамический элемент отображения. Гистограмма
отображает значения, получаемые из PLC в виде прямоугольных
областей. Это означает, что Вы можете с одного взгляда на операторский
терминал определить, насколько текущее значение далеко от уставок и
достигнута ли заданная контрольная точка. Гистограммы можно
использовать, например, для отображения количеств или уровней
наполнения.

Для конфигурирования гистограмм нажмите на изображенную иконку.

Настройки
Гистограмма связываются с PLC при помощи тега. Помимо данного тега,
содержащего значение, которое следует отобразить, Вы можете задать
другие теги, например, для отображения факта выхода за уставку или для
скрытия поля столбца.

Вы можете по собственному усмотрению задавать направление, масштаб,
цвет и фон столбца, и маркировку оси Y. В дополнение Вы можете
отображать линии уставок для обозначения граничных значений.

На приведенном ниже рисунке показан вертикальный столбец с
нарисованными на нем линиями уставок.
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5.2.10 Что такое кнопка?

Назначение
Кнопка — это виртуальная клавиша на операторском терминале, которой
Вы можете назначать одну или несколько функций. Кнопки управляются
указательным устройством, например, мышью. При помощи кнопок Вы
можете индивидуально настроить пользовательский интерфейс.

Для создания кнопок нажмите на изображенную иконку..

Маркировка
Вы можете производить статическую и динамическую маркировку кнопок
при помощи текста или графических элементов.

•  Статическая маркировка:
При конфигурировании кнопки введите текст или выберите картинку.
Данный тип маркировки — статический, что означает, что она не будет
изменяться в операторском терминале.

•  Динамическая маркировка:
При конфигурировании кнопки выберите текстовый или графический
список и связанный индексный тег. Во время исполнения значение
индексного тега определяет, какой элемент списка отображается на
кнопке.

Функционирование
Нажатие, щелканье и отпускание кнопки активизирует функции, которые
Вы определили для данных событий.

Если Вы нажали кнопку по ошибке и не желаете активизировать
соответствующую функцию, оставьте кнопку в нажатом состоянии и
переместите указатель мыши или Ваш палец (для сенсорной панели) с
кнопки. Такое действие не приведет к возникновению события release.
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Невидимые кнопки
Невидимые кнопки — это прозрачные кнопки, которые не отображаются
на операторском терминале. Если Вы поместите невидимую кнопку на
графический элемент, Вы сможете управлять элементами картинки,
например двигателем или клапаном, щелчками мыши.

Для создания невидимых кнопок нажмите на изображенную иконку.

5.2.11 Что такое фиксирующаяся кнопка?

Назначение
Фиксирующаяся кнопка (кнопка статуса) — это элемент ввода и
отображения с двумя состояниями: ON (ВКЛ) и OFF (ВЫКЛ) или нажата и
отпущена. Оператор нажимает на фиксирующуюся кнопку, прикасаясь к
сенсорному экрану, или щелкая мышью.

Таким образом, Вы можете использовать фиксирующуюся кнопку для
отображения состояния устройства, например, двигателя, который
оператор не видит на операторском терминале. В то же время, оператор
может использовать фиксирующуюся кнопку для изменения состояния
соответствующего устройства.

Вы можете сконфигурировать фиксирующуюся кнопку с защелкиванием
или без. Фиксирующаяся кнопка без защелкивания активизирована (ON)
только пока она нажата.

Отображение
Для каждого из двух режимов отображения Вы можете определить текст
или картинку, появляющуюся на фиксирующейся кнопке. На приведенном
ниже рисунке показаны фиксирующиеся кнопки в различных состояниях и
вариантах конфигураций.

Фиксирующаяся кнопка с текстом или картинкой
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Создание фиксирующейся кнопки

Для создания фиксирующейся кнопки нажмите на изображенную
иконку или выберите в меню Insert → Status Button (Вставка →
Фиксирующаяся кнопка).

Привязка тега
Фиксирующаяся кнопка должна быть связана с тегом типа BOOL или INT.
Для тега типа INT, Вам также необходимо задать целое число n (≠ 0),
соответствующее состоянию "ON" (“ВКЛ”). В таблице показаны значения,
принимает тег при нажатии фиксирующейся кнопки:

Состояние Значение (тип тега BOOL) Значение (тип тега
INT)

ON / нажата TRUE (1) заданное значение n

OFF / отпущена FALSE (0) 0

При связывании с целочисленным тегом фиксирующаяся кнопка
отображается в состоянии "ON" (“ВКЛ”) только когда тег содержит
заданное значение n. При любом другом значении отображается
состояние "OFF" (“ВЫКЛ”).

Функционирование
Фиксирующаяся кнопка предусмотрена для использования в основном в
сенсорных панелях, но может управляться при помощи мыши или
клавиатуры:

•  Для переключения фиксирующейся кнопки щелкните на ней мышью.

•  На клавиатуре выделите фиксирующуюся кнопку клавишами TAB или
SHIFT + TAB и переключите ее нажатием на SPACEBAR (ПРОБЕЛ)
или Enter/Return.

Защелкивание
Фиксирующаяся кнопка может быть сконфигурирована как
защелкивающаяся или не защелкивающаяся.

•  Если фиксирующаяся кнопка сконфигурирована как
защелкивающаяся, она изменяет свое состояние при каждом
воздействии на нее.

•  Если фиксирующаяся кнопка сконфигурирована как не
защелкивающаяся, она остается в положении "ON" (“ВКЛ”) только пока
оператор нажимает на нее (или на кнопку мыши). Если связанный тег
получает значение n любым другим способом (например, из PLC),
кнопка, естественно, остается в положении "ON" (“ВКЛ”).
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Генерируемые события
При изменении состояния фиксирующейся кнопки оператором
происходит генерация следующих событий, для которых Вы можете
задать одну или более функций:

•  Switch on (Включение): при переводе кнопки во включенное
состояние ("ON").

•  Switch off (Выключение): при переводе кнопки в выключенное
состояние ("OFF").

•  Status change (Изменение состояния): каждый раз при изменении
состояния кнопки.

Если изменение состояния кнопки происходит из–за изменения значения
связанного тега, ни одно из описанных событий не генерируется.

5.2.12 Что такое переключатель?

Назначение
Переключатель используется для ввода и вывода бинарной информации:
он может быть только во включенном или выключенном состоянии. Для
этого  он связывается с тегом типа BOOL или INT. Состояние "выключен"
соответствует значению 0 (или FALSE) тега, связанного с
переключателем. Все другие ненулевые значения тега интерпретируются
как "включен".

Отображение
Вы можете сконфигурировать переключатель как в горизонтальном, так и
в вертикальном направлении; состояние "ON" (“ВКЛ”) переключателя
выбирается произвольно. Вы можете сделать маркировку переключателя,
а также визуально подчеркнуть его состояние цветом фона.

Положение переключателя маркируется цветом фона
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Создание переключателя

Для создания переключателя нажмите на изображенную иконку или
выберите в меню Insert → Switch (Вставка → Переключатель).

Привязка тега
С переключателем Вам необходимо связать тег типа BOOL или INT. В
таблице показаны значения, принимает тег при нажатии переключателя:

Состояние Значение (тип тега BOOL) Значение (тип тега
INT)

выключен FALSE (0) 0

включен TRUE (1) 1

При связывании с целочисленным тегом переключатель отображается во
“включенном” состоянии только когда значение тега 0. При любом другом
значении переключатель находится во "включенном” состоянии.

Управление мышью и клавиатурой
Переключатели могут управляться при помощи сенсорной панели, мыши
и клавиатуры.

•  Оператор может передвигать переключатель непосредственно мышью
или прикосновением. При щелчке на область свободного хода бегунка,
переключатель немедленно изменяет свое состояние на
противоположное, и тег устанавливается в соответствующее значение.

•  При использовании клавиатуры оператор может выбрать
переключатель клавишей TAB (при этом рамка выделяется пунктиром)
и перещелкнуть его нажатием SPACEBAR / ENTER.

Генерируемые события
При изменении состояния переключателя оператором происходит
генерация следующих событий:

•  Switch on (Включение): при переводе переключателя из состояния
"OFF" (“ВЫКЛ”) в "ON" (“ВКЛ”).

•  Switch off (Выключение): при переводе переключателя из
состояния "ON" (“ВКЛ”) в "OFF" (“ВЫКЛ”).

•  Status change (Изменение состояния): каждый раз при изменении
состояния переключателя.
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5.2.13 Что такое бегунок?

Назначение
Бегунок используется для ввода и отображения численных значений в
аналоговой форме. Для ввода значений необходимо переместить
регулируемый бегунок, например, при помощи мыши или стрелок в
ножном направлении. Когда он используется как элемент отображения,
выводимое значение определяется позицией перемещающегося бегунка.

Для создания бегунка нажмите на изображенную иконку.

Настойки
Бегунок связывается с тегом. При перемещении управляемого бегунка,
соответствующее значение записывается в тег. Наоборот, при изменении
значения тега также меняется положение движущегося бегунка, если
только в данный момент он не перемещается оператором.

Помимо тега, содержащего вводимое/отображаемое значение, Вы можете
задать другие теги, например, Для того чтобы во время исполнения
динамически изменять значения верхнего и нижнего предела.

Для того чтобы настроить бегунок в соответствии с Вашими
индивидуальными требованиями, Вы также можете задать следующие
атрибуты:

•  Маркировка

•  Маркировка осей

•  Масштабирование

•  Текущее значение (численное)

•  Гистограмма
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Отображение
На рисунке приведен пример бегунка для отображения и
ввода значений температуры. Текущее значение (здесь:
50) отображается обычным текстом, а также в виде
гистограммы.

Совет
Для отображения численных значений в аналоговом виде Вы также
можете использовать такой элемент экранных форм как аналоговый
дисплей.

Замечание
Так как масштабирование производится автоматически, две
промежуточные метки шкалы могут слиться друг с другом (и выглядеть
как широкая промежуточная метка шкалы). Для нейтрализации данного
эффекта немного измените высоту бегунка.
Вы также можете убрать отображение масштаба.

5.2.14 Что такое аналоговый индикатор?

Назначение
Аналоговый индикатор  представляет численные значения в виде
стрелочного прибора. На шкале прибора Вы можете задать до 3 областей,
каждая со своим цветом фона. Так Вы можете отображать различные
режимы работы, например, нормальное функционирование,
предупредительная зона и аварийная зона.

В аналоговом индикаторе Вы также можете сконфигурировать не
сбрасывающийся указатель. Во время исполнения не сбрасывающийся
указатель показывает максимальное значение, которое достигала
отображаемая величина

Для конфигурирования аналогового индикатора нажмите на
изображенную иконку.
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Настройки
Аналоговый индикатор связывается с тегом. При изменении значения тега
стрелка прибора также изменяет свое положение. Помимо данного тега,
содержащего отображаемое значение, Вы можете задать другие теги,
например, Для того чтобы во время исполнения динамически изменять
значения верхней и нижней границы шкалы.

Для того чтобы настроить аналоговый индикатор в соответствии с Вашими
индивидуальными требованиями, Вы также можете задать следующие
атрибуты:

•  Строку измеряемой величины (e. g. температура) и единицы измерения
(e. g. °C)

•  Угол наклона стрелки при максимальном и минимальном значениях.

•  Различные цвета областей шкалы для нормального,
предупредительного и аварийного режимов.

Примечание
Аналоговый индикатор является исключительно элементом
отображения. Вы не можете использовать его для ввода аналоговых
значений на операторском терминале. Для этой цели можно применять
такой элемент экранных форм, как бегунок.

Отображение
На рисунке приведен пример аналогового индикатора для отображения
значений температуры.

Типичный аналоговый индикатор
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Область фона и область рамки
Вы можете заменить предустановленное заполнение областей фона и
рамки самостоятельными фрагментами.

•  Область фона:
Пользовательская область фона охватывает циферблат и три области
шкалы, выделенные цветом. Стрелки, оси стрелок, шкала, маркировка
шкалы и строки измеряемой величины и единиц измерения остаются
видимыми.

•  Область рамки:
Пользовательская область рамки заменяет заданную по умолчанию
рамку вокруг циферблата.

5.2.15 Что такое индикатор даты/времени?

Индикатор даты/времени используется для отображения и смены на
операторском терминале календарных дат и времени.  Индикаторы даты
и времени зависят от используемого языка. Они базируются на формате,
заданном в Вашей среде Windows.

Для конфигурирования индикатора даты/времени нажмите на
изображенную иконку.

Помимо прочих настроек Вы можете указать
•  отображать только время, только дату, или и то и другое
•  можно ли изменять отображаемые данные во время исполнения
•  отображать данные в краткой или полной форме
 Краткая форма: например, 07.24.98, 17:09:43
 Полная форма: например, Friday, July 24, 1998, 17:09:43

Совет
Для отображения времени Вы также можете использовать такой
объект экранных форм, как цифровые/аналоговые часы.
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5.2.16 Что такое цифровые/аналоговые часы?

Назначение
Цифровые/аналоговые часы дают Вам возможность выбора формы
отображения системного времени: в численном виде (цифровые), или в
виде стрелочных часов (аналоговые).

В цифровом виде также отображается текущая дата. Формат отображения
зависит от используемого языка. Он базируются на формате, заданном в
среде Windows целевого устройства.

Для конфигурирования цифровых/аналоговых часов нажмите на
изображенную иконку.

Примечание
Цифровые/аналоговые часы являются исключительно элементом
отображения. Вы не можете использовать их для ввода времени или
даты на операторском терминале. Для этой цели можно применять
такой элемент экранных форм, как индикатор даты/времени.

Отображение
На рисунке приведен пример аналоговых часов без циферблата. Фон
часов был заменен отдельным рисунком.

Типичные аналоговые часы
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5.3 Использование тегов

Обзор
Так как теги являются наиболее важным механизмом обмена данными и
взаимодействия операторского терминала и PLC, здесь подробно
разъясняется, что такое теги и какие типы тегов используются в ProTool.

5.3.1 Что такое тег?

Определение
Тег имеет символьное имя и определенный тип данных. Значение тега
изменяется во время исполнения программы PLC.

Теги, связанные с PLC называются глобальными. Теги, не связанные с
PLC называются локальными.
•  Глобальные теги
 Тег, связанный с PLC занимает в PLC определенное адресное
пространство, доступное для чтения и записи из операторского
терминала и PLC.

•  Локальные теги
 Локальные теги не связаны с PLC. Они доступны только в пределах
операторского терминала. Вы можете создавать локальные теги,
например, Для того чтобы оператор мог вводить на операторском
терминале значения уставок.
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Типы тегов
ProTool распознает следующие типы тегов (но не все из них доступны в
каждом PLC):

Тип данных Разряды Диапазон значений

INT 16 бит от – 32768 до 32767

UINT 16 бит от 0 до 65535

LONG 32 бита от – 2147483648 до 2147483647

ULONG 32 бита от 0 до 4294967295

FLOAT 32 бита Верхний предел: ± 3.402823 e+38
Нижний предел: ± 1.175495 e–38

BOOL – true (1), false (0)

STRING – от 1 до 255 байт

DATETIME 64 бита Значение даты/времени

Массив
тегов

Данный тип объединяет произвольное число тегов
одного и того же типа в единое целое, с которым
можно обращаться как с самостоятельным объектом.

5.3.2 Свойства тегов

Для определения тега задайте его свойства.

На рисунке приведен пример диалогового окна Tag (Тег) для SIMATIC S7.



Приемы конфигурирования

ProTool: Конфигурирование систем на базе Windows
5–36 Версия от 12/99

Диалоговое окно Tag (Тег) для SIMATIC S7

Определение тегов (Раздел A)
Доступные типы и форматы данных зависят от типа используемого PLC.
Вы выбираете их в диалоговом окне Tag (Тег) в поле тега Type (Тип) (см.
онлайновую справку ProTool).

Обновление тегов
Цикл опроса определяет временной интервал, за который значение тега
обновляется в операторском терминале.

Результат:
•  Если цикл опроса устанавливается в 0, значение тега считывается
только при вызове экранной формы и в дальнейшем не обновляется.

•  Если для цикла опроса указывается значение > 0, значение тега
обновляется с заданной периодичностью, а также при открытии
экранной формы.

Системная установка по умолчанию: 1 сек.

Цикл опроса кратен стандартному тактовому импульсу, который Вы
задаете для каждого PLC в диалоговом окне PLC. Изменяя стандартный
тактовый импульс, Вы меняете цикл опроса всех тегов проекта
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Массивы тегов
Массив тегов представляет собой несколько тегов одного и того же типа с
последовательными адресами памяти. Для задания массива тегов
введите количество элементов в поле Number Elements (Количество
элементов) диалогового окна Tag (Тег).

Системное значение по умолчанию — 1, другими словами, тег не
является массивом.

Максимальное количество элементов в массиве — 640.

Совет
Вы можете использовать массивы тегов, например, для трендов
профиля (см. онлайновую справку ProTool).

Адрес (Раздел B)
Адрес определяет область памяти глобального тега в PLC.
Следовательно, адрес зависит от типа используемого PLC.

Формат представления адреса также зависит от выбранного PLC. Данный
раздел диалогового окна Tag (Тег) динамически корректируется в
соответствии с доступным адресным пространством.

ProTool, интегрированный в STEP 7 (Раздел C)
Если при установке Вы интегрировали ProTool в STEP 7, Вы можете
обращаться к таблице символов STEP 7 непосредственно из диалогового
окна Tag (Тег).

Из соображений производительности ProTool автоматически не обновляет
таблицу символов STEP 7 после каждого изменения. Для того чтобы
последние изменения таблицы символов STEP 7 сделать видимыми в
ProTool, следует обновить таблицу символов в диалоговом окне Tag (Тег)
щелкнув на Update (Обновить).

Пример в онлайновой справке содержит определение экземпляра DB в
таблице символов.
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Установка начального значения
В разделе Options (Опции) для тега можно задать начальное значение.
После загрузки проекта тегу присваивается указанное начальное
значение. Начальное значение отображается только в операторском
терминале и не хранится в PLC.

Пример:

Если теги используются для масштабирования трендов и гистограмм, в
качестве начального значения можно задать исходный масштаб.

Примечание
Это не имеет смысла для тегов типа STRING.

Установка граничных значений
В разделе Limit values (Граничные значения) для тегов можно задать
верхнее и нижнее граничные значения.

Если оператор в поле ввода задает значение тега, которое находится вне
заданного диапазона, другими словами, оно больше или меньше
рассматриваемых граничных значений, то данное значение отклоняется, а
предыдущее значение восстанавливается.

Конфигурирование тегов с функциями
Тегам полей ввода/вывода Вы можете присваивать функции, например,
Select Screen (Выбор экранной формы). Тогда при изменении значения
тега произойдет открытие соответствующей экранной формы.

5.3.3 Обновление тегов

В разделе Options (Опции), Вы можете указать, как производится
обновление значений и их пересылка между операторским терминалом и
PLC   

Считывать непрерывно:

Тег обновляется непрерывно, даже, если он не содержится на
отображаемой в данный момент экранной форме. Это важно в случае
трендов. Как правило, формирование тренда должно производиться даже
тогда, когда он не отображается.
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5.3.4 Пример установки цикла опроса и стандартного тактового
импульса

Системная установка по умолчанию: стандартный тактовый импульс
500 мс, цикл опроса 1 с.

Установите стандартный тактовый импульс в диалоговом окне PLC. При
увеличении стандартного тактового импульса до 1000 мс, цикл опроса для
всех тегов увеличивается до 2 с.

Совет
Для того чтобы не перегружать связь между PLC и операторским
терминалом, интервал, устанавливаемый в качестве стандартного
тактового импульса не должен быть слишком коротким. В противном
случае другие процессы, такие как обновление трендов или выполнение
задач PLC, будут выполняться значительно дольше.

5.3.5 Пример линейного масштабирования тега

Масштабирование логически производится между значением PLC и тегом,
иными словами, масштабированное значение уже содержится в теге.

Данные настройки производятся в диалоговом окне Tag (Тег) в закладке
Scaling (Масштабирование).

Значения тега преобразуются в соответствии со следующей формулой:
y = a*x + b.

Если Вы не задаете масштабирование, значение тега в PLC соответствует
значению, отображаемому на операторском терминале.

5.3.6 Сохранение тегов типа STRING

Сохранение тегов типа STRING в ProTool производится не так, как в
STEP 7.
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ProTool, интегрированный в STEP 7
Если Вы интегрировали ProTool в STEP 7 и использовали теги типа
STRING, то эти теги сохраняются и обновляются пакетом ProTool таким
же образом, как и в STEP 7.

В следующем примере показан порядок байтов при задании типа данных
STRING[4] с начальным значением 'AB'.

7 ..  .. 0 7  ..  .. 0

Байт 0

7 .. ..  0  7 ..  ..  0

Байт 1 Байт 3

Макс. длина
строки: 4

Реальная длина
строки

("AB" = 2)

ASCII код
A

Байт 2

ASCII код
B

 7 ..  ..  0  7 ..  ..  0

Байт 5Байт 4

Пример: тег типа STRING[4]

Замечание
Длина строки может быть до 80 символов.

5.3.7 Десятичные позиции тегов

В системах на базе Windows возможное количество позиций в десятичной
записи числа всегда от 0 до 16.

Для отображения значений с десятичными позициями после запятой, теги
должны иметь подходящий формат, зависящий от выбранного PLC:

Драйвер PLC Количество Формат

SIMATIC S5 от 0 до 16 KG

SIMATIC S7

SIMATIC WinAC

SIMATIC 500/505

от 0 до 16 REAL

Allen–Bradley от 0 до 16 REAL

<No PLC> (<Без PLC>) от 0 до 16 FLOAT



Приемы конфигурирования

ProTool: Конфигурирование систем на базе Windows
Версия от 12/99 5–41

Особенности ввода граничных значений
Граничные значения для тегов вводятся без десятичной запятой.
Константа граничного значения интерпретируется по–разному, в
зависимости от того, были ли для тега заданы десятичные позиции после
запятой.

Количество заданных десятичных позиций тега определяет, сколько
разрядов граничного значения будут интерпретироваться как знаки после
запятой.

В таблице приводится соответствующий пример.

Десятичные
позиции

Введенное
граничное значение

Интерпретируется ProTool

0 2275 2275

1 2275 227,5

2 2275 22,75

5.3.8 Что такое адресное мультиплексирование?

Определение
При адресном мультиплексировании параметры адреса тега изменяются
как функция от значения мультиплексирующего тега .

Назначение адресного мультиплексирования
Используя адресное мультиплексирование, Вы можете адресоваться к
нескольким областям памяти PLC при помощи одного тега. Вы можете
осуществлять чтение и запись по нескольким адресам и не задавать
отдельный тег для каждого адреса; это очень эффективный метод
обработки данных.
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Конфигурирование мультиплексирующего тега

   Для задания мультиплексирующего тега нажмите на данную кнопку
рядом с полем адреса в диалоговом окне Tag (Тег).

При конфигурировании мультиплексирующих тегов обратите внимание на
следующее:

•  Мультиплексирующий тег не должен быть мультиплексируемым.

•  Тип (type) мультиплексирующего тега должен совпадать с типом
параметра адреса, который он задает.

На рисунке показан результат адресного мультиплексирования тегов:

Адресное мультиплексирование тегов

Замечание
В адресном мультиплексировании нельзя использовать теги ProTool,
фигурирующие в скриптах, потому, что после изменения адреса значение
тега не сразу считывается из PLC.

5.3.9 Пример конфигурирования мультиплексирующего тега

Для мультиплексирования адреса создайте, например, следующий тег:

1. Для конфигурирования нового тега выберите Paste → Object
(Вставить → Объект).

2. В диалоговом окне Tag (Тег) введите Var_1 в качестве имени нового
тега.

3. В закладке адреса, выберите INT в типе и в качестве адреса введите:
DB   50
DBB   0

4.    Щелкните на данную кнопку, чтобы открыть диалоговое окно
Address Multiplexing (Мультиплексирование адреса).

5. Активизируйте мультиплексирование адреса.

6. Введите Multiplex_1 в качестве имени нового мультиплексирующего
тега.
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7.  Щелкните на данную кнопку, чтобы задать мультиплексирующий
тег.

8. В закладке адреса, выберите BYTE в поле типа и введите адрес:
FW   20

 Мультиплексирующий тег может принимать значения от 0 до 255,
иными словами, используя тег Var_1, Вы можете обращаться к 256
различным адресам.

 Замечание:
Если Вы хотите использовать весь максимально возможный диапазон
значений, DB 50 в программе STEP 7 должен быть создан с не менее,
чем 128 словами данных.

9. Подтвердите изменения, нажав на OK.

 В качестве адреса тега Var_1 отображается имя
мультиплексирующего тега:
DB   50
DBB  [MULTIPLEX_1]

 

Variable_1 DB     50
DBB  [mux]

Байт 0

Байт 1

Байт 2

Байт n

Multiplex_1

MW   20

Пример: конфигурирование мультиплексирующего тега
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5.3.10 Архивирование тегов

Системы на базе Windows предоставляют Вам возможность
архивировать данные процесса (т.е. постоянно хранить их для
возможности анализа). Условие активизации и диапазон значений для
архивирования задаются в диалоговом окне Tag (Тег) закладки Archive
(Архив).

Дальнейшую информацию по данному вопросу Вы сможете найти в
разделе Архивирование данных процесса (Пример структуры архива для
тегов (Глава 5.12.5)).

5.3.11 Функции изменения тегов

Ниже приводится обзор различных функций, предоставляемых в
ProTool/Pro CS для редактирования значений тегов.

В основном, содержимое тегов можно менять следующими способами:

•  установка отдельного бита тега

 Функции для битовых операций используются для переключений
между двумя состояниями, например, включить или выключить
переключатель, или открыть или закрыть клапан.

•  изменение значения всего тега

 Изменение значения всего тега используется в том случае, если
необходимо переключаться между более чем двумя состояниями
(например, между несколькими языками) или обрабатывать
произвольно задаваемые значения (например, для ввода тома)

•  линейное масштабирование тега

 Линейные преобразования используются для масштабирования
значений или для приведения их к другой величине.
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5.4 Создание текстовых и графических списков

Назначение
Текстовые или графические списки зачастую более информативны, чем
абстрактные значения.  Например, текстовые строки full и empty
(полный и пустой) или два графических символа представляют
состояние резервуара более ясно, чем соответствующие числовые
значения. Именно поэтому ProTool предоставляет Вам возможность
использования графических или текстовых списков.

Эти текстовые или графические списки — это списки, в которых Вы
каждому значению тега сопоставляете элемент списка.

Использование
При помощи текстовых или графических списков Вы, например, можете
динамически маркировать кнопки, отображать текст и графику в полях
вывода и выбирать текст в полях ввода. Это в значительной мере
устраняет возможность неверного интерпретирования отображаемой
информации и ошибок оператора при вводе данных.

Дальнейшую информацию по использованию текстовых и графических
списков в экранных формах можно найти в

•  Поля ввода (Глава 5.2.6)

•  Поля вывода (Глава 5.2.5)

•  Кнопки (Глава 5.2.10)

Текстовый список
Текстовый список сопоставляет текстовую строку каждому значению тега.
Во время исполнения значение тега определяет, какая строка списка
выбрана и отображается, например, в поле ввода/вывода операторского
терминала.

Для создания нового текстового списка в окне проекта дважды щелкните
на Text or graphic lists (Текстовые или графические списки).

Графический список
Графический список сопоставляет графический элемент каждому
значению тега. Во время исполнения значение тега определяет, какой
графический элемент выбран и отображается, например, в поле вывода
операторского терминала.

Для создания нового графического списка нажмите на изображенную
иконку при открытой экранной форме.



Приемы конфигурирования

ProTool: Конфигурирование систем на базе Windows
5–46 Версия от 12/99

5.5 Создание графических элементов

5.5.1 Что такое графический элемент?

Назначение
Графические элементы — это статические элементы отображения не
связанные с PLC.  Они не могут быть изменены в операторском
терминале во время исполнения. Используйте графические элементы,
например, для изображения Вашей системы, или в качестве поясняющих
символов к динамическим элементам отображения и управления.

Создание графических элементов
В ProTool предусмотрена возможность встраивания внешних графических
редакторов с использованием интерфейса OLE. Так Вы можете создавать
графические элементы в том приложении, к которому Вы привыкли,
вместо того чтобы изучать новый графический редактор.

Когда графический элемент создан, он встраивается в ProTool либо как
растровая, либо как векторная картинка, в зависимости от того, каким
графическим редактором Вы пользуетесь.

Для конфигурирования графического элемента нажмите
изображенную иконку.

Совет
Чтобы сделать графический элемент “управляемым”,
сконфигурируйте кнопку с графическим списком.

Цветопередача в проекте ProTool
Данные настройки доступны только в операторских терминалах под
управлением Windows CE.

Если установленная цветность конфигурационного компьютера
превышает 256 цветов, для достижения оптимальной цветопередачи при
вставке графических элементов Вы можете выбирать между следующими
режимами:
•  Рассеивание ошибки (системное значение по умолчанию):
Цвета экранной формы смешиваются для передачи различных
оттенков.

•  Близкие цвета:
Отдельные цвета экранной формы заменяются другими цветами из
системной палитры, наиболее близкими к исходным.

Для векторной графики используйте режим similar colors (близкие цвета), а
для цветных фотографий режимом по умолчанию является error diffusion
(рассеивание ошибки).
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Цветопередача в операторском терминале
Если цвета растровых графических элементов при отображении на
операторском терминале значительно отличаются от тех, которые были
заданы в ProTool, выполните следующие действия:

На конфигурационном компьютере в главном меню выберите Settings →
Control Panel → Display (Настройки → Панель управления → Дисплей) и в
поле Colors (Цвета) закладки Settings (Настройки) выберите True Color
(Реалистичная цветопередача).

Сохраните данные настройки при конфигурировании и компиляции
проекта.
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5.6 Создание трендов

5.6.1 Что такое тренд?

Использование
•  Тренд реального времени
У трендов реального времени в каждый временной квант (задаваемый
импульсами синхронизации) из PLC считывается и добавляется к
тренду, отображаемому на операторском терминале, только одно
значение. Тренды реального времени подходят для представления
медленных, продолжительных процессов.

•  Тренд профиля
У трендов профиля при установке активизирующего бита все значения
считываются из PLC и отображаются на операторском терминале
одновременно. Тренды профиля подходят для представления быстрых
процессов в случае, если изменение тренда в целом (его профиля)
более важно, чем отдельные значения.

Активизация:
Тип активизации определяет, как считываются данные тренда:

•  Активизация по часам (временная активизация)

 В случае временной активизации данные, которые необходимо
получить для тренда, считываются из PLC в определенные,
настраиваемые временные интервалы. Для этого при
конфигурировании тега выберите Read Continuously (Считывать
непрерывно) в закладке Options (Опции). При заполнении тренда
новые значения начинают перезаписывать самые ранние.

 Выбирая временной интервал активизации и количество фиксируемых
значений, которые следует отображать, Вы определяете промежуток
времени, охватываемый трендом. Данный тип активизации подходит
для трендов реального времени.
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•  Активизация по биту (событийная активизация)

 В случае событийной активизации данные, которые необходимо
получить для тренда, считываются из PLC при возникновении
заданного события. Событие генерируется PLC в результате установки
определенного бита. Существует два возможных варианта считывания
данных:

− Одиночное считывание

 Каждый раз при установке соответствующего бита, из PLC
считывается только одно значение. Одиночное считывание
подходит для отображения трендов реального времени.

− Буферизированное считывание

 Каждый раз при установке соответствующего бита, из PLC
считывается целый блок буферизированных данных
Буферизированное считывание подходит для отображения
трендов профиля.

Коммуникационные области для трендов с битовой активизацией
Для того чтобы иметь возможность конфигурировать тренды с битовой
активизацией, Вам необходимо создать в PLC коммуникационные
области, выбрав в меню System → Area Pointer (Система → Указатель
области). Взаимодействие операторского терминала с PLC
осуществляется с использованием этих областей:

•  Область запроса тренда

 Данная область может использоваться PLC для определения тренда,
отображаемого в текущий момент на операторском терминале.

•  Область передачи тренда 1

 Данная область используется для активизации трендов.

•  Область передачи тренда 2

 Данная область требуется только для тех трендов, у которых Вы
конфигурируете переключаемый буфер.

Во всех битовых областях каждому тренду присваивается отдельный бит
активизации. Если, например, Вы присвоите какому–либо тренду бит 4, то
этот тренд будет идентифицироваться битом 4 во всех битовых областях.
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Переключаемый буфер
Переключаемый буфер — это второй буфер, который Вы можете создать
для тренда профиля. Пока операторский терминал считывает значения
тренда из первого буфера, PLC уже записывает новые значения во второй
буфер. Когда операторский терминал осуществляет чтение из второго
буфера, PLC записывает первый. Переключаемый буфер служит для
предотвращения перезаписи значений PLC в период чтения тренда
операторским терминалом.

Буфер 2

При заполнении буфера тренда в области
передачи тренда 1 устанавливается бит

Операторский
терминал
считывает

Буфер 1

PLC
записывает

Переключаемый буфер: одновременное чтение и запись значений тренда

Отображение архивных данных в виде тренда
Данные архива отображаются в виде тренда профиля, иными словами,
считывание и отображение данных тренда событийно–управляемы.

Такие тренды могут применяться, например, для отображения процессов
запуска, или температурной кривой при прогреве печи.
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5.6.2 Пример отображения архивных данных во временном
окне

Цель
Допустим, Вы желаете отобразить на операторском терминале архивные
данные, начиная с некоторого момента времени. . На экранной форме Вы,
также, хотите иметь возможность перехода к конкретным временным
меткам без длительного скроллирования.

Процедура:
Как сконфигурировать поле ввода для архивного тренда:

1. Сконфигурируйте поле ввода для задания начальной временной метки
отображения архивных данных:

 Display:       Date
Decimal places:  0
Field Length:    15

 (Отображать:   Дата
Десятичных позиций:  0
Длинна поля:   15)

2. Выберите тег не связанный с PLC с форматом даты/времени:

 Name:      VAR_15
PLC:       <No PLC>
Type:       DATETIME

 (Имя:       VAR_15
PLC:       <Без PLC>
Тип:        DATETIME)

3. В графике тренда перейдите на закладку Axis Scaling
(Масштабирование осей) и выберите тег VAR_15.

Результат:

При вводе на операторском терминале в данном поле даты и времени,
производится отображение архивных данных, начиная с указанного
момента времени.

Замечание
Для экрана сообщений перейдите на закладку General (Общие) и
выберите тег с начальным временем.
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5.7 Конфигурирование планировщика

5.7.1 Что такое планировщик?

Задачи планировщика
Планировщик задает регулярно повторяющиеся или однократные
моменты времени, в которые должна исполняться определенная функция.

Предусмотрены следующие типы планируемых интервалов:
•  каждую n–ую минуту
•  каждый час
•  каждый день
•  каждую неделю
•  каждый месяц
•  каждый год
•  однократно

Диалоговое окно планировщика

В приведенной ниже таблице перечислены временные параметры,
требующиеся для различных типов планировщика.
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Тип планировщика Необходимые временные параметры

каждую n–ую минуту –

каждый час минута

каждый день час, минута

каждую неделю день недели, час, минута

каждый месяц дата, час, минута

каждый год месяц, дата, час, минута

однократно год, месяц, дата, час, минута

Ограничения

Замечание
Планировщики доступны только в операторских терминалах MP270,
OP37/Pro, FI25 FI45 и в PC.

Функции, связанные с планировщиком
По истечении заданного для планировщика интервала времени
производится запуск сконфигурированной функции. Вы, например, можете
связать с планировщиком функцию печати или архивации.

Корректировка планировщика во время исполнения
Если Вы хотите иметь возможность изменять запланированные моменты
времени в операторском терминале, Вы можете связать планировщик с
временным тегом. Привяжите временной тег к полю даты/времени.
Изменяя содержимое поля даты/времени оператор корректирует
временной тег и тем самым влияет на планировщик.

Замечание
С планировщиком Вы можете связать только один внутренний тег.
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5.8 Создание отчетов

5.8.1 Что такое отчет?

Использование
В системах HMI отчеты используются для документирования данных
процесса и производственных циклов. Таким образом, отчет
документирует операции, выполняемые в течение рабочей смены.

Такого рода отчеты можно сконфигурировать в ProTool. Задайте
содержимое и макет каждого отчета в редакторе отчетов. Где–либо в
другом месте сконфигурируйте событие, по наступлению которого Вы
хотите активизировать формирование отчета.

Так Вы сможете сконфигурировать отчет, формируемый к концу рабочей
смены, в котором будут зафиксированы времена простоя. Вы также
можете сконфигурировать отчет, используемый для документирования
испытаний качества. (ISO 9000).

Типы отчетов в окне проекта
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Содержание
Задайте содержание отчета в редакторе отчетов. В отчет Вы можете
включить следующие динамические и статические объекты:
•  Статический текст
•  Дату/Время
•  Буфер сообщений
•  Номер страницы
•  Численные и символьные поля вывода
•  Гистограммы
•  Графические элементы
•  Векторную графику: квадрат, окружность, линию, квадрат с пунктирной
обводкой или скругленными углами.

Макет
В редакторе отчетов Вы также можете задать макет отчета. Вы можете
установить обложку, верхние и нижние колонтитулы и номера страниц.
Имеется возможность конфигурирования не более 10 страниц отчета.

Событие активизации
Во время исполнения отчет может формироваться либо автоматически
(т.е. посредством задач PLC), или вручную (т.е. используя контекстно–
зависимые клавиши). Вы можете сконфигурировать следующие события
активизации:
•  Планировщик
•  Контекстно–зависимая/функциональная клавиша
•  Изменение значения тега
•  Скрипт

Язык вывода
Вы можете использовать языки операторского терминала для
формирования отчетов на различных языках. Это делается так же, как и в
редакторе экранных форм. Во время исполнения отчет формируется на
том языке, который установлен в операторском терминале.

Особые ситуации при печати
Для корректной печати отчетов во время исполнения, подключенный
принтер должен поддерживать заданный формат бумаги и макет отчета.

Замечание
При использовании устройств на базе Windows CE проверьте, какие типы
принтеров поддерживаются операционной системой.
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Отчетные значения тегов
Значения тегов, включаемых в отчет, считываются и фиксируются только
в момент печати отчета. В случае многостраничных отчетов времена
формирования первой и последней страниц могут значительно
отличаться. В связи с этим может возникнуть ситуация, при которой
значение одного и того же тега может быть различным на, скажем, первой
и последней страницах.

5.8.2 Печать буфера сообщений в отчете

При создании отчета среди многих доступных объектов панели
инструментов Report (Отчет) есть иконка "print message buffer"
(“печать буфера сообщений”).

Объект print message buffer (печать буфера сообщений) может быть
вставлен в отчет. При этом в отчет будет вставлено содержимое буфера
сообщений на момент формирования отчета.

В закладках задайте общие настройки, колонки, шрифт, цвет, положение
(при необходимости с варьируемым отступом) и имя.

•  General (Общие): Здесь Вы можете выбрать тип выводимых
сообщений и задать количество строк для каждого сообщения.

•  Columns (Столбцы): Здесь вы можете исключить отдельные столбцы
из отчета (по умолчанию включаются все) и установить порядок
сортировки.

Замечание
Буфер сообщений всегда является последним объектом страницы, после
него Вы не можете вставить никакие другие объекты. Буфер сообщений
всегда выводится полностью: если первой страницы не хватает,
последующие страницы распечатываются автоматически.

5.8.3 Что такое номер страницы?

При создании отчета среди многих доступных объектов панели
инструментов Report (Отчет) есть иконка "page number" (“номер
страницы”).

Объект page number (номер страницы) может быть вставлен в отчет, как
правило, в колонтитул. При этом в месте вставки будет распечатываться
номер текущей страницы отчета. Если Вы используете страницу обложки,
номер страницы на ней не отображается.

В закладках задайте общие настройки, колонки, шрифт, цвет, положение
(при необходимости с варьируемым отступом) и имя.
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5.8.4 Пример создания отчета

Цель
Допустим, Вы хотите создать отчет, содержащий подчеркнутый заголовок,
дату, и время распечатки и содержимое системного буфера сообщений. .
Вы желаете, чтобы отчет формировался в 6:00 каждого дня и затем
каждые последующие 8 часов.

Выполните следующие действия:
1. Дважды щелкните на иконку Reports (Отчеты) в окне проекта.

 После этого откроется новый отчет. Вы можете оставить заданные по
умолчанию настройки формата бумаги (A4) и макета без изменений.

2. 
Щелкните на данную кнопку и при помощи мыши поместите
текстовое поле на текущей странице.

3. Введите в поле заголовок "Message buffer from" (Форма буфера
сообщений).

4. 
Щелкните на данную кнопку и рядом с текстовым полем поместите
еще одно поле для вывода даты/времени.

5. Подтвердите диалоговое окно Date/Time (Дата/Время), нажав OK.

6. 
Щелкните на данную кнопку и нарисуйте линию нужной длины под
заголовком.

 Откроется диалоговое окно Line (Линия).

7. Перейдите к закладке Colors (Цвета), установите в качестве цвета
изображения black (черный), и подтвердите диалог, нажав OK.

8. 
Щелкните на данную кнопку для вставки буфера сообщений и под
нарисованной линией выделите необходимую для него область.

 Откроется диалоговое окно Message Buffer (Буфер сообщений).
Проверьте, что все флажки закладок Messages и Display (Сообщения и
Отображение) установлены.

9. В закладке Messages (Сообщения) отключите все сообщения кроме
системных (System Messages). В закладке Display (Отображение)
отключите все элементы, не требующиеся для вывода (например,
Diagnostic capability (Возможность диагностики)). Подтвердите
диалог, нажав OK.
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 После того, как вы вставили в страницу отчета буфер сообщений, Вы
не сможете больше ничего добавить. Если Вы хотите использовать
другие объекты, Вам следует добавить еще одну страницу.

 При выходе из редактора отчетов, отчет сохраняется под именем
REPORT_1. Вы можете изменить данные настройки в меню Tools →
Default Settings (Утилиты → Значения по умолчанию) или каждый раз
вводить новое имя, состоящее из не более чем 12 буквенно–цифровых
символов.

10. После этого сконфигурируйте планировщик таким образом, чтобы он
активизировался каждые 8 часов, начиная с 6:00.

11. Свяжите функцию Print_Report с планировщиком, и в качестве
параметра введите имя отчета.

В результате, каждые 8 часов операторский терминал будет
автоматически посылать на печать отчет, с заданным Вами содержанием.
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5.9 Конфигурирование сообщений

Обзор
Для отображения состояния системы и технологического процесса, а
также  для получения и протоколирования в операторском терминале
данных процесса, принимаемых из PLC, осуществите конфигурирование
сообщений.

Сообщения инициируются PLC и могут быть отображены на операторском
терминале.

5.9.1 Оповещение о состояниях системы и технологического
процесса

•  В ProTool существуют следующие типы сообщений:
− Сообщения о событиях отображают обычное состояние
системы или процесса.

− Аварийные сообщения отображают критическое или опасное
состояние системы или процесса и требуют от обслуживающего
персонала либо подтверждения, либо исправления.

− Системные сообщения отображают состояние и ошибки
операторского терминала, PLC или связи между ними. Они
инициируются операторским терминалом или PLC.

•  В ProTool можно сконфигурировать отображение сообщений от
SIMATIC S7–300/400:

− S7 системные сообщения отображают ошибки в состоянии PLC
или ошибки связи с PLC. Они инициируются PLC и могут
просматриваться на операторском терминале.

− S7 диагностические события вносятся в диагностический буфер
S7–CPU и могут просматриваться на операторском терминале.
Служат для предоставления всей вышеперечисленной
информации с целью быстрого и удобного поиска и диагностики.

Для чего используются сообщения?
Система сообщений решает следующие задачи:

•  Оповещение о событиях или состояниях, происходящих в системе или
процессе:

− О состоянии сообщается сразу после его изменения.
− Сообщения представляются оператору в зависимости от их
значимости (приоритета).
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•  Помощь в устранении причин возникновении ошибок:
− Сообщения предоставляют расширенную информацию о
причинах ошибок (диагностика).

− Оператор может влиять на технологический процесс на основе
сообщений. Для упрощения работы оператора в обзор сообщений
можно добавить кнопку Редактировать и задать функцию для
этой кнопки (например, выбор некоторой экранной формы).

•  Распечатка: события сообщений выводятся на принтер.

•  Архивация: события сообщений сохраняются для последующей
обработки и оценки.

5.9.2 Что содержится в сообщении?

Сообщение состоит из:

•  номера сообщения

•  текста сообщения

•  тега сообщения

•  подсказки

В операторском терминале отображаются, но не могут редактироваться в
ProTool следующие сообщения:

•  Номер сообщения не может изменяться в системных сообщениях,
стандартных результатах диагностики S7 (системных сообщениях S7) и
аварийной сигнализации NC (только для OP7 и OP17).

•  Номер сообщения для определенных пользователем результатов
диагностики S7 может произвольно задаваться в STEP 7 в пределах
установленных ограничений.

•  Номер сообщения назначается сообщением Alarm_S в STEP 7.

Номер сообщения
Номер сообщения используется для ссылки на сообщение. В ProTool
можно произвольно выбирать номер (в пределах от 0 до 2000) и текст
сообщения.



Приемы конфигурирования

ProTool: Конфигурирование систем на базе Windows
Версия от 12/99 5–61

Текст сообщения
Текст сообщения содержит описание сообщения. Длина текста сообщения
зависит от операторского терминала. Во время конфигурирования
количество символов в каждой линии обозначается символом  на
верхней границе окна.

Выбрав Edit → Style (Редактирование → Стиль) в меню, в зависимости
от операторского терминала, можно определить следующие стили текста
сообщения: мигающий, подчеркнутый, курсив и основной (только для
текстовых мониторов).

Совет
Инструкции оператору могут быть реализованы в форме сообщений.

Теги сообщений
Сообщение может содержать поля вывода с тегами.

Выбрав Edit → Style (Редактирование → Стиль) в меню, можно
определить следующие стили полей вывода в зависимости от
операторского терминала: мигающий, подчеркнутый, курсив.

Вставьте поле вывода, выбрав указанный символ.

Замечание
Значение тегов сообщений обновляются в буфере для активных или
сброшенных сообщений, но не для подтвержденных.

Подсказка
Подсказка содержит детальную информацию о сообщении и может быть
настроена для каждого сообщения. Подсказка отображается в отдельном
окне операторского терминала при нажатии клавиши Help (Помощь).

Введите подсказку, выбрав указанный символ или воспользовавшись
командой меню View → Help text (Вид → Подсказка).
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5.9.3 Какие параметры устанавливаются для сообщений?

Для сообщений можно конфигурировать следующие параметры:

•  группы подтверждения

•  печать

•  функции

Группы подтверждения
Аварийные сообщения могут быть назначены группам подтверждения.
Сконфигурируйте назначение групп подтверждения для каждого
сообщения. При подтверждении аварийного сообщения группы, все
аварийные сообщения из этой группы подтверждаются одновременно
(групповое подтверждение).

Печать
При выборе пункта меню Print (Печать), событие сообщения (активное,
очищенное, подтвержденное) автоматически посылается на принтер, при
условии, что выполнена настройка System → Messages → Settings
(Система → Сообщения → Настройки), Print ON  (Печать ВКЛ).

Для каждого сообщения настройте печать в диалоговом окне Attributes
(Атрибуты).

Также имеется возможность печати сохраненные в архиве сообщения.

Функции
Для событий прибытия, убытия, подтверждения и редактирования
сообщения, Вы можете сконфигурировать одну или несколько функций.

•  Событие сообщения о редактировании может быть инициировано
только оператором (нажатием кнопки Редактирование).

•  Событие подтверждения сообщения может инициироваться системой
или оператором (нажатием кнопки ACK или клавиши ACK).

Замечание
Для того, что бы разрешить оператору инициировать функции,
сконфигурированные для подтверждения или редактирования,
необходимо сконфигурировать кнопки ACK или редактирование  в обзоре
сообщений или сделать доступной клавишу ACK на операторском
терминале.
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5.9.4 Подтверждение сообщений

Принцип
Аварийное сообщение может быть подтверждено либо оператором на
операторском  терминале, либо из программы PLC. Подтверждение
аварийного сообщения означает, что оно было принято к сведению.

Формирование групп подтверждения
При конфигурировании Вы можете включать несколько аварийных
сообщений в группу подтверждения. После подтверждения первого
сообщения, одновременно подтверждаются все остальные сообщения,
относящиеся к данной группе. Это позволяет, например, одновременно
подтвердить аварийное сообщение о причине неполадки, и все
сообщения о последующих сбоях (групповое подтверждение)

Пустое поле в окне Attributes (Атрибуты) редактора сообщений
эквивалентно вводу 0. Значение 0 обозначает индивидуальное
подтверждение, то есть подтверждение данного сообщения относится
только к нему. При подтверждении некоторого аварийного сообщения из
группы подтверждения все остальные аварийные сообщения этой группы
подтверждаются одновременно (групповое подтверждение).

Одно сообщение может быть размещено в одной из 16 групп
подтверждения.

5.9.5 Какие существуют настройки для классов сообщений?

Для классов сообщений можно сконфигурировать следующие
параметры:
•  подтверждение
•  распечатка
•  архивация
•  фильтрация
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 Подтверждение
Сообщения, отнесенные к аварийным сообщениям, должны быть
подтверждены. Аварийные сообщения отображаются до тех пор, пока не
будут подтверждены.

Единичное подтверждение: подтверждается только одно сообщение.

Групповое подтверждение: подтверждается сообщение из группы
подтверждения, а также все стоящие в очереди сообщения данной
группы.

Распечатка
Распечатка всех сообщений включается и отключается атрибутом Print
(Печать) в System → Messages → Settings (Система → Сообщения →
Настройки). Сообщения выводятся на принтер, подключенный к
операторскому терминалу.

Для настройки печати выберите в меню System → Messages → Settings
(Система → Сообщения → Настройки).

Архивация
Для архивации событий сообщений создаются архивы. В последствии
события сообщений записываются в буфер сообщений и в архив. Буфер
сообщений изменяется, а архив, содержащий сообщения, является
постоянным. Архивация настраивается для каждого класса сообщений.

Для настройки архивации выберите System → Messages → Settings
(Система → Сообщения → Настройки) и нажмите кнопку Archives
(Архивы).

Фильтрация
Для отображения сообщений можно установить критерий фильтрации.

•  Для отображения вновь появившихся событий сообщений в начале
или в конце списка на операторском терминале выберите в меню
System → Messages→ Settings (Система → Сообщения → Настройки)
и в Alarm messages (Аварийные сообщения) укажите First or Last
(Первые или Последние).

•  Для обзора сообщений, укажите в закладке General Information (Общая
Информация), что следует отображать:
− сообщения или
− события сообщений или
− диагностический буфер S7 или
− содержимое архива.
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5.9.6 Пример конфигурирования аварийных сообщений

Пример установки области аварийных сообщений и конфигурирования
аварийных сообщений от  SIMATIC 300/400 PLC

В этом примере Вы сначала сконфигурируете область аварийных
сообщений, а потом аварийное сообщение.

1. Выбрав в меню System → Area Pointers (Система → Указатели
Областей) создайте область аварийных сообщений. Откроется диалог
Area Pointers (Указатели Областей).

 
2. В поле Type (Тип), выберите указатель области Alarm messages

(Аварийные сообщения). Нажмите кнопку Add (Добавить).

3. Откроется диалог Alarm Messages (Аварийные Сообщения). Введите
Address (Адрес)

 DB:       10
DW:        2
Length:    2
PLC:       PLC_1

 Вы только что создали область аварийных сообщений на 32 аварийных
сообщения.

4. Подтвердите все установки, нажав OK. Аналогично, нажав OK,
выйдите из диалогового окна Area Pointers (Указатели Областей).

5. Двойным щелчком откройте окно Alarm Messages (Аварийные
Сообщения). Установите курсор на сообщение № 2.

6. Введите следующее сообщение: Motor temperature too high
(Перегрев двигателя)

7. Выполните следующие настройки в окне Attributes (Атрибуты):
 Acknowledgment (Подтверждение):   7

Print (Печать):            !

 На рисунке изображено сконфигурированное аварийное сообщение:
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5.9.7 Что такое системные сообщения?

Системные сообщения всегда появляются на операторском терминале и
не могут конфигурироваться в ProTool. Системное сообщение состоит из
номера сообщения и текста сообщения. Текст сообщения может
содержать внутренние системные теги, что обеспечивает дальнейшую
детализацию причин появления сообщения об ошибке.

Что сообщается?
Системные сообщения предоставляют на операторском терминале
информацию о режимах функционирования. Возможные системные
сообщения охватывают диапазон от примечаний до серьезных ошибок.

Совет
Найдите нумерованный список системных сообщений операторского
терминала, их причин и действий по их устранению в приложении к
техническому руководству или в руководстве пользователя Связь.
Руководство пользователя (Communication User's Guide). При обращении
в службу технической поддержки убедитесь в том, что Вы знаете
системный номер сообщения и значения всех содержащихся в сообщении
тегов.
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Отображение системных сообщений в окне сообщений
Для задания системных сообщений, которые Вы хотите отображать, и
времени их отображения, выберете в меню System → Messages → System
Messages (Система → Сообщения → Системные Сообщения).

Замечание
Установка значения 0 обозначает статичность отображения. Окно
сообщения не будет закрыто до тех пор, пока не будет нажата клавиша
ESC.

Дополнительно можно активизировать отображения следующих
системных сообщений:

•  SIMATIC S7 (Минимальный): Выводятся номера сообщений системы
сообщений S7 (с отметкой времени). Причину ошибки можно найти по
номеру в руководстве по S7.

•  SIMATIC S7 (Стандартный): В дополнение к минимальному
отображению выводится текст сообщения системы S7.

Отображение системных сообщений в обзоре сообщений
При помощи Отображения Сообщений возможно отображение
диагностических сообщений SIMATIC S7. При этом считывается текст
диагностического сообщения S7.

5.9.8 Пример системного сообщения

SIMATIC OP
Например, считывается системное сообщение операторского терминала:

13001 Not enough memory available on hard disk
(Недостаточно памяти, доступной на жестком диске)

SIMATIC S7 (Минимальный)
Выводятся номера сообщений системы сообщений S7. Причину ошибки
можно найти по номеру в руководстве по S7.

MESSAGE S4303   07.03.98 15:16:34
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SIMATIC S7 (Стандартный)
В дополнение к минимальному отображению выводится текст сообщения
системы S7. Для этого выберите соответствующее сообщение при
помощи стрелок.

MESSAGE S4303   07.03.98 15:16:34

Если нажать ПРАВУЮ стрелку:

PLC_1:
STOP by operating Stop switch
(•••••••••• ••• •••••• ••••••••• •••••••••••••)

Диагностический буфер SIMATIC S7
Текст сообщения диагностического события S7 считывается вместе с
Отображаемым Сообщением.

No
(Номер)

Time
(Время)

Date
(Дата)

Status
(Состоя
–ние)

Text (Текст)

12354 09:33:47 12.06.98 K Module (Модуль)

12484 09:34:18 12.06.98 K Distributed I/O: Station
(Распределенный
ввод/вывод: Станция)

16387 09:36:24 12.06.98 K STOP by operating Stop switch
(Остановите при помощи
стопового переключателя)

20493 09:36:25 12.06.98 K New startup information in
operating state STOP (Новая
информация запуска в
режиме СТОП)

4225 09:36:28 12.06.98 K Request for manual reload
(Запрос на ручную
перегрузку)
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5.9.9 Как протоколировать сообщения на принтере?

Включение и отключение протоколирования сообщений
Для протоколирования сообщений на принтер включите переключатель
Print (Печать) в диалоговом окне Attributes –  Message (Атрибуты –
Сообщения). Сообщение протоколируется при изменении его состояния
(активное, пассивное, подтвержденное).

Выбрав в меню System → Messages → Settings (Система → Сообщения
→ Настройки), можно установить флажок активизации
протоколирования сообщений.

Отчет
Вы также можете распечатать все сообщения из буфера сообщений в
определенный момент времени или по наступлению некоторого события.
Для этого сконфигурируйте отчет, включающий объект буфера
сообщений.

Дополнительная информация
Дополнительную информацию на эту тему можно найти в

•  Что такое буфер сообщений? (Глава 5.9.12)

•  Что такое отчет? (Глава 5.8.1)
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5.9.10 Отображение сообщений на операторском терминале

Сообщения отображаются в окнах сообщений. Операторским терминалом
можно управлять даже во время получения и отображения сообщений.

Установите свойства следующих объектов, выбрав в меню System →
Screen/Keys (Система → Экранная форма/Клавиши):

•  Окно сообщений/строка сообщений: здесь выводятся сообщения.

•  Индикатор сообщений: указывает на то, что неподтвержденное
аварийное сообщение поставлено в очередь.

Выберите в меню Insert → Message Display (Вставка → Экран
Сообщения) для конфигурирования следующих объектов экрана:

 Обзор сообщений (Что такое обзор сообщений? (Глава 5.9.11)): здесь
Вы можете задать, что следует отображать.

− сообщения

− события сообщений

− диагностический буфер S7 или

− содержимое архива сообщений

Критерий сортировки для аварийных сообщений
В случае, когда различные неподтвержденные аварийные сообщения с
одинаковым приоритетом встают в очередь, необходимо определить
критерий сортировки, выбрав в меню System → Messages → Settings
(Система → Сообщения → Настройки):

First (Первое) Первое (самое старое) аварийное предупреждение
отображается первым.

Last (Последнее) Последнее (самое новое) аварийное предупреждение
отображается первым.
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5.9.11 Что такое обзор сообщений?

Цель
В ProTool по умолчанию сообщения о событиях, аварийные сообщения и
системные сообщения операторского терминала  отображаются в
специальных окнах процесса.

Вместо этого обзор сообщений разрешает размещать табличные формы

•  сообщений

•  событий сообщений

•  содержимого выбранного архива сообщений

•  содержимого диагностического буфера S7 SIMATIC 300/400–CPU
(невозможно в WinAC и OPC)

Можно совместить отображение сообщений и событий сообщений для
следующих классов сообщений:

•  Аварийные сообщения

•  События сообщений

•  Системные сообщения

•  Диагностические сообщения S7

Для конфигурирования обзора сообщений, нажмите на
изображенную иконку.

Замечание
Используйте SHIFT + двойной щелчок для активизации обзора сообщений
(с масштабом 100%).
Также на стадии конфигурирования колонки можно перемещать в нужное
место и устанавливать их ширину.
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Как использовать обзор сообщений?
При необходимости можно отобразить следующие кнопки:

•  ACK: для подтверждения аварийных сообщений

•  HELP (ПОМОЩЬ): для отображения подсказки

•  EDIT (РЕДАКТИРОВАНИЕ): для запуска функций

 Дополнительную информацию можно найти в онлайновой справке
ProTool, см. Редактирование сообщений.

В операторском терминале отдельные колонки можно показывать или
скрывать в зависимости от Вашего желания, а также редактировать их как
таблицу, например:

•  Порядок размещения столбцов

•  Установка ширины столбцов

•  Установка столбцов в порядке возрастания и убывания

5.9.12 Что такое буфер сообщений?

Определение
Буфер сообщений — это буферная область оперативной памяти
операторского терминала, в которой в хронологическом порядке хранятся
события сообщений. Он имеет формат FIFO буфера определенного
размера и не обязателен для явного конфигурирования.

Размер буфера сообщений – 1024 события сообщений.

Хранение данных в буфере сообщений
Каждое событие сообщений хранится вместе со следующей
информацией:

•  номер сообщения

•  метка времени, включающая время и дату

•  идентификатор события (A для прибывших (Arrived), D для ушедших
(Departed) , K для подтвержденных (AcKnowledged))

•  текст сообщения

•  значение тега сообщения во время прибытия или убытия
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Пример
Пример вывода из буфера сообщений на операторский терминал:

No
(Номер)

Time
(Время)

Date
(Дата)

Status
(Состоя
– ние)

Text (Текст)

0010 11:34:26 27.03.98 K Давление котла слишком
большое: 12.7 Бар.

0029 11:35:18 27.03.98 K Поставка нефти
прекращена.

0010 11:38:09 27.03.98 (A)K Давление котла слишком
большое: 12.7 Бар.

0029 11:40:47 27.03.98 (A)K Поставка нефти
прекращена.

0010 11:58:08 27.03.98 (KQ)G Давление котла слишком
большое: 7.9 Бар.

5.9.13 Задание окна или строки сообщений

Установите отображение сообщений, на операторском терминале выбрав
в меню System → Screen/Keys (Система → Экранная форма/Клавиши).
Выберите одну из следующих комбинаций:

•  Окно – Окно

 Сообщения об ошибках и аварийные
сообщения отображаются в
отдельных окнах сообщений. Окно
аварийных сообщений открывается
автоматически всякий раз, когда
приходит аварийное сообщение. Для
включения и блокировки окна
событий сообщений выберите
функцию Event Window (Окно
Событий).

Окно сообщения о событии

Окно аварийных сообщений
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•  Окно – строка

 Аварийные сообщения выводятся в
окне сообщений, поскольку
сообщения о событии отображаются
в строке сообщений. Строка
сообщений видна все время. Окно
аварийных сообщений открывается
автоматически всякий раз, когда
приходит аварийное сообщение.

Окно  аварийных сообщений

Строка сообщений

•  Окно – off

 Аварийные сообщения
отображаются в окне сообщений,
сообщения событий не
отображаются.

 

Окно аварийных сообщений

•  Строка – строка

 Строка сообщений видна все время.
Любые появившиеся аварийные
сообщения или сообщения о
событиях отображаются в строке
сообщений в соответствии с их
приоритетом.

 

Строка сообщений

5.9.14 Что показывает индикатор сообщений?

Установите отображение индикатора сообщений на операторском
терминале, выбрав System → Screen/Keys (Система → Экранная
форма/Клавиши). Индикатор сообщения покажет, что ожидаются
аварийные сообщения

Окно аварийных сообщений и индикатор сообщений отображаются, как
только появится аварийное сообщение.

Идентификатор сообщения может быть в двух состояниях:

•  мигающий: когда как минимум одно неподтвержденное аварийное
сообщение встает в очередь.

•  статический: когда все стоящие в очереди аварийные сообщения
подтверждены, но хотя бы одно из них все еще не очищено.

 Индикатор сообщений исчезает только после убытия всех
подтвержденные сообщений. Таким образом, нельзя забыть о
поставленных в очередь аварийных сообщениях.
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5.9.15 Функции отображения сообщений

Сообщения отображаются в специальных окнах. Вы можете управлять
операторским терминалом даже во время прихода и отображения
сообщений .

В System → Screen/Keys (Система → Экранная форма/Клавиши)
установите, как будут отображаться сообщения во время исполнения
процесса. Можно выбрать строку или окно сообщения.

•  Строка сообщений постоянно находится на операторском терминале
и содержит только одно текущее сообщение. Если для аварийных
сообщений сконфигурировано отдельное окно сообщений, строка
сообщений содержит только текущее сообщение о событии.

•  Аварийные сообщения и сообщения о событиях отображаются в
разных окнах сообщений. Окно сообщения всегда содержит все
поставленные в очередь сообщения конкретного класса сообщений.

 Окно аварийных сообщений автоматически открывается, когда
приходит аварийное сообщение.

 Для окна сообщений о событиях можно сконфигурировать элемент
управления для помощи в закрытии–открытии окна.

Кроме того, в ProTool имеются следующие опции отображения
сообщений:

•  Отображение буфера сообщений

 Буфер сообщений содержит все события аварийных сообщений или
сообщений о событии. Для отображения буфера аварийных
сообщений или буфера событий, сконфигурируйте элемент
управления.

 Для задания более ясного формата буфера сообщений и в то же
самое время уменьшения загруженности системы сконфигурируйте
элементы управления, позволяющие пользователю удалить весь
буфер сообщений или его часть.

•  Сконфигурируйте отображение сообщений

 Можно выбрать сообщения для отображения:

− события сообщений из различных классов сообщений (также
возможны комбинации)

− текущее содержимое диагностического буфера S7 или архива
сообщений

Можно модифицировать внешний вид и поведение экрана сообщения
под нужды проекта.
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5.9.16 Какие коммуникационные области требуются для
сообщений?

Для корректной связи между операторским терминалом и PLC выберите в
меню System → Area Pointers (Система → Указатели Области) и
установите для проекта следующие коммуникационные области:
сообщения о событии и/или аварийные сообщения

Эти области необходимы, если сконфигурированы сообщения о событиях
и аварийных сообщений.

Их размер должен быть, по крайней мере, немного больше, чем нужно
для всех сконфигурированных сообщений. Если коммуникационная
область сделана недостаточно большой, то во время компиляции проекта
будет выдано предупреждение.

При желании можно создать следующие коммуникационные области:

•  PLC acknowledgement (подтверждение PLC)

•  OP acknowledgement (подтверждение OP)

5.9.17 Опциональные коммуникационные области сообщений

Если Вы хотите, чтобы подтверждение исходило от PLC, создайте
следующие области подтверждения, выбрав System → Area Pointers
(Система → Указатели Области).

•  PLC Acknowledgement (Подтверждение PLC)

 Бит подтверждения устанавливается программой PLC и поэтому
подтверждение соответствующего аварийного сообщения
отображается на операторском терминале.

 Область подтверждения PLC Acknowledgement (Подтверждение PLC)

− должна быть непрерывной со связанной областью аварийных
сообщений

− должна иметь тот же цикл опроса, что область аварийных
сообщений

− может иметь ту же длину, что и связанная область аварийных
сообщений, но не больше.

•  OP Acknowledgement (Подтверждение OP)

 Оператор подтверждает аварийные сообщения на операторском
терминале и, таким образом, устанавливает бит подтверждения этого
аварийного сообщения в PLC. При этом вся область подтверждения
передается в PLC.

 Область подтверждения OP Acknowledgement (Подтверждение OP)
может иметь тот же размер, что и связанная область аварийных
сообщений, но не больше.
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5.10 Процедура оповещения

5.10.1 Как инициируются сообщения?

Процедура оповещения:
Процедура оповещения определяет путь передачи сообщения и, как
следствие, параметры сообщения. В ProTool процедура оповещения —
это процедура битового сообщения.

С данной процедурой сообщения операторский терминал обнаруживает
прибытие, убытие или подтверждение сообщения, устанавливая бит в
адресной области, которая назначается в меню Система → Указатели
Области (System → Area Pointers) выбором области сообщений о
событиях/аварийных сообщений.

Сообщения событийно–управляемы и передаются, когда в PLC
устанавливается соответствующий бит. Установка, сброс и подтверждение
бита называются событием сообщения.

Активный (K) Бит сообщения был установлен и ожидается
отображение сообщения.

Очищенный (G) Бит сообщения был сброшен, потому что
причина его возникновения устранена.

Подтвержденный (Q) Только для аварийных сообщений:
Оператор (или PLC) подтвердили, что сообщение
было принято к рассмотрению.

События сообщений получаются операторским терминалом, и отмечается
время прибытия.

Операторский терминал автоматически вносит все сообщения в буфер
сообщений. В этом случае события сообщений могут быть рассмотрены
еще раз позднее.

Коммуникационная область для сообщений
Отображение сообщений на операторском терминале инициализируется
PLC с помощью установки бита в определенной коммуникационной
области.

На следующем рисунке видно, какие коммуникационные области для
сообщений могут быть созданы в PLC:
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Область аварийных
сообщений

Область сообщений
о событиях

Адресная областьИндикатор

000x сообщение

Буфер
сообщений

Принтер

Операторский терминал PLC

Отображение сообщений

5.10.2 Процедура нумерованного сообщения ALARM_S

Обзор
Эта глава предоставляет детальную информацию о процедуре
нумерованного сообщения ALARM_S .

Будет показано, чем ALARM_S отличаются от процедур битовых
сообщений и как система ведет себя в случае критических узких мест.

Требования
Конфигурирование отображения сообщения ALARM_S возможно только в
случае использования SIMATIC S7 PLC и при условии того, что ProTool
интегрирован со STEP 7.

Совет
Если Вы установите S7–PDIAG, то конфигурирование сообщения
ALARM_S станет значительно проще.
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Что такое ALARM_S?
ALARM_S — процедура нумерованного сообщения. Нумерованное
сообщение передается автоматически во время процесса
конфигурирования STEP 7. Номера используются как основа для
назначения корректного текста сообщения.

Когда возникает сбой, операторский терминал получает сообщение,
содержащее некоторый номер. На основе этого номера определяется и
отображается соответствующий текст сообщения.

S7–CPU сохраняет не только статус сообщения (пришедшее, убывшее,
подтвержденное), а еще и время. Эта информация не сбрасывается
немедленно после посылки сообщения, так что индивидуальные сетевые
компоненты (например, операторский терминал) могут в последствии
зарегистрироваться и внести изменения.

Преимущества ALARM_S
По сравнению с процедурами битового сообщения ALARM_S имеет
следующие преимущества:

•  ALARM_S активная процедура сообщений. При передаче сообщения
CPU сам оповещает все сетевые устройства. Операторский терминал
освобождается от задачи непрерывного опроса области сообщений.

•  Данные процесса всегда точно отображают ситуацию в момент
сообщения. Это не может быть гарантировано процедурами битового
сообщения.

•  Метка времени точно показывает, когда произошло событие, даже если
операторский терминал не был подключен до некоторого, более
позднего момента времени.

Классы отображений
Индивидуальные сообщения в STEP 7 могут быть присвоены разным
классам отображений. В ProTool во время конфигурирования для
операторского терминала можно выбрать несколько классов отображения.
В этом случае есть возможность выборочно распределить сообщения
между различными устройствами отображения.

Приоритеты
Во время конфигурирования сообщениям ALARM_S можно присвоить
разные приоритеты.

Совет
Убедитесь в том, что приоритеты, назначенные сообщениям,
могущим вызвать дальнейшие ошибки, имеют более высокий
приоритет, чем сами последующие ошибки.
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Типы сообщений ALARM_S
Вместе с конфигурацией сообщения в STEP 7, есть еще два типа
ALARM_S сообщений: аварийные сообщения и сообщения о событиях.

Замечание
В STEP 7 можно указать, нуждается ли сообщение ALARM_S в
подтверждении или нет.

Конфигурирование ALARM_S сообщений
ALARM_S сообщения не конфигурируются в ProTool, а только в STEP 7
(см. Конфигурирование сообщений ALARM_S (Глава 5.10.5)).
Преимуществом этого является то, что сообщения компилируются
централизовано и могут быть созданы только однажды.

5.10.3 Классы отображения

Что такое классы отображения?
S7–CPU всегда передает ALARM_S сообщения на все станции,
регистрирующие его. Однако, возможно Вы не хотите отображать на
конкретном операторском терминале все сообщения, например, для того
чтобы избежать гонки сообщений. В этом случае специфические
сообщения просто должны отображаться, например, на пульте
управления.

Для того чтобы управлять выборочным отображением событий в STEP 7,
каждому сообщению можно назначить класс отображения. Существует
16 классов отображения (с 0 до 15).

Пример:

Сообщениям, которые появятся на машине, можно назначить класс
отображения 1, тем же что появятся на пульте управления класс 2.

Различные операторские терминалы затем только проверяют сообщения
на принадлежность некоторым классам отображений. Все другие
ALARM_S сообщения немедленно отбрасываются.
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назначенный
класс отображений

выбранный
класс отображений

Сообщение A
1

Сообщение B
1

Сообщение C
0

Сообщение D
2

1

0

2

1

Классы отображения определяют, какие группы сообщений отображаются на
операторском терминале.

Определение классов отображения
Класс отображения, которому принадлежит ALARM_S сообщение,
определяется при конфигурировании сообщения в STEP 7. Для точного
описания процедуры обратитесь к информации о конфигурировании
сообщений в документации по STEP 7.

Если не определить класс отображения в STEP 7, сообщению
автоматически присвоится класс отображения 0.

Выбор классов отображения
В ProTool можно определить, какие классы сообщений будут
отображаться на конфигурируемом операторском терминале.

Выберете System → Messages → Settings (Система → Сообщения →
Настройки). Точное описание можно найти в главе Установка процедуры
оповещения и выбор классов отображения (Глава 5.10.4).

Если Вы не производили никаких настроек, все классы отображения (от 0
до 15) отображаются по умолчанию.
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5.10.4 Установка процедуры оповещения и выбор классов
отображения

Для определения процедур оповещения, которые предполагается
использовать, откройте диалоговое окно Message Settings (Настройка
Сообщений). Для открытия этого диалогового окна, выберете в меню
System → Messages → Settings (Система → Сообщения → Настройки).

Диалоговое окно Message Settings (Настройка Сообщений)

Выберете требуемую процедуру оповещения в нижней части диалогового
окна. Как только Вы выбрали ALARM_S, Вы можете воспользоваться
кнопкой Alarm_S для установки класса сообщений, которые будут
отображаться на операторском терминале.

Замечание
Если для проекта в ProTool выбрана только система сообщений
ALARM_S, тогда в дальнейшем в окне проекта данные для сообщений о
событиях и аварийных сообщениях предлагаться не будут.
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Выбор классов отображения
При выборе кнопки Alarm_S, открывается диалоговое окно SIMATIC S7
ALARM_S.

Диалог SIMATIC S7  ALARM_S

В этом диалоговом окне можно индивидуально для каждого PLC системы
установить сообщения, отображаемые на операторском терминале. По
умолчанию посылаются все сообщения.

Совет
Умышленно отбирая определенные сообщения, можно ограничить
отображение на конфигурируемом операторском терминале
определенным классом сообщений, другими словами очень конкретными
сообщениями. Другие сообщения можно отображать на другом
устройстве, например на контрольном пульте.

Левая колонка диалогового окна показывает список всех PLC в системе.
Для каждого PLC можно заставить операторский терминал не отображать
сообщения, отображать выбранные или все сообщения.

При выборе кнопки Details (Детали), откроется диалоговое окно Display
Classes (Классы отображения).
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Диалоговое окно Display Classes (Классы Отображения)

Классы отображений были бы определены, когда PLC программировался
в STEP 7. В то же самое время каждое сообщение было бы назначено
одному или другому классу отображения.

Теперь Вы можете выбрать индивидуальные классы отображения и
определить, какие сообщения будут отображаться на операторском
терминале.

Замечание
Сообщения типа ошибок Системы Отчетов всегда отображаются на
операторском терминале, какие бы классы не были выбраны.

5.10.5 Конфигурирование сообщений ALARM_S

Конфигурирование сообщений в STEP 7
Сообщения ALARM_S всегда конфигурируются в STEP 7, а не в ProTool.
Преимущество этого состоит в том, что можно использовать сообщения
на разных устройствах отображения, вводя их только один раз.

При конфигурировании сообщений в STEP 7 возможен либо ввод простого
неформатированного текста, либо использование ресурсов зависящей от
устройства конфигурации сообщений. В зависимости от того, о каком
отображении идет речь, можно задать такие эффекты, как мигание текста
и дополнительную информацию.

Следующие ресурсы доступны для конфигурирования ALARM_S
сообщений в STEP 7:
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•  Конфигурация, использующая S7–PDIAG

•  Конфигурация в S7Graph или HiGraph

•  Вызов через SFC17, SFC18

Замечание
Графические устройства вывода не поддерживают тегов с текстовыми
списками, которые можно сконфигурировать в STEP 7.

Более подробную информацию можно найти  в онлайновой подсказке на
STEP 7 и в соответствующих пакетах.

5.10.6 Встраивание сообщений ALARM_S

При конфигурировании сообщений в STEP 7 текст сообщений и
введенные атрибуты хранятся в общей с ProTool базе данных. Во время
компиляции проекта ProTool автоматически импортирует необходимые
данные и впоследствии загружает их в операторский терминал.

общая
база данных

COROS

Конфигурирование и загрузка сообщений ALARM_S

Следовательно, важно, чтобы общая база данных была самой новой во
время процесса компиляции и чтобы синхронизация данных была
активна.
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5.10.7 Обновление данных операторского терминала

S7–CPU сохраняет информацию только о рассматриваемых сообщениях,
и подразумевается, что  как только все события (прибытие, убытие,
подтверждение) произошли, сообщение удаляется из S7–CPU.

Сетевой операторский терминал, потерявший связь с S7–CPU может
снова подключиться к S7–CPU и получить корректные текущие
рассматриваемые сообщения.

Следовательно, при получении обновленных данных операторский
терминал обрабатывает некоторые отсутствующие события
автоматически, если сообщение неизвестно S7–CPU, но сообщения
прибытия или подтверждения не поступали на оперативный терминал.

События вводятся и помечаются в буфере сообщений операторского
терминала.

Пример 1: Стандартная ситуация
Данные для сообщения в буфере сообщений:

No
(Номер)

Time
(Время)

Date
(Дата)

Status
(Состоя
– ние)

Text (Текст)

3029 14:28:08 27.03.99 A Boiler 13: Temperature
190 degrees Notify shift
supervisor. (Котел 13:
Температура 190 градусов
Уведомление диспетчеру.)

3029 14:31:12 27.03.99 (A)K Boiler 13: Temperature
### degrees Notify shift
supervisor. (Котел 13:
Температура ### градусов
Уведомление диспетчеру.)

3029 14:40:37 27.03.99 (KQ)G Boiler 13: Temperature
120 degrees Notify shift
supervisor. (Котел 13:
Температура 120 градусов
Уведомление диспетчеру.)

Если сообщение содержит значения процесса, то в буфере сообщений
сохраняются те значения, которые были доступны, когда событие
сообщения прибыло или убыло. В случае, когда сообщение имеет статус
Подтвержденное, операторский терминал не принимает никакого
текущего значения процесса. Значение заменяется на ###.
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Пример 2: Ситуация потери связи
Операторский терминал возобновляет протоколирование S7–CPU после
потери связи. К этому времени сообщение уже не хранится в S7–CPU. На
операторском терминале отобразится следующее.

No
(Номер)

Time
(Время)

Date
(Дата)

Status
(Состоя
– ние)

Text (Текст)

3029 14:28:08 27.03.99 A Boiler 13: Temperature
190 degrees Notify shift
supervisor. (Котел 13:
Температура 190 градусов
Уведомление диспетчеру.)

3029 14:52:11 27.03.99 (KQG) Boiler 13: Temperature
### degrees Notify shift
supervisor. (Котел 13:
Температура ### градусов
Уведомление диспетчеру.)

Поскольку сообщение больше не хранится в S7–CPU, операторский
терминал не может считать значения процесса. Они меняются на ###.

5.10.8 Использование ресурсов

Сообщения ALARM_S конфигурируются в STEP 7. В дальнейшем данные
хранятся в разделенной базе данных, импортируемой во время
компиляции проекта ProTool и, в конце концов, окончательно загружаемой
в операторский терминал.

Это означает, что сообщения ALARM_S используют ресурсы
операторского терминала. Сообщения занимают меньше места в памяти,
чем требовали бы. В этом случае несущественно, какая процедура
оповещения использовалась.

Более подробную информацию можно найти в разделе Системные
ограничения (Глава A). В приложении содержится информация о
требованиях к памяти при конфигурировании, на основании которых
можно оценить, достаточен ли объем памяти операторского терминала
для предполагаемой конфигурации

Замечание
В STEP 7 существуют ограничения относительно количества и размера
тегов, которые могут использоваться в сообщении. За более подробной
информацией обратитесь к документации по STEP 7.
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5.10.9 Последовательность взаимодействия

Регистрация для ALARM_S
Для сообщения ALARM_S в сети возможна регистрация более, чем одной
станции (например, более одной OP, PU, и т.д..). Каждая станция, которая
хочет отображать сообщения ALARM_S, регистрируется в CPU для
ALARM_S.

OP

S7

CPU

PUTP

CPU
S7

MPI сеть

Когда происходит событие сообщения
Когда происходит событие, инициированное сообщением, CPU посылает
об этом оповещения всем зарегистрированным станциям. Номер
сообщения определяет соответствующий текст сообщения, который
прежде был загружен в операторский терминал.

Это значит, что CPU не должен постоянно сканироваться для
обнаружения сообщений, как это было бы в случае процедуры битового
сообщения. Операторский терминал и сеть не перегружают систему.

Метка времени
С процедурой ALARM_S метка времени передается CPU, а не
операторским терминалом. Сообщения хранятся в хронологическом
порядке на основе их метки времени в буфере сообщений на
операторском терминале – даже если они пришли с разных CPU.
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Хранимая информация
Для сообщения CPU хранит не только время, но еще статус (прибывшее,
убывшее, подтвержденное) и другие параметры процесса. Информация
сохраняется до тех пор, пока сообщение не будет полностью обработано,
то есть пока оно не прибудет, убудет и не будет подтверждено. На
операторском терминале информация в буфере сообщений хранится
дольше.

5.10.10 Подтверждение сообщений ALARM_S

Сообщения ALARM_S, требующие подтверждения
Когда сообщение подтверждается станцией в сети, CPU немедленно
уведомляется об этом. Затем CPU рассылает подтверждение всем
присоединенным станциям. Операторский терминал реагирует только на
это сообщение, то есть только в этот момент подтверждение вносится в
буфер сообщений.

Замечание
CPU для подтверждаемого сообщения передает метку времени, но не
хранит ее. Следовательно, в дальнейшем, когда совершаются
последующие изменения, нельзя установить, когда сообщение было
подтверждено (см. Обновление содержимого операторского
терминала).

Сообщения ALARM_S, не требующие подтверждения
Определенные сообщения ALARM_S сконфигурированы как аварийные
сообщения, но не требуют явного подтверждения пользователем. Такие
сообщения подтверждаются CPU автоматически по мере поступления.

5.10.11 Распечатка сообщений ALARM_S

Обычно выбор сообщений, которые будут выводиться на принтер,
осуществляется в  ProTool в меню System → Messages → Settings
(Система → Сообщения → Настройки).
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Протоколирование сообщений
Если не определены зависящие от устройства настройки сообщений в
STEP 7 (посмотрите конфигурирование сообщений ALARM_S), все
события сообщений автоматически  протоколируются непосредственно на
подключенном принтере.

Если сконфигурированы зависящие от устройства сообщения, для
каждого сообщения можно указать, должно оно протоколироваться, или
нет.

Сообщения всегда распечатываются в том порядке, в котором они
посылались CPUs. Это также делается для синхронизации.

Замечание
Если в сети находятся несколько CPU, это обозначает, что сообщения
не всегда получаются операторским терминалом в хронологическом
порядке.
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5.11 Использование функций

Обзор
Функции являются центральным элементом конфигурации в ProTool. в
этой секции объясняется, какие функции и используются в практике и как
они используются.

5.11.1 Для чего используются функции?

Основной принцип
В ProTool можно связать события  (например "нажатие клавиши") с
предопределенными функциями. При наступлении события на
операторском терминале или PLC выполняется назначенная функция и
некоторое действие.

Например, функция "Выбор Экрана" отображает экран настройки на
операторском терминале.

Событие
Нажатие клавиши

Action:
Переключение экрана

Функция:
Выбор Экрана

A B

Вызов функции
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Области приложения
В общем, Вы можете использовать функции для:

•  Установки конфигурации для процесса
(например, переключение между экранами)

•  Управления процессом
(например, установка для включения двигателя)

•  Использования дополнительных возможностей операторского
терминала
(например, отображение или печать буфера сообщений)

•  Исполнения онлайновых системных установок на операторском
терминале
(например, смена режима)

В большинстве случаев, возможно конфигурирование поведения функций
посредством параметров. Если Вы хотите активизировать несколько
действий, Вы можете объединить различные функции.

Конфигурирование
Конфигурирование функций осуществляется на закладке Functions
(Функции) в диалоговом окне свойств соответствующего объекта.

Для некоторых операторских терминалов можно также определить
глобальные точки входа, выбрав в меню System → Functions (Система →
Функции).

5.11.2 События для активизации функций

Необходимость
Исполнение функции всегда связано с некоторым событием. Функция
активизируется только когда, когда это событие происходит.

События, которые могут быть связаны с функцией, зависят от типа
функции. Многие функции работают только с определенным классом
событий.

Примеры
Примерами событий, которые могут активизировать функции, являются
события "нажатия клавиши" и "отпускания клавиши". В первом случае
функция выполняется в момент нажатия определенной функциональной
клавиши, во втором, она выполняется в момент, когда функциональная
клавиша отпускается.
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Функции, связанные с объектом
Функции и события обычно связываются с определенными объектами.
Например, функция, привязанная к событию "нажатие клавиши"
активизируется, когда нажата некоторая, вполне определенная клавиша.

Например, следующие объекты могут быть связаны с функциями:

•  Функциональные клавиши, контекстно–зависимые клавиши и кнопки

•  Объекты экранной формы

•  Экранные формы

•  Теги

В зависимости от операторского терминала, может оказаться
невозможным конфигурирование функций для всех этих объектов.

Совет
Функции с тегами активизируются, только когда выбрана закладка Read
Options Continuously (Непрерывное Чтение Опций) или тег отображается
на экранной форме.

Глобальные функции
Также возможно связать некоторые функции с глобальными,
независимыми от объекта событиями. Они могут активизироваться в
следующих случаях:

•  когда тег инициализируется или в момент запуска системы

•  когда вводится значение

•  когда печатается содержимое экрана (Печать экрана)

•  когда буфер сообщений переполняется или удаляется

•  когда считывается или записывается запись рецепта

В зависимости от операторского терминала, может оказаться
невозможным конфигурирование всех событий.

Подробное описание всех допустимых событий можно найти в
онлайновой справке ProTool в разделе Configurable events
(Конфигурируемые события).
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5.11.3 Параметры функций

Необходимость
Многие функции могут выполнять только одно определенное действие.
Действие этих функций однозначно определяется  по их имени.
Например, функция Events – Delete Buffer(События – Удалить
буфер) очищает буфер сообщений о событиях.

Функция Предопределенное
действие

Функция без входных параметров

Тем не менее, ситуация не всегда такая простая. Множество функций
может работать по–разному.

Входные параметры
Представьте, что Вы хотите открыть другую экранную форму с помощью
клавиши на операторском терминале. Для этого сконфигурируйте
функцию для кнопки Выбор экрана. Однако Ваш проект обычно имеет
несколько разных экранных форм. Какую из них откроет ProTool?

Следовательно, необходимо передавать функции больше информации.
Это делается с помощью параметров. Например, определите для
функции Выбор экрана такой параметр, как имя открываемого экрана.

Другой пример – функция языка. В этом случае определяемый параметр –
язык, который будет установлен.

Действие, зависящее
от входного параметраФункцияВходной

параметр

Функция с входным параметром

Некоторые функции требуют один параметр, другие — несколько.
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Основной принцип
Следующий рисунок иллюстрирует принципы работы функции:

Тег

Тег

Константа

Функция

Как работает функция

Входной параметр определяется для функции. Это может быть константа
или значение, считанное из тега. Тег может быть локальным или иметь
связь с PLC. Если присутствует связь с PLC, значение устанавливается
процессом. Результат функции записывается в тег, который сам по себе
может быть локальным или иметь связь c PLC.

5.11.4 Комбинирование нескольких функций

Несколько функций с одним объектом
Вы можете назначить событию несколько функций. Функции
инициируются одна за другой. Порядок их вызова устанавливается в
диалоговом окне Functions (Функции) во время конфигурирования. Вы
можете поменять порядок функций с помощью кнопок Up (Вверх) и Down
(Вниз).
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Несколько функций с одним объектом

Последовательность
Список функций обрабатывается сверху вниз.

Руководство по этой теме можно найти в онлайновой подсказке ProTool.

Замечание
Из–за разного времени исполнения функций запуск следующей функции в
списке не связан с завершением предыдущей функции в списке. Таким
образом, может случиться, что несколько функций будут выполняться
параллельно и результат предыдущей функции все еще не будет
доступен.

Функции ProTool упрощают архивацию данных процесса (Глава 5.12.1).

5.11.5 Пользовательские функции

Специальные задачи
Если Вы хотите выполнить действие или вычисление, для которого нет
встроенных  функций ProTool, Вы можете с помощью скрипта VisualBasic
Script определить собственную функцию, включить ее и использовать
точно также как функции ProTool.

Для получения более подробной информации по скрипту VisualBasic
обратитесь к разделу Создание скриптов VB (Глава 5.15).
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Функциональные блоки
Скрипты также можно использовать для простого создания многократно
используемых функциональных блоков, которые потом будут вызываться
в проекте, без необходимости каждый раз вновь конфигурировать
функции.

5.11.6 Особенности функций преобразования

Возможности преобразования
Существует две возможности преобразования величины между PLC и
операторским терминалом:

•  Для одного тега можно сконфигурировать простое линейное
преобразование между разными шкалами в диалоговом окне Tag (Тег)
на закладке Conversion (Преобразование).

 В качестве примера можно привести преобразование между двумя
единицами измерений, такими как градусы Цельсия и градусы
Фаренгейта.

•  Для других типов линейного преобразования с несколькими тегами
используйте функции Scaling Linear 1 и Scaling Linear
2(Линейное масштабирование 1 и Линейное масштабирование
2), а также скрипты.

Особенности, связанные с функциями и скриптами
Автоматически выполняемые преобразования тега конфигурируются для
события "Value Change" (Изменение Значения). Поскольку при обратном
преобразовании изменение должно отображаться по–разному, в
зависимости от того порождается это изменение PLC или операторским
терминалом, необходимо использовать вспомогательный тег. Следующий
рисунок показывает схему того, как это происходит:
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VAR 1
без связи с

PLC

VAR 1
связанная с

PLC

Функция/
Скрипт

Масштаб. 1

Функция /
Скрипт

Масштаб. 2

поля ввода/вывода PLC

Событие
Изменение
значения

Обратное преобразование

Когда сделаны изменения в поле ввода/вывода, имеет место следующее:

1. Меняется значение тега VAR_1.

2. Функция или скрипт преобразует VAR_1 в VAR_2, активизируя событие
"Value Change" (“Изменение значения”).

3. Поскольку VAR_2 имеет связь с PLC, измененное значение доступно в
PLC.

Когда значение меняется в PLC, имеет место вычисление обратной
функции:

1. Поскольку VAR_2 имеет связь с PLC, изменяется значение VAR_2.

2. Функция или скрипт для преобразования VAR_2 в VAR_1
активизируется событием "Value Change"(Изменение значения).

3. Измененное значение VAR_1 появляется  в поле ввода–вывода на
операторском терминале.
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Совет
Во избежание рекурсии функции не исполняются при событии "Value
Change"(Изменение значения) когда значение тега меняется в результате
работы другой функции. Таким образом, изменения в теге VAR_2 не
вызовет немедленного изменения VAR_1, которое должно закончиться
бесконечным циклом.

5.11.7 Пример смены и отображения режима работы

Следующий пример использования функции Mode (Режим) показывает,
как конфигурировать функции с параметрами. Вы также увидите, как
результат появляется на операторском терминале.

Цель
Вы хотите установить Online (Онлайновый) и Offline(Оффлайновый)
режим работы посредством двух функциональных клавиш. На
операторском терминале появляется текст "Online Mode" ("Онлайновый
режим") или "Offline Mode" ("Оффлайновый режим ").

Как конфигурировать функции
1. Создайте и откройте экранную форму, на которой будут происходить
переключение и отображение.

2. Щелкните функциональную клавишу, которую хотите использовать для
переключения в режим работы Online (Онлайновый).
Появится диалоговое окно Function Key (Функциональная Клавиша).

3. Выберете закладку Functions (Функции).

4. В Selected Functions (Выбранная функция), выберете событие Press
Key (Нажатие клавиши).

5. Выберете флажок Display Selectable Functions (Отображать
Выбираемые Функции).
Появится окно Select Object (Выбор Объекта).

6. Выберете функцию Change_Mode в группе функций Switch
(Переключение).
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7. Щелкните кнопку Add (Добавить).
Появится диалоговое окно Parameters (Параметры).

8. Выберите из списка параметр Operating Mode (Режим Работы) и
введите значение 0 в поле ввода под списком. Этот параметр
управляет поведением функции Mode (Режим), если режим меняется
на онлайновый.
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9. Для закрытия диалогового окна Parameters (Параметры) щелкните
OK.
Функция появится в списке Selected Functions (Выбранные Функции).

10. Настройте Set Bit (Установка Бита) как секундную функцию.
Определите локальный тег типа Bool в качестве параметра. Вы можете
создать тег во время назначения, щелкнув стрелку, указывающую
направо под списком в диалоговом окне Parameters (Параметры).
Настройте тег со следующими данными:

Name
(Название):

Operating Mode (Режим работы)

PLC: <no PLC> (<нет PLC>)

Type (Тип): Bool

 Обе функции со сконфигурированными параметрами появятся в списке
в диалоговом окне Function Key (Функциональные Клавиши).

 
11. Повторите шаги со 2 по 10 для второй функциональной клавиши. На
шаге 8 на этот раз используйте параметр 1. На шаге 10, в отличие от
предыдущего, сконфигурируйте функцию Reset Bit (Сброс Бита).
Используйте тег Operating Mode (Режим работы), созданный на
шаге 10 во время конфигурации первой функции.

На следующем шаге создайте поля вывода, содержимое которых
автоматически меняется в зависимости от тега Operating Mode (Режим
Работы). Таким образом, пользователь в любое время может прочитать
на операторском терминале, какой режим установлен к настоящему
моменту времени.
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Как конфигурировать отображение
1. Вставьте символьное поле вывода в экранную форму.
Появится диалоговое окно Symbolic Output Field (Символьное Поле
Вывода).

2. В Index Tag (Индексный Тег) выберете предварительно созданный тег
Operating Mode (Режим Работы).

3. Щелкните на стрелку, указывающую направо под Text or Graphic List
(Список Текстов и Графики), и выберете в появившемся меню New
(Новый).

 
 Появление диалогового окна Text or Graphic List (Текстовый или
Графический список).

4. Дайте текстовому или графическому списку название Status
(Состояние) и создайте список со следующими данными:

 Type (Тип): Bit 0

 Value (Значение): 0 Text: Online Mode (Текст: Онлайновый
Режим)

 Value (Значение): 1 (Текст: Оффлайновый Режим)
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5. Щелкните OK для того чтобы подтвердить все введенные данные
диалогового окна.

Во время исполнения оператор может использовать две
сконфигурированные функциональные клавиши для установки режима
работы и прочитать текущий режим работы на экране.

5.11.8 Функции конфигурирования времени исполнения

Вы можете определить поведение проекта во время исполнения, а также
то, какие опции будут доступны оператору.

Какие возможны настройки?
Вы можете произвести следующие настройки, которые будут полезны во
время исполнения:

•  Автоматический запуск проекта во время запуска системы   

 Автоматический запуск ProTool проекта во время запуска
операторского терминала.

•  Полноэкранное отображение или оконное   

 Проект отображается на операторском терминале, используя целый
экран, или запускается в меньшем окне, так что на экране есть место
для других приложений.

 В начале проекта необходимо правильно решить, как Вы хотите
отображать его во время исполнения, так чтобы Вы могли создавать
экранные формы правильного размера.
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− Активна настройка Full Screen (Полный Экран)

 Эта настройка пригодна для большинства проектов. С настройкой
Full Screen (Полный Экран) у Вас есть большее доступное
пространство для Ваших экранных форм и окон, поскольку
отсутствует граница и заголовок окна.

− Настройка Full Screen (Полный Экран) отключена

 Если настройка Full Screen отключена, проект запускается в окне
как в Windows с границей и заголовком. Оператор может изменять
размер окна, минимизировать и максимизировать окно, помещать
его на панель задач и закрывать, таким образом, завершая
ProTool/Pro RT.

•  Запрещение переключения между задачами

 Эта опция позволяет остановить вызов оператором других программ
на операторском терминале. Во время исполнения операторский
терминал доступен только для проекта ProTool.

Предупреждение
Если включена настройка Inhibit Task Switching (Запрещение
Переключения Между Задачами), обязательно
сконфигурируйте клавишу с функцией Exit_Runtime
(Завершение времени исполнения). Иначе Вы не сможете
завершить ProTool/Pro RT или Windows. Комбинация клавиш
CTRL + ALT + DEL также не действует.

В зависимости от требований к проекту, можно объединять настройки для
времени исполнения. Это позволит, например, гарантировать, что система
доступна только для определенного проекта ProTool.
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5.12 Создание архивов

Обзор
Системы на базе Windows предоставляют возможность архивировать
данные процесса (то есть хранить их как угодно долго и анализировать).

Можно архивировать следующие типы данных процесса:
•  Теги
 В диалоговом окне Tags (Теги) Вы определяете условие активизации и
диапазон значений для архивации тегов.

•  Сообщения
 Выбрав в меню System → Messages → Settings (Система →
Сообщения → Настройки) можно определить, какие сообщения будут
архивироваться.

•  Тренды
 Используйте закладку Data Source (Источники Данных) в диалоговом
окне Trend (Тренд) для установки архива, из которого будут читаться
теги для отображения тренда.

5.12.1 Архивирование данных процесса

Свойства архива, такие как место хранения и т.д. определяются в
диалоговом окне Archives (Архивы).

Модель архивирования
Следующая диаграмма показывает модель архивирования:

Данные процесса Архивы Способ хранения

Тег 1

Тег 4

Тег 3

Тег 2

Тренд 2

Тренд 1

Событие сообщения 1

Событие сообщения 2

Событие сообщения 3

Архив тегов 1

Архив сообщений 1

Архив тегов 3

Архив тегов 2

Файл

База данных

База данных

Модель архивирования
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Носитель для хранения
Данные могут архивироваться на различные носители:

•  Файл: каждый архив сохраняется в отдельном файле. Необходимо
определить путь в Storage Location (Расположение Хранилища).

 Если при создании архива Вы не ввели ничего в Path Name (Путь) в
закладке Settings (Настройки) или определили только диск, например
C:\, то архив не будет создан.

•  База данных (за исключением MP270): база данных определяется
при помощи ее data source name (имени источника данных). Выберете
базу данных, которую хотите использовать в ProTool в меню Start
(Пуск) в Settings → Control Panel → ODBC Data Sources (Настройка →
Панель управления → Источники Данных ODBC). В основном, может
использоваться любая база данных предоставляющая OLE DB
Interface 1.1 ().

Замечание
Можно создать не больше 40 архивов (см. также Системные ограничения
(Глава A.1)).

Сохранение данных в файле
Данные хранятся в файле в соответствии со стандартом Microsoft  CSV,
то есть, в текстовом файле, который хранит данные, разделенные
свободно задаваемым разделителем, например, запятой. Все данные
хранятся в ANSI кодировке. Файлы CSV могут загружаться и
редактироваться другими программами для анализа данных.

Замечание
В случае MP270 внутренняя FLASH–память не может задаваться в
качестве места хранения.

Сохранение данных в базе данных
ProTool позволяет вместо файла сохранять архивы непосредственно в
базе данных. То есть Вы имеете в своем распоряжении
полнофункциональную базу данных для дальнейшей обработки и оценки
данных архива.

Для использования с ProTool/Pro RT рекомендованы следующие базы
данных:

•  MS Access 97

•  MS SQL Server 6.5
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Для того чтобы разрешить сохранение архивируемых данных в базе
данных, в ProTool вместо имени каталога должен быть определен "data
source name" (DSN, наименование источника данных). DSN используется
для предоставления точной ссылки на базу данных и ее расположение.

Источник данных, то есть база данных, в которой хранятся данные,
должна быть установлена на том же компьютере, что и среда исполнения.
DSN конфигурируется а затем определяется в ProTool во время создания
архива.

Руководство по данному вопросу можно найти онлайновой помощи
ProTool .

5.12.2 Свойства архива

Возможны два типа архивов:

•  Short–term archive (Краткосрочный архив) – это FIFO буфер, это
обозначает, что если, например, буфер имеет емкость 100, то хранятся
только последние 100 значений. Старые значения перезаписываются.

 Замечание
Реально, всегда можно считать меньше 80% значений из буфера.
Следовательно, если Вы хотите иметь точное количество доступных
значений (скажем 100 значений), Вы должны быть уверены, что
создали больший FIFO архив (скажем 125 значений).

•  Sequence archive (Последовательный архив) заполняется до
определенного размера. Затем для продолжения работы необходимо
изменить настройки архива.

 Для последовательных архивов можно выбрать одну из следующих
опций:

− Automatically Create Sequence Archive (Автоматическое Создание
последовательного архива)
Автоматически создается новый архив. Архивы получают
определенное имя архива добавлением номера (1 ... n).
Количество архивов можно сконфигурировать. Как только
последний архив оказывается заполненным, первый архив
начинает заполняться вновь.

− Output System Message When (Когда Выводится Системное
Сообщение)
Если архив (например, дискета) заполняется, выводится
системное сообщение. Вы можете определить уровень в
процентах, при котором будет выводиться сообщение.

− Trigger Function (Активизация Функции)
Когда архив полон, активизируются функции, включающие
специальную обработку последовательного архива.
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5.12.3 Пример создания архива сообщений

Задача
Вы хотите создать архивы для сообщений, каждый по 300 записей.

Процедура:
Проделайте следующее:

1. Дважды щелкните на тип объекта Archives (Архивы) в окне проекта для
открытия диалогового окна Archive (Архив).

2. На закладке General (Общее), выберите Messages (Сообщения).

3. В Behavior at Restart (Поведение при Перезагрузке), выберите Reset
Archive (Восстановит архивы). Это означает, что в случае
перезагрузки архив будет заполняться с начала.

4. На закладке Settings (Настройки), определите File (Файл) в Storage
Location (Место Хранения).

5. Для Size (Размер) введите 300 элементов.

6. В Behavior When Archive Full (Поведение Когда Архив Полон), выберите
Automatically Create Sequence Archive (Автоматическое Создание
Последовательного Архива) и введите номер 7 (то есть, будут
созданы 8 архивов). Когда они все будут заполнены, первый будет
затерт.

5.12.4 Пример структуры архива сообщений

Здесь приведен пример файла для сообщений:

"Time_ms";"MsgProc";"StateAfter";"MsgClass";"MsgNumber";"V
ar1";"Var2";"Var3";"Var4";"Var5";"Var6";"Var7";"Var8";"Tim
eString"

36341550590,27;1;1;3;110001;"";"";"";"";"";"";"";"";"30.06
.99 13:12:51"

36341550682,87;1;1;3;140010;"";"";"";"";"";"";"";"";"30.06
.99 13:12:59"

36341550682,87;1;1;3;140001;"2";"0";"0";"";"";"";"";"";"30
.06.99 13:12:59"

36341550682,87;1;1;3;170003;"PLC_1:";"0x80000104";"";"";""
;"";"";"";
"30.06.99 13:12:59"

36341601759,25;1;1;3;190011;"";"";"";"";"";"";"";"";"30.06
.99 14:26:32"
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В различных столбцах выводятся следующие данные:

Time_ms Метка времени, преобразованная к десятичному*)
формату

Msg_Proc Процедура сообщений:

0 = Неизвестная процедура сообщений
1 = Системное сообщение
2 = Процедура битового сообщения (сообщения о
событиях)
3 = ALARM_S процедура нумерованного сообщения
4 = Диагностическое событие S7
100 = Процедура битового сообщения (аварийные
сообщения)

StateAfter Событие сообщения:

0 = Активное/очищенное
1 = Активное
2 = Активное/подтвержденное/очищенное
3 = Активное/подтвержденное
4 = Активное/очищенное/подтвержденное

Msg_Class Класс сообщений:

0 = не принадлежит классу сообщений
1 = аварийное сообщение
2 = сообщение о событии
3 = системное сообщение
4 = диагностическое событие S7

MsgNumber Номер сообщения
Var1 ... Var8 Значение тегов сообщения как строки
TimeString Метка времени как строка в удобочитаемом формате

даты

*) Замечание преобразование значений для столбца Time_ms:

 Если Вы хотите обработать это значение в другой программе, оно
должно быть разделено на 1 000 000.

 Пример: 36343476928: 1 000 000 = 36343.476928

 Даты, начиная с 31.12.1899, вычисляются по той части полученной
величины, которая лежит до точки.

 Время получается из значения, следующего после точки: 0.476928.
Умножая на 24, получаем часы; умножая остаток на 60 получаем
минуты; опять умножая остаток на 60 получаем секунды; остаток,
умноженный на  1000, дает миллисекунды.

 Результат: 2.07.1999   11:26:46
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5.12.5 Пример структуры архива тегов

Здесь приведен пример файла для тегов:
"VarName";"TimeString";"VarValue";"Validity";"Time_ms"

"Var_107";"01.04.98 11:02:52";66,00;1;35886460322,81

"Var_108";"01.04.98 11:02:55";60,00;1;35886460358,73

"Var_109";"01.04.98 11:02:57";59,00;1;35886460381,22

В различных столбцах выводятся следующие данные:

VarName Имя тега ProTool
TimeString Метка времени как строка в удобочитаемом формате

даты
VarValue Значение тега
Validity Достоверность: 1 = значение правильное

0 = произошла ошибка
Time_ms Метка времени, преобразованная к десятичному

формату*): она требуется только для отображения
значения тега на тренде.

*) Замечание преобразование значений для столбца Time_ms

 Если Вы хотите обработать это значение в другой программе, оно
должно быть разделено на 1 000 000.

 Пример: 36343476928: 1 000 000 = 36343.476928

 Даты, начиная с 31.12.1899, вычисляются по той части полученной
величины, которая лежит до точки.

 Время получается из значения, следующего после точки: 0.476928.
Умножая на 24, получаем часы; умножая остаток на 60 получаем
минуты; опять умножая остаток на 60 получаем секунды; остаток,
умноженный на  1000, дает миллисекунды.

 Результат: 2.07.1999   11:26:46



Приемы конфигурирования

ProTool: Конфигурирование систем на базе Windows
Версия от 12/99 5–111

5.12.6 Отображение архивных данных в заданном временном
окне

Отображение данных архива (то есть тегов и сообщений) на
операторском терминале возможно в форме трендов (для тегов) или
экрана сообщений (для сообщений).

Для быстрого и простого отображения данных архива начиная с
некоторого момента времени, можно ввести требуемые дату и время в
поле ввода.
•  На экране сообщения будут отображены сообщения, начиная с
выбранного момента времени.

•  Для этого создайте на экранной форме вышеупомянутое окно времени
и график тренда и отобразите данные архивных трендов, начиная с
установленного момента времени.

На следующем рисунке показан пример графика тренда:

25.06.99  11:30:00

07:00:00
25.06.99

18:59:06
25.06.99

Окно времени в
графике тренда

11:30:00
25.06.99

Вспомогательная
линия

Пример графика тренда и поля ввода
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5.12.7 Пример отображения архивных данных в заданном
временном окне

Цель
Вы хотите отобразить на операторском терминале тренд, показывающий
данные архива  начиная с определенного момента времени. Также Вы
хотите быстро и легко получить доступ к конкретному моменту времени,
не затрачивая много времени на прокрутку экрана.

Процедура:
Как конфигурируется поле ввода для тренда архива:

1. Сконфигурируйте поле ввода, в которое вводится начальное время
отображения данных архива:

 Display (Отображение):       Date(Дата)
Decimal places (десятичные позиции):  0
Field Length (Длина поля):    15

2. Выберете тег без связи с PLC в  формате дата/время:

 Name (Имя):      VAR_15
PLC:       <No PLC>
Type (Тип):       DATETIME

3. В графике тренда перейдите к закладке Axis Scaling
(Масштабирование осей) и выберете VAR_15.

Результат:

Если ввести дату и время на операторском терминале в поле ввода, то
отобразятся данные архива начиная с определенного момента времени.

Замечание
Для отображения сообщений, перейдите на закладку General (Общее) и
выберите тег с начальным моментом времени.
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5.12.8 Использование функций архивации

Системы на базе Windows предоставляют возможность архивировать
данные процесса, то есть сохранять их как угодно долго и оценивать.

Что содержит архив?
В зависимости от сохраняемых данных процесса, существуют различные
типы архивов:

•  Архив сообщений
 Архив сообщений для хранения событий сообщений одного или
нескольких классов сообщений (сообщения о событии /аварийные
сообщения/системные сообщения).

 Тем не менее, можно присваивать отдельный архив каждому классу
сообщений.

•  Архивы тегов
 Архив тегов содержит значения одного или нескольких тегов в
некоторый момент времени.

 Тем не менее, можно присваивать отдельный архив каждому тегу.

Свойства архива, такие как его размещение в памяти определяются в
диалоговом окне Archive (Архив).

Модель архивирования для проекта можно найти в Archiving process data
(Архивирование данных процесса).
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Как архивируются данные процесса?
Обычно сообщения и теги архивируются в течение всей длительности
процесса. Когда архив полон, данные архивируются в последовательные
архивы, конфигурируемые для исходного архива.

С помощью функций ProTool можно модифицировать пути архивации для
удовлетворения требованиям проекта. Здесь приведены примеры
приложений:

•  Пользователь может архивировать сообщения и теги в
"незарегистрированной" базе.

•  Пользователь может переключать архивы по своему выбору.

•  При запуске последовательного архива выполняются другие функции.

•  Архив сообщений  или архив тегов отображаются на операторском
терминале.

•  Данные архива сохраняются в базе данных и в дальнейшем
обрабатываются.

•  Данные архива копируются и в дальнейшем обрабатываются другой
программой.

В онлайновой помощи ProTool можно найти описание того, как
продолжить конфигурирование.

Где сохраняются архивы?
Данные можно архивировать в разных форматах хранения:

•  Файл: каждый архив сохраняется в отдельном файле. Данные
сохраняются в соответствии со стандартом Microsoft  CSV, то есть в
текстовый файл данные в котором разделяются точкой с запятой. Все
данные хранятся в ANSI кодировке. CSV файлы можно считывать и
обрабатывать другими программами для оценки данных.

•  База данных (не для MP270): каждый архив также сохраняется
непосредственно в базе данных и в дальнейшем там обрабатывается.

Замечание
Максимальное количество архивов, которые могут быть созданы – 40 (20
с MP270) (см. также Системные ограничения (Глава A.1)).



Приемы конфигурирования

ProTool: Конфигурирование систем на базе Windows
Версия от 12/99 5–115

5.13 Создание рецептов

Обзор
В этой главе вы узнаете, как конфигурировать рецепты. Здесь вы найдете
следующую информацию:

•  Что такое рецепт? (Глава 5.13.1)

•  Конфигурирование рецептов (Глава 5.13.5)

•  Что такое обзор рецепта? (Глава 5.13.2)

•  Что такое экран рецептов? (Глава 5.13.4)

•  Требования к редактированию записей (Глава 5.13.8)

•  Пример: как создать рецепт (Глава 5.13.10)

•  Синхронизация с PLC (Глава 5.13.6)

5.13.1 Что такое рецепт?

Назначение
Рецепты предназначены для совместной синхронной передачи объемов
связанной информации с операторского терминала в PLC и обратно.

Принцип
Термины рецепт и запись определим на примере картотеки:
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Система розлива
фруктовых напитков

Грейпфрут

Лимон

Апельсин

Напиток

Нектар
Сок

Яблоко

Рецепт и запись в картотеке

•  Рецепт
Рецепты соответствуют секциям картотеки, как показано на рисунке
(например, Апельсин или Лимон.) Поля ссылочных значений (теги)
принадлежащие к конкретному рецепту, определяются в каждой
секции. Рецепт используется для определения структуры данных
Вашего проекта ProTool.

 Впоследствии вы не можете изменить эту структуру на операторском
терминале.

•  Запись
Записи соответствуют карточкам в секциях картотеки (Напиток, сок и
нектар). Записи содержат значения для рецепта.

 Вы редактируете записи на операторском терминале, создавая,
сохраняя и удаляя их.

 Функции Экспорта/Импорта дают Вам дополнительные возможности
использования внешних средств редактирования экспортированных
записей с последующим их импортом.
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Пример рецепта
Примером рецепта может служить система розлива фруктовых напитков.
Данная система способна производить апельсиновый напиток, сок и
нектар. Для приготовления используются одни и те же ингредиенты, но
разные пропорции, в зависимости от типа напитка.

Предположим, что создан рецепт под названием Смесь, содержащий
следующую структуру данных:

Тег Обозначение
Var_2 л апельсин

Var_3 л вода

Var_4 кг сахар

Var_5 г вкусовая добавка

Обозначения также называются именами элементов. Имена элементов
также отображаются на операторском терминале. Например, тег Var_2,
можно определить как тег, обозначающий один из компонентов смеси, а
именно апельсин.

Записи содержат значения для различных типов напитков. Вид записей
может быть, например, таким:

Смесь Апельсиновый
сок

Апельсиновый
нектар

Апельсиновый
напиток

л апельсин 95 90 70

л вода 5 10 30

кг сахар 3 10 45

г вкусовая
добавка

100 300 600
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5.13.2 Что такое обзор рецепта?

Назначение
Обзор рецепта – это небольшой объект экрана, позволяющий Вам
управлять рецептами и записями просто, быстро и с минимальной
настройкой. Обычно обзор рецепта используется для редактирования
записей или меньших рецептов в табличной форме. Вы можете
использовать обзор рецепта для создания, сохранения и пересылки
записей на операторский терминал.

Если Вы хотите модифицировать пользовательский интерфейс для
редактирования записей, например имитацией визуального появления
Вашей системы, Вы также можете использовать обзоры рецепта.

Настройте обзор рецепта с помощью изображенной кнопки.

Детальное руководство по настройке обзора рецептов можно найти в
онлайновой помощи ProTool.

Замечание
Используйте SHIFT + двойной щелчок для активизации обзора рецепта (с
масштабом 100%).
В активном режиме, Вы можете перетащить столбец в нужную позицию и
установить его ширину также как и на стадии конфигурации.
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Как использовать обзор рецепта
ProTool предоставляет следующие кнопки для использования обзора
рецепта. Для каждой кнопки Вы можете установить, будет ли она
отображаться на операторском терминале.

Кнопка Назначение

New

Создать новую запись
Используйте данную кнопку для создания новой записи на
операторском терминале. Уставки определяются
значениями по умолчанию, задаваемыми в качестве
начальных значений каждого конкретного тега.

Save

Сохранить запись
Эта кнопка предназначена для сохранения текущих
значений записи на жестком диске. Путь для сохранения
устанавливается во время конфигурирования рецепта в
редакторе рецепта (Кнопка Свойства, закладка Хранение).

Delete

Удалить запись
После нажатия на эту кнопку с жесткого диска удаляется
запись, отображаемая в данный момент на операторском
терминале для текущего рецепта.

To PLC

Переслать запись в PLC
Используйте данную кнопку для пересылки текущей
записи в PLC.

From PLC

Прочитать запись из PLC
Данная кнопка используется для чтения записи из PLC.

Советы по управлению без мыши и сенсорного экрана
Также Вы можете использовать обзоры рецептов без мыши и сенсорного
экрана. В книге “Среда исполнения ProTool/Pro, Руководство
пользователя” и описании Вашего операторского терминала Вы найдете
соответствующие комбинации клавиш.

Для оптимизации управления обзором рецепта сделайте следующее:

•  Использование функциональных клавиш вместо кнопок:
В ProTool, запретите отображение кнопок. Вместо этого
функциональным или контекстно–зависимым клавишам назначьте
соответствующие функции. Для функциональных клавиш выберите
закладку Функции. В окне выбора объекта, под заголовком
Управление экранными объектами с помощью клавиатуры, Вы
найдете все функции работы с записями.
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•  Перемещение по элементам рецепта:
Для обзора рецепта, настройте две функциональные или контекстно–
зависимые клавиши, со связанными с ними функциями "Page_Up"
(Страница вверх) и "Page_Down" (Страница вниз). Во время
исполнения с использованием указанных клавиш Вы сможете
постранично перемещаться по таблице элементов рецепта.

Указание названия рецепта
Если в списке выбора Recipe name fixed (фиксированное название
рецепта) Вы выберите предопределенный рецепт, то в дальнейшем, Вы
сможете просматривать и редактировать записи указанного рецепта.

Возможные применения:

•  Одновременно только один фиксированный рецепт может
отображаться и редактироваться на экране.

•  Например, группе пользователей может быть переданы записи только
одного фиксированного рецепта.

Отображение и/или редактирование записей
Используйте опцию Display Table (Отображать таблицу) для
отображения указанных элементов текущей записи на операторском
терминале. В случае запрещения отображения, Вы автоматически
исключаете возможность использования обзора рецепта для создания
или редактирования записей.

При выборе обеих опций: Display Table (Отображать таблицу) и Allow
Edit (Разрешить редактирование), указанные элементы записей будут
отображаться на операторском терминале. В это же время, Вы получаете
права на редактирование записей.

Сохранение количества рецептов и количества записей в теги
Вы можете указать различные теги для количества рецептов и количества
записей. Во время исполнения, числа, выбранные на операторском
терминале, сохраняются в эти теги. В дальнейшем, сохраненные в тегах
значения можно использовать в качестве параметров для функций и
скриптов, например, для сохранения текущей записи.
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5.13.3 Применение сценариев в рецептах

Ниже представлены три сценария с типичными настройками и их
применение в рецептах. На рисунке показаны основные отличия при
редактировании записей и влияние опций Synchronize
(Синхронизировать) и Offline (Автономно).

Управление рецептом

Обзор/экран рецепта

Автономно

Синхронизировать
Да

Нет

Да
Нет

Теги

PLC

Носитель
Информации1

2

3

Опции "Synchronize" (Синхронизировать) и "Offline" (Автономно) во время
редактирования записей

1. Редактирование записей в обзоре рецепта в автономном режиме

Использование

Вы хотите просто и быстро производить редактирование записей и
рецептов. Введенные на операторском терминале данные сохраняются в
теги, но не записываются в PLC сразу.

Данный способ рекомендуется для записей с относительно небольшим
числом элементов, пригодных для редактирования в табличном виде.

Конфигурация в ProTool
•  Создайте рецепт с выключенными опциями Synchronize Tags

(Синхронизировать теги) и Tags Offline (Автономные теги).

•  Создайте экран и поместите на него обзор рецепта. Сконфигурируйте
обзор рецепта так, чтобы Вы могли и выбирать и редактировать записи
на операторском терминале.

Редактирование записей на операторском терминале
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•  В списке выбора обзора рецепта выберите запись и подтвердите
выбор.

•  Будет произведено чтение указанной записи с устройства.

•  Информация из данной записи будет отображена в обзоре рецепта,
без ее сохранения в указанные теги.

•  Отредактируйте элементы записи в таблице обзора рецепта.

•  С помощью кнопки Save (Сохранить) выполните сохранение
измененных величин, указав в случае необходимости, новое имя

2. Редактирование записей на экране рецепта в автономном режиме

Использование

Вы хотите модифицировать пользовательский интерфейс, например,
имитирую форму отображения своей системы. Введенные на
операторском терминале данные сохраняются в теги, но не записываются
в PLC сразу.

Данный способ рекомендуется для записей с достаточно большим числом
элементов. Объемные рецепты можно разбить на несколько предметно–
ориентированных экранов и отображать их, используя, например,
графические элементы.

Конфигурация в ProTool
•  Создайте рецепт с включенными опциями Synchronize Tags

(Синхронизировать теги) и Tags Offline (Автономные теги)

•  Создайте экраны, на которых теги рецептов могут редактироваться с
помощью полей ввода/вывода.

•  Для возможности выбора записей на операторском терминале
существует две альтернативы:

– Поместить обзор рецепта на экран. Настроить обзор рецепта на
минимальную функциональность (без опций редактирования) только
для возможности выбора записей.

Это дает простейшие возможности управления.

– Назначить функции редактирования записей на функциональные или
контекстно–зависимые клавиши, или на кнопки, если есть
возможность использования мыши или сенсорный экран.

Это дает Вам полную свободу действий для модификации
пользовательского интерфейса.
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Редактирование записей на операторском терминале
•  Выберите запись.

•  Активизируйте процесс чтения выбранной записи с носителя
информации.

– С обзором рецепта:
Чтение производится автоматически при выборе записи.

– Без обзора рецепта:
Нажмите на кнопку, которой была назначена функция
Load_Data_Record (Загрузить запись) Перед вызовом данной
функции необходимо корректно выставить ее параметры.

•  Информация из записи сохраняется в теги.

•  Отредактируйте теги с помощью сконфигурированных полей
ввода/вывода.

•  Выполните сохранение модифицированных тегов.

– С обзором рецепта:
Нажмите на кнопку Save (Сохранить) и, в случае необходимости
укажите новое имя.

– Без обзора рецепта:
Нажмите на кнопку, которой была назначена функция
Save_Data_Record (Сохранить запись) Перед вызовом данной
функции необходимо корректно выставить ее параметры.

3. Редактирование записей на экранах рецепта/обзоре рецепта в
онлайновом режиме

Использование

При запуске, когда Вы хотите протестировать компьютер/систему.
Введенные на операторском терминале данные напрямую передаются в
PLC.

Конфигурация в ProTool

•  Создайте рецепт с включенной опцией Synchronize Tags
(Синхронизировать теги) и с выключенной опцией Tags Offline
(Автономные теги).

•  Создайте экраны, на которых теги рецептов могут редактироваться с
помощью полей ввода/вывода.
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•  Для возможности выбора записей на операторском терминале
существует две альтернативы:

– Поместить обзор рецепта на экран. Настроить обзор рецепта на
минимальную функциональность (без опций редактирования) только
для возможности выбора записей.

Это дает простейшие возможности управления.

– Назначить функции редактирования записей на функциональные или
контекстно–зависимые клавиши, или на кнопки, если есть
возможность использования мыши или сенсорного экрана.

Это дает Вам полную свободу действий для модификации
пользовательского интерфейса.

Редактирование записей на операторском терминале
•  Выберите запись.

•  Активизируйте чтение выбранной записи с носителя информации.

– С обзором рецепта:
Чтение производится автоматически при выборе записи.

– Без обзора рецепта:
Нажмите на кнопку, которой назначена функция Load_Data_Record
(Загрузить запись) Перед вызовом данной функции необходимо
корректно выставить ее параметры.

•  Информация из записи сохраняется в теги и сразу же отправляется в
PLC.

•  Отредактируйте теги с помощью сконфигурированных полей
ввода/вывода. Соответствующие значения в PLC будут обновлены
незамедлительно.

•  Сохраните модифицированные теги.

– С обзором рецепта:
Нажмите на кнопку Save (Сохранить) и, в случае необходимости
укажите новое имя.

– Без обзора рецепта:
Нажмите на кнопку, которой назначена функция Save_Data_Record
(Сохранить запись) Перед вызовом данной функции необходимо
корректно выставить ее параметры.

Замечание
При редактировании записи в онлайновом режиме введенные значения
передаются в PLC без синхронизации. Поэтому убедитесь, что изменение
значений отдельных тегов не влечет за собой переход
компьютера/системы к неправильному режиму работы.
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5.13.4 Что такое экран рецепта?

Назначение
Вам необходимы экраны рецептов, если Вы хотите иметь возможность
создавать, сохранять и выполнять передачу записей  на операторский
терминал. В отличие от обзора рецепта, при использовании экрана,
существует возможность настраивать индивидуальные маски ввода
записей.

Процедура создания экрана рецепта
1. Определение структуры рецепта:
Наполните структуру рецепта тегами. Используйте данные теги для
полей ввода/вывода на экране рецепта.

 Укажите название рецепта. В дальнейшем, оно будет использоваться
для выбора рецепта как внутри проекта, так и на операторском
терминале.

 Синхронизация тегов:
В свойствах рецепта на закладке Options (Опции) можно
контролировать свойства тегов рецепта. С включенной опцией
Synchronize Tags (Синхронизировать теги), можно определить, что
элементы записи, считанной из PLC или устройства хранения, были
записаны в теги или наоборот, прочитаны из тегов.

 Автономные теги:
Также на закладке Options (Опции) возможно использование опции
Tags Offline (Автономные теги) для указания того, что введенные
значения сохраняются только в тегах, без непосредственной
пересылки в PLC. В этом случае опция Synchronize Tags
(Синхронизировать теги) также должна быть включена.

 Если опция Tags Offline (Автономные теги) не включена, то
введенные значения сразу же передаются в PLC.

2. Создание экрана:
Создайте один или более экранов Для того чтобы иметь возможность
создавать, сохранять и осуществлять передачу записей на
операторский терминал. Также создайте поля ввода/вывода для тегов
рецепта. Они–то как раз и будут использоваться для отображения и
редактирования значений на операторском терминале.

3. Применение функций:
Назначьте функции редактирования записей (например, функции
сохранения и пересылки) функциональным, контекстно–зависимым
клавишам или кнопкам. Все функции редактирования представлены на
закладке Functions (Функции), в окне Object Selection (Выбор объекта)
под заголовком data records (Записи).

 Кроме того, Вы можете сконфигурировать минимизированный обзор
рецепта, например, без табличного показа.
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5.13.5 Конфигурирование рецептов

Процесс конфигурирования
Основные этапы конфигурирования рецепта перечислены ниже:

1. Определение структуры рецепта:
Наполните структуру рецепта тегами. Данные теги связываются с
элементами записей.

 Укажите название рецепта. В дальнейшем, оно будет использоваться
для выбора рецепта как внутри проекта, так и на операторском
терминале.

 Установка свойств тега рецепта:
В свойствах рецепта на закладке Options (Опции) можно
контролировать свойства тегов рецепта. С включенной опцией
Synchronize Tags (Синхронизировать теги), можно определить, что
элементы записи, считанной из PLC или устройства хранения, были
записаны в теги или наоборот, прочитаны из тегов. Таким образом,
устанавливается связь между тегами рецепта и тегами на экране. В
момент загрузки записи, значения записываются в теги на экране.

 Если опция Tags Offline (Автономные теги) также включена, то
введенные значения сохраняются только в тегах, если нет, то
введенные значения сразу же передаются в PLC.

2. Установка параметров хранения записи на операторском
терминале:
Вы можете установить путь для хранения записей. Допустимы
следующие значения, в зависимости от используемого устройства:

− любой путь на любом диске

− Внутренний FLASH (путь: \FLASH\)

− Карта хранения (карта PC, путь: \Storage Card\ )

3. Установка синхронной пересылки информации:
Вы можете установить способ обмена информацией с PLC– с или без
синхронизации. Для синхронной пересылки Вам необходимо иметь
коммуникационную область почтового ящика данных.
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4. Создание обзора рецепта/экранов рецепта:
Сконфигурируйте один или более экранов, если Вы хотите создавать,
сохранять и выполнять передачу записей на операторский терминал. В
зависимости от приложения, Вы можете использовать обзор рецепта,
например, для создания эмблемы системы с помощью полей
ввода/вывода экранов рецепта.

– Обзор рецепта:
Обзор рецепта позволяет быстро и просто обрабатывать записи и
рецепты. Обычно, он используется для редактирования записей
небольших рецептов в табличной форме.

– Экраны рецепта:
Экраны рецепта используются для модификации пользовательского
интерфейса для редактирования записей, например, путем
имитирования формы отображения системы. Экраны рецептов
настоятельно рекомендуются для записей с довольно большим
количеством элементов.

 Использование обзора рецепта или экранов рецепта зависит от выбора
опции Synchronize Tags (Синхронизировать теги) на закладке Options
(Опции)

 Синхронизированные теги:
Элементы записей сохраняются/считывается из сконфигурированных
для рецепта тегов. Для редактирования записей через экран рецепта
необходимо связать сконфигурированные для рецепта теги с полями
ввода на экране.

 Не синхронизированные теги:
Элементы записей лишь отображаются в таблице обзора рецепта.
Использование тех же самых тегов на экранах не влечет изменения их
значений.

 Замечание
Внимательно отнеситесь к требованиям по редактированию записей
(Глава 5.13.8).

 Обратитесь к службе помощи ProTool для более детальной
информации.

Текстовый или графический список для рецептов
В момент создания первого рецепта, автоматически создается текстовый
или графический список рецептов, обозначенный как Z_RECIPES.
Порядок, по которому рецепты поступают в список, определяется, исходя
из их порядковых номеров.
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Теги в рецептах
Используемые в рецептах теги обладают следующими особенностями:

•  Свойства, не проверяемые не синхронизированными рецептами

− Функции, активизируемые событиями установки

− Циклический опрос (непрерывное чтение)

− Уставки тегов

− Архивация

•  Строковые теги
В строковых тегах шестнадцатеричное значение 00h является
признаком конца строки. Следующие за ним символы не
воспринимаются и, при операциях чтении или записи в PLC или на
устройство хранения, забиваются нуль символами.

•  Таймер/Счетчик
Для тегов с типами Таймер или Счетчик не осуществляется проверка
на корректность ввода. Для проверки на допустимые значения
произведите настройку соответствующих уставок тегов.

5.13.6 Синхронизация с PLC

Назначение
При синхронной передаче приемник и передатчик информации
устанавливают биты статуса в почтовом ящике данных. Таким образом,
Вы можете предотвратить неконтролируемую взаимную перезапись
данных в программе PLC.

Использование
Синхронная пересылка записей используется, если:

•  PLC является ведущим устройством при передаче записей,

•  Номер рецепта или записи должен пройти проверку в PLC,

•  Пересылка записей активизирована задачей PLC.
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Требования
Для обеспечения возможности осуществления синхронной пересылки
записей между PLC и операторским терминалом, необходимо выполнить
следующие требования:

•  В System (Система) → Area Pointers (Указатели области) установить
почтовый ящик данных.

•  В свойствах рецепта указать PLC, с которым производится
синхронизация.

 Данная настройка выполняется в редакторе рецепта в пункте Properties
(Свойства) → Transfer. (Пересылка)

Замечание
Связь с PLC описана в книге “Связь в системах на базе Windows.
Руководство пользователя“.

5.13.7 Структура указателей области "почтового ящика данных"

Коммуникационная область Почтовый Ящик Данных необходима для
синхронной передачи записей .

Записи сохраняются в адресном пространстве PLC или считываются
оттуда. Также выполняется проверка на возможность передачи
информации и выводится системное сообщение о результатах процесса
передачи данных.

Почтовый Ящик Данных создается в System (Система) → Area Pointers
(Указатели области).

При создании почтовый ящик данных состоит из 5 слов и имеет
следующую структуру:

Слово 1

Слово 2
Слово 3
Слово 4
Слово 5

Текущий номер рецепта (1 – 999)
Текущий номер записи (1 – 65535)
Зарезервировано

Статус передачи
Зарезервировано
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5.13.8 Требования к редактированию записей

Создание записей
Создание записей осуществляется несколькими способами:

•  Создание записей оператором на операторском терминале.

•  Использование функций  Export_Data_Records (Экспортировать
записи) и Import_Data_Records (Импортировать записи)

Процедура внешнего создания записей

1. Создайте запись с символьным названием.

2. Настройте функцию Export_Data_Records (Экспортировать записи)
на экспорт из файла csv. Таким образом, Вы легко можете
редактировать записи с помощью других приложений, таких как
текстовые редакторы или электронные таблицы.

 Название и номер рецепта, и название и номер записи хранятся в
первых двух строках указанного текстового файла. Далее следуют
значения записи, дающие представление о ее структуре.

3. После этого Вы можете импортировать записи с помощью функции
Import_Data_Records (Импортировать записи).

Пересылка записей
Пересылка записей  может быть осуществлена несколькими способами:

•  С помощью кнопок обзора рецепта на операторском терминале

•  С помощью задач PLC под номером 69 и 70
•  С помощью функций:

Data_Record_DAT_to_PLC (Пересылка записи из DAT в PLC) и
Data_Record_PLC_to_DAT (Пересылка записи из PLC в DAT)
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5.13.9 Совместимость рецептов

При копировании рецептов через системный буфер обмена, обратите
внимание на следующее:

•  Системы на базе Windows →→→→ Системы на базе Windows
При копировании свойства полей принимают значения как в проекте–
источнике.

•  Устройства с графическим дисплеем →→→→ Системы на базе Windows
Если некоторое свойство при копировании принимает некорректное
значение (например, место хранения), то для этого свойства
выставляется значение по умолчанию для проекта– приемника. Если
некоторые настройки не нужны в проекте– приемнике, то их значения
обнуляются.
Стандартные функции работы с экранами и записями для устройств с
графическим дисплеем не конвертируются.

 Обратите внимание, что даже при использовании одинаковых PLC, при
изменении типа соединения, адреса тегов могут измениться.

 Для предотвращения этого, копирование рецептов можно осуществить
за несколько шагов:

Источник: Проект OP37 Используя SIMATIC S5 L2–DP

(промежуточный шаг 1: Проект OP37 Используя SIMATIC S5 AS511
)

(промежуточный шаг 2: Проект PC Используя SIMATIC S5 AS511
)

Проект–приемник: Проект PC Используя SIMATIC S5 DP

•  Системы на базе Windows →→→→ Устройства с графическим дисплеем
Такое копирование рецептов невозможно.
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5.13.10 Пример создания рецепта

Задание
В данном примере создается рецепт для станции розлива фруктовых
напитков.  Различные напитки готовятся по одинаковому принципу.
Ингредиенты для всех напитков одни и те же, различия только в
пропорциях.

Количество в резервуаре (в л.)
Резервуар 1:
Резервуар 2:

Резервуар 3:
Розливочный аппарат

Рез-р 1 Рез-р 2 Рез-р 3

Количество Клапан 4

К розливочному аппарату

off on

Смесительное устройство

Help ESC

В миксере (л.)

Пример экранной формы: Смесительная станция

Сначала создайте рецепт Смесь и запись Сок. Данная запись содержит
пропорции для приготовления апельсинового сока.

Запись должна передаваться в PLC синхронно, т.е. необходим почтовый
ящик данных. Во время передачи записи, операторский терминал
выставляет биты состояния в почтовом ящике данных. По завершению
пересылки, для возможности повторной передачи информации, в
программе PLC необходимо обнулить слово состояния.

Задание включает в себя следующие процедуры:

•  Создание рецепта

•  Конфигурирование обзора рецепта

•  Пересылка файла проекта на операторский терминал

•  Создание записи на операторском терминале

•  Пересылка записи в PLC
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Процедура
Рассматривается процесс создания рецепта для OP37Pro, соединенного с
SIMATIC S7–300/400 PLC через протокол MPI.

Создание рецепта:

1. Создайте новый проект и сохраните его под выбранным именем.

2. В окне проекта двойным щелчком мыши вызовите Рецепты для
создания рецепта, описанного ниже.

3. Создайте четыре действительных тега – Var_2, Var_3, Var_4 and
Var_5 – для ингредиентов смеси – сок (в литрах), вода (в литрах),
сахар (в килограммах) и вкусовая добавка (в граммах) и укажите для
них следующие адреса:

 Var_2 DB 120, DBD 0
Var_3 DB 120, DBD 4
Var_4 DB 120, DBD 8
Var_5 DB 120, DBD 12

 В диалоговом окне Рецепт, назовите элементы так, как показано на
рисунке и добавьте их к структуре рецепта. Структура рецепта
задается указанным порядком следования тегов.

 

 Замечание
Переменная length (Длина) указывает длину в байтах. Значения
Смещения (Offset) (в байтах) устанавливает позицию в структуре. Если
к значению смещения последнего элемента структуры прибавить его
длину, то можно получить размер всей структуры.

4. Нажмите на кнопку Properties (Свойства) в диалоговом окне Рецепт.
На закладке General (Общие), измените название рецепта на Mixture
(Смесь). Номер рецепта установите в 1.

5. На закладке Transfer (Пересылка) выберите тип используемого PLC.

6. На закладке Options (Опции) выключите переключатель Synchronize
Tags (Синхронизировать теги). Это означает, что прочитанная запись
будет лишь отображаться в таблице обзора рецепта и ее можно будет
отредактировать только в обзоре рецепта. Одновременное
использование тегов на экране рецепта не влияет на их значения.
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7. Выберите меню System (Система)→ Area Pointers (Указатели
области) и создайте коммуникационную область Почтового Ящика
Данных. Нажмите кнопку add (добавить) и установите следующие
адреса:
Длина фиксированная и составляет 5 слов.
Область: DB100, DBW 0

 Замечание
Также убедись, что в программе PLC создан блок данных 100
размером, по крайней мере, в 5 слов.

8. На закладке Storage (Хранение) укажите путь C:\TEMP\REC.

Конфигурирование обзора рецепта

1. Настройте обзор рецепта с помощью кнопок: New (Новый), Save
(Сохранить), Delete (Удалить), from PLC (из PLC) и to PLC (в PLC).

2. В пункте Data record (Запись), установите опции Display Table
(Отображать Таблицу) и Allow Edit (Разрешить Редактирование).

Пересылка файла проекта на операторский терминал

1. Установите физическую связь с операторским терминалом.

2. Сохраните проект и выберите File (Файл)→ Download (Загрузить).

Создание записи на операторском терминале:

1. Выберите экранную форму с интересующим Вас обзором рецепта.

2. В поле Recipe (Рецепт), выберите рецепт Mixture (Смесь).

3. Нажмите кнопку New (Новый).

 Установите курсор на поле ввода data record name (название записи) и
введите Juice (Сок).

4. Переместите курсор на поле ввода под названием записи.

 Введите следующие значения:
апельсин 95
вода 5
сахар 3
вкусовая добавка 250

5. Нажмите на кнопку Save (Сохранить). Произойдет сохранение записи
по указанному пути.

Пересылка записи в PLC:

Нажмите кнопку To PLC (в PLC) для пересылки записи с операторского
терминала в PLC.

Во время передачи записи, операторский терминал выставляет биты
состояния в почтовом ящике данных. В программе PLC необходимо
подтвердить пересылку записи.

Результат:
Значения записи Juice (Сок) теперь находятся в области хранения PLC.
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5.14 Руководство оператором

Назначение
В дополнение к возможности модификации пользовательского
интерфейса на операторском терминале, существуют некоторые
дополнительные опции, используемые в зависимости от конкретной
ситуации. Это означает, что можно реализовать эффективные механизмы
для предотвращения некорректных операций на операторском терминале.

Обзор
ProTool предоставляет следующие возможности для обеспечения
удобства работы оператора:
•  Предоставление подсказки (Глава 5.14.1)
•  Конфигурирование последовательности обхода (Глава 5.14.6)
•  Задание иконок для локальных функциональных клавиш (Глава 5.14.2)
•  Показ/Сокрытие отображаемых объектов (Глава 5.14.3)
•  Добавление динамических атрибутов (Глава 5.14.4)
•  Управление светодиодами (Глава 5.14.5)

5.14.1 Предоставление подсказки

Подсказки предоставляют дополнительную информацию и инструкции
оператору во время исполнения, включая значения полей ввода/вывода .
Например, подсказка может отображаться в виде допустимой области
значений переменной или указывать причину и способ устранения ошибки
при сбое.

На закладке Help Text (Подсказка) укажите текст подсказки для объектов.

Сконфигурированная ранее подсказка отображается при нажатии клавиши
Help (Помощь) с использованием языковых настроек операторского
терминала.

5.14.2 Задание иконок для локальных функциональных клавиш

Иконки – это графические изображения фиксированного размера, которые
помещаются в непосредственной близости от  специфических для экрана
функциональных (контекстно–зависимых) клавиш. Это означает, что
можно изобразить функцию, назначенную функциональной клавише.

Во многих случаях Вы можете предотвратить непреднамеренное нажатие
на клавишу посредством применения информирующих обозначений.

Замечание
Невозможно на стандартном PC.
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5.14.3 Сокрытие объектов

Назначение
ProTool позволяет показывать и скрывать элементы управления и
отображения  во время исполнения. Например, можно скрыть поле
вывода в случае, если его значение попадает в установленный диапазон.

Кроме того, можно отображать поле ввода только тогда, когда от
оператора ожидается ввод значений. В этом случае предоставленный
Вами интерфейс пользователя является удобным и понятным.

Тег индекса
Показ и отображение объекта можно привязать или к постоянному
диапазону значений или к тегу поля ввода/вывода. Используя различные
теги, можно независимо управлять показом нескольких полей
ввода/вывода.

При привязке тега к уровню пароля, указанный графический элемент
можно отображать только для определенной группы пользователей.

5.14.4 Что такое динамические атрибуты?

Назначение
Для привлечения внимания оператора к операторскому терминалу,
например,  в случае выхода за уставки, можно настроить графические
атрибуты для элементов ввода/вывода. Это означает, что Вы можете
динамически изменять цвета текста и фона полей ввода/вывода, а также
разрешать или запрещать мерцание отображаемого текста.

Тег индекса
Можно либо напрямую привязать указанный атрибут к тегу или полю
ввода/ вывода, либо определить для него отдельный тег индекса.
Используя различные теги индекса, можно независимо управлять
отображением нескольких полей ввода/вывода.
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5.14.5 Управление светодиодами

Purpose
Светодиоды (LEDs) на функциональных клавишах операторской панели
могут  управляться с PLC. С помощью них Вы можете указать оператору,
что операторская панель ожидает нажатия определенной
функциональной клавиши.

Требования
Для управления светодиодами с PLC, необходимо создать область связи
светодиодов в PLC и Вашем проекте, что делается в меню System
(Система)→ Area Pointers (Указатели Области). При конфигурировании
функциональных клавиш, отдельным светодиодам назначаются
различные биты.

Описание назначения светодиодов и функций для разных операторских
терминалов можно найти в описании связи PLC и операторского
терминала.

5.14.6 Конфигурирование последовательности обхода

Последовательность обхода
Для управления экранными формами в отсутствии мыши, при наличии
клавиатуры, к элементам экранных форм можно получить доступ с
помощью клавиши Tab (Табуляция) При этом активный элемент
выделяется цветом и рамкой.

Выражение Последовательность обхода означает порядок активизации
элементов экранной формы при нажатии клавиши Tab.
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Конфигурирование последовательности обхода
Обычно, последовательность обхода выставляется автоматически в
порядке  создания элементов формы.

Также в ProTool есть возможность указать эту последовательность
вручную. Иногда это требуется для быстрого переключения между
экранными формами или если последовательность обхода диктуется
назначением экранной формы.

Для этого, выберите в редакторе форм меню Edit (Правка)→ Tab
Sequence (Последовательность Обхода). В этом режиме Вы сможете
изменить только последовательность обхода элементов, без изменения
самих элементов.

Экранная форма редактирования последовательности обхода
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В этом режиме слева от каждого элемента отображается число. Это
порядковый номер в последовательности обхода. С помощью мыши, Вы
свободно можете редактировать распределение этих номеров. Для
завершения редактирования используйте контекстное меню или кнопку
ESC.

Последовательность обхода элементов импортированных экранных
форм

Для экранных форм из проектов, созданных более ранней версией
программы, задается стандартная последовательность обхода
элементов: слева направо, сверху вниз. После этого, вновь добавленные
элементы нумеруются в порядке создания.

5.14.7 Динамическое позиционирование объектов

Что понимается под динамическим позиционированием?
В ProTool/Pro есть возможность динамически изменять позицию
используемых на форме объектов . Это значит, что горизонтальные и
вертикальные координаты объектов могут быть изменены во время
выполнения. Динамическое позиционирование применимо к таким
объектам как гистограммы, поля ввода/вывода, текстовые и графические
элементы.

Таким образом, Вы можете, например, передвигать график по экрану для
отображения движущейся ленты конвейера.

Как работает динамическое позиционирование
При конфигурации, для различных объектов устанавливаются координаты
X и Y. Эти значения указываются либо в окне свойств на закладке Position
(Позиция), либо перемещением объекта мышью.

X и Y координаты начальной позиции и размера объекта выставляются
автоматически и отображаются в диалоговом окне.

Для динамического позиционирования объекта, укажите теги для
смещения координаты X и/или Y. Текущие значения этих тегов
определяют «длину шага», прибавляемую к соответствующим
координатам во время выполнения. Таким образом, позиция объекта с
течением времени изменяется.

При выходе координат объекта за допустимые значения, они
выставляются таким образом, чтобы объект оставался видимым на
экране.
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5.14.8 Установка авторизации оператора

Назначение
ProTool предоставляет возможность использования паролей для
управления доступом к полям ввода  и функциональным клавишам. Это
значит, что при создании проекта Вы можете разрешить доступ к
функциям, влияющим на безопасность, только определенной группе
операторов. Таким образом, важные параметры и установки будут
изменяться только авторизованным персоналом.

Управление доступом обеспечит надежную защиту против некорректного
использования и повысит безопасность системы и компьютера.

Иерархия паролей
На этапе конфигурирования Вы можете назначить авторизацию оператора
определенным группам. Во время выполнения, индивидуумы могут
включаться в одну из групп, получая, таким образом, привилегии доступа
группы.

ProTool предоставляет иерархическую организацию уровней пароля от 0
до 9. При назначении пользователю пароля с уровнем 4, ему разрешается
выполнять функции с уровнями пароля от 0 до 4.

•  Уровень пароля 0
Это уровень пароля по умолчанию в ProTool. Этот самый низший
уровень используется для функций, не влияющих на
последовательность обработки. Это обычно не требующие ввода
функции, такие как отображение сообщений. Для выполнения функций
с 0–ым уровнем пароля ввод пароля не требуется.

•  Уровни пароля с 1 по 8
Уровни пароля назначаются функциям, исходя из их важности. Перед
выполнением такой функции, операторский терминал потребует ввести
пароль.

•  Уровень пароля 9
Авторизация на выполнение функций с 9–ым уровнем пароля дается
только системному администратору или инженеру–эксплуатационнику.
При этом предоставляется доступ ко всем функциям операторского
терминала, включая администрирование паролей.

 Пароль Системного Администратора указывается в System
(Система)→ Settings (Настройка). По умолчанию установлено 100.
Данный параметр также может быть изменен на операторском
терминале во время исполнения.

Более подробную информацию по администрированию паролей можно
найти в описании оборудования операторского терминала.



Приемы конфигурирования

ProTool: Конфигурирование систем на базе Windows
Версия от 12/99 5–141

Начало и завершение работы с операторским терминалом
•  При вызове операции, защищенной паролем, операторский терминал
автоматически требует введение соответствующего пароля.

 Для исключения возможности получения несанкционированного
доступа, не следует оставлять активным уровень пароля, больший 0.

•  Если в течение некоторого времени (таймаут выхода из системы)
операторский терминал остается без оператора, то текущий уровень
пароля автоматически сбрасывается в 0.

 Таймаут выхода из системы устанавливается в System (Система)→
Settings (Настройка).
По умолчанию это значение равно 5–и минутам.

Замечание для текстовых и графических дисплеев
Регистрация на операторском терминале
Для регистрации на операторском терминале используется стандартный
экран Z_PASSWORD.

Замечание для систем на базе Windows
Регистрация и завершение работы с операторским терминалом
Независимо от защиты по паролю, в любой момент можно выполнить
регистрацию пользователя и завершение работы, сконфигурировав
функции Logon_User (Регистрация Пользователя) или Logoff_User
(Выход Пользователя из системы).

Установка уровня пароля на операторском терминале
Для определения уровня пароля на операторском терминале
предназначены следующие задачи PLC:

•  Номер 23 предоставляет возможность производить установку уровня
пароля на операторском терминале из PLC, например, для
разрешения определенным пользователям использования
операторского терминала.

•  Номер 24 позволяет из PLC сбросить уровень пароля до 0.

Список возможных задач PLC с указанием их номеров и параметров
можно найти в службе онлайновой помощи ProTool.
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5.14.9 Что такое список паролей?

Назначение
Список паролей конфигурируется для возможности ввода и изменения
паролей и их уровней для операторов на операторском терминале .

Во время выполнения, каждый ввод подтвердите нажатием клавиши
ENTER.

Сконфигурируйте список паролей с помощью изображенной кнопки
или с помощью меню Paste (Вставка)→ Password List (Список
Паролей).

Замечание
Для активизации списка паролей (в масштабе 100%) используйте SHIFT +
двойной щелчок мышью.
В активном режиме, Вы можете перетащить столбец на требуемое место
и установить его ширину, как и на этапе конфигурации.

5.14.10 Функции управления паролями

Пароли используются для предотвращения полей ввода или
функциональных клавиш от неавторизованных операций .

Аналогично с использованием паролей для регистрации/завершения
работы с операторским терминалом, пользователю доступны следующие
функции:

•  Защита тега паролем и проверка значений тега в PLC.

•  Экспорт списка паролей.

•  Импорт списка паролей.
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5.15 Создание скриптов Visual Basic (VBScripts)

Обзор
В ProTool имеется возможность использования скриптов Microsoft® Visual
Basic® (VBScript). VBScript позволяет добавлять Ваши собственные
функции к своему конфигурационному программному обеспечению.
Поддерживаются все операторы, функции и типы данных, используемые
в VBScript. Использование скриптов VB аналогично использованию
обыкновенных функций.

Замечание
Скриптами можно пользоваться практически во всех системах на базе
Windows, за исключением систем на основе Windows CE (например,
MP270).

5.15.1 Cкрипты Visual Basic в ProTool

Полную документацию Microsoft по скриптам VBScript можно найти в
онлайновой помощи, нажав на кнопку VBScript Help (Помощь по скриптам
VB).

Здесь же описаны основы создания скриптов в ProTool:

•  Объекты ProTool, используемые в скриптах

•  Взаимодействие внутренних тегов скрипта с тегами ProTool

•  Отладка скриптов в ProTool

•  Ограничения скриптов VB

Замечание
Перед использованием скриптов следует прочесть документацию
Microsoft и знать обо всех возможных последствиях. Скрипты VB могут
улучшить функциональность ProTool; а могут привести к неожиданным
ошибкам во время исполнения.
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Конструкции скриптов VB
VBScript – это простой язык скриптов в котором используются следующие
конструкции:

•  Теги: либо теги ProTool, либо внутренние теги скрипта.

•  Операторы +, –, *, or, and

•  Условные выражения:  If...then...else, Select Case

•  Конструкции циклов: Do...Loop, While...Wend, For ... Next, For each ...
Next.

•  Процедуры VBScript: Sub и Function

•  Встроенные функции: Date, Sin, Sqr.

VBScript распознает два типа процедур. Оба они предлагаются на
закладке General (Общие):

•  Подпрограмма
•  Функция

В отличие от функции, подпрограмма не возвращает значений.
Параметры передаются как в подпрограмму, так и в функцию.

Краткий обзор использования скриптов
При программировании скриптов можно использовать объекты ProTool.
Также из скриптов можно вызывать функции ProTool и ранее созданные
скрипты. Например, с помощью скрипта можно определить и вывести
большее из двух значений.

В левой части окна проекта Вы найдете тип скрипта. Название скрипта,
под которым происходит его сохранение, указывается в правой части
окна.

В ProTool поддерживается подсветка синтаксиса. Теги, выражения,
объекты и комментарии имеют соответствующий цвет шрифта:

   Инструкции VBScript– голубой.

   Комментарии – зеленый.

   Функции ProTool и названия скриптов – серый.

   Теги ProTool – красный.

   Экраны – желтый.

   Архивы – фиолетовый.

Перед использованием скрипта, он должен быть откомпилирован. Во
время компиляции осуществляется синтаксическая проверка и проверка
тегов.
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Всем объектам, которым могут назначаться функции, можно назначать
реализованные скрипты. Также как и для функций, для скриптов
указываются события, по которым они активизируются (например,
"Изменение значения" или "Нажатие на клавишу").

Ограничения
 Количество и область применения сценариев зависят от используемого
операторского терминала (см. System limits (Системные ограничения)
(Глава A.1)).

5.15.2 Объекты ProTool, которые могут использоваться в
скриптах

При программировании скриптов можно использовать объекты ProTool.
Эти объекты перечислены ниже:

•  Теги
•  Функции
•  Скрипты

При использовании тегов:

•  Скрипт может использоваться, например, для чтения значения тега,
его преобразования и присвоения тегу обратно.

•  Запрос бинарных тегов:
Логические состояния TRUE (Истина) и FALSE (Ложь) в VBScript
представляются значениями '–1' (TRUE) и '0' (FALSE). Так, например,
выясняется, имеет ли переменная Bool_Var значение "TRUE" (Истина):

IF Bool_Var <> 0 ...

При использовании функций:

•  Не пишите скриптов, уже имеющихся среди функций ProTool.

•  При использовании в скриптах функций типа Set_Bit_In_Tag
(Установить бит в теге), помните, что биты всегда нумеруются,
начиная с 0, справа налево независимо от используемого типа PLC.
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5.15.3 Использование локальных тегов скрипта и тегов ProTool

Теги являются ссылками на области памяти OP/PC. Во время работы
скриптов можно записать значение в тег или считать значение из него.
Существует два типа тегов:

•  Теги ProTool
В скрипте теги ProTool выделяются красным цветом. Перед
использованием, тег ProTool должен быть создан. Иначе, в процессе
компиляции возникнут ошибки.

•  Внутренние теги скриптов
Внутренние теги определяются в скриптах с помощью конструкции
DIM.

ProTool поддерживает следующие типы тегов:

Формат Тип данных

8 бит, со знаком CHAR, CHAR_ARRAY

8 бит, без знака BYTE, BYTE_ARRAY

16 бит, со знаком INT, INT_ARRAY

16 бит, без знака UINT, UINT_ARRAY

32 бит, со знаком LONGINT, LONGINT_ARRAY

32 бит, без знака FLOAT, FLOAT_ARRAY

64 бит, с плавающей
точкой

DOUBLE, DOUBLE_ARRAY

1 бит BOOL, BOOL_ARRAY

Символьные строки STRING

5.15.4 Отладка скриптов в ProTool

При нажатии на кнопку Compile (Компилировать), выполняется проверка
скрипта на предмет синтаксических ошибок. Так как средства отладки VB
в ProTool не доступны, рекомендуется производить тестирование скриптов
в Visual Basic или в VBA. Помните, что VBScript не использует всех
возможностей языка Visual Basic. При тестировании, теги ProTool можно
заменить локальными тегами.

Как и в любой другой программе, ошибки могут появиться во время
выполнения. В случае ошибки выдается соответствующее сообщение, в
котором указывается название скрипта и номер строки, в которой
произошла ошибка.

Во избежание ошибок в скриптах, проверьте:
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•  Правильно ли используются прямые и косвенные рекурсии?

•  Есть ли бесконечные циклы?

•  Правильно ли указаны параметры функций?

•  Корректны ли типы тегов, используемые в качестве параметров?

•  Верно ли количество параметров скрипта?

•  Насколько трудоемки Ваши программы?

•  Насколько часто вызываются Ваши скрипты?

Для отладки можно использовать функцию "Display_system_message_text"
(Отображать текст системного сообщения). Данная функция позволяет
определить, на каком этапе выполнения находится программа.
Вызывайте эту функцию в тех местах, где бы Вы хотели проверить
процесс отладки. Передайте функции текст или значение в качестве
параметра. Во время выполнения скрипта на экране будет отображено
системное сообщение. Таким образом, можно производить пошаговую
отладку скрипта.

Замечание
Одновременно может выполняться только один скрипт

5.15.5 Ограничения скриптов Visual Basic

Назначение символьных имен
В качестве имен объектов ProTool запрещается использование
зарезервированных слов Visual Basic, таких как If, Then, Loop, Sub and
Dim, . В именах локальных тегов и названиях процедур VB нельзя
использовать специальные и специфические для языка символы, такие
как ä or é. Все имена, начинающиеся с pt, зарезервированы для
использования внутренними объектами ProTool.

Если нельзя обойтись без использования зарезервированных слов Visual
Basic, придумайте для них разумные префиксы. Например, такие:

•  Теги ProTool (глобальные теги), префикс PtVar

•  Функции ProTool, префикс PtFct

•  Названия экранных форм ProTool, префикс PtScn

•  Названия архивов ProTool, префикс PtArc

•  Названия скриптов ProTool, префикс PtScp.

Пример использования тегов:  PtVar.Convert
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Обработка нескольких скриптов
В режиме онлайн одновременно может выполняться только один скрипт.
Если нужно выполнить несколько скриптов, они выстраиваются в очередь.
Если один скрипт вызывает другой, то родительский скрипт должен
дождаться завершения дочернего скрипта.

Запрет на присвоение значений параметрам
В скрипте нельзя выполнять присвоение значений его параметрам.
Передаваемый в скрипт параметр используется в нем (передача по
значению) Тем не менее, в результате работы скрипта, исходное значение
параметра не изменяется.

Результат работы скрипта можно вернуть двумя способами:

•  Реализовать его как функцию. Возврат результата обеспечивается
путем присвоения значения имени функции.

•  Результат работы скрипта присваивается тегу ProTool.

5.15.6 Пример подпрограммы

В тег ProTool Var_1 из PLC считывается температура по Фаренгейту.
Далее, с помощью скрипта TempConvert это значение преобразуется в
температуру по Цельсию и записывается во внутренний тег ProTool
Var_2. Можно связать тег Var_2 с полем вывода и отображать его
значение на экране.

Создание скрипта
1. Прежде всего, создайте в ProTool связанный с PLC тег Var_1 и
отметьте для него Read Continuously (Постоянное Чтение) на
закладке Options (Опции).

2. Тег Var_2 не нужно связывать с PLC (<no PLC>).

3. Нажмите Scripts (Скрипты) в окне процесса

4. На закладке General (Общие) выберите опцию Sub (Подпрограмма).

5. В поле Name (Название) введите TempConvert.

6. В поле Description (Описание) введите краткое описание функции,
например, Перевод или Из Фаренгейта в Цельсий.

7. Перейдите на закладку Script Text (Текст скрипта).

8. Введите текст скрипта.
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 Dim Fahrenheit
Fahrenheit = Var_1
Var_2 = (Fahrenheit –32)*5/9

9. Для компиляции скрипта нажмите кнопку Compile (Компиляция).

 Ниже показано диалоговое окно Текст Скрипта с написанным и
скомпилированным скриптом.

 

Использование скрипта
1. В окне проекта выберите тег Var_1 и перейдите на закладку Functions

(Функции).

2. На событие Value Change (Изменение Значения) с помощью кнопки
Add (Добавить) назначьте скрипт TempConvert().

 Ниже показана закладка Functions (Функции) со скриптом.
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3. Поместите на экранную форму поле вывода и свяжите с ним тег Var_2.

 Каждый раз при изменении тега Var_1 происходит выполнение скрипта,
запись результата в тег Var_2 и обновление поля вывода на экране.

5.15.7 Пример функции

В тег ProTool Var_1 из PLC считывается температура по Фаренгейту.
Далее, с помощью скрипта DegreesCelsius(Fahrenheit), это
значение  преобразуется в температуру по Цельсию и записывается во
внутренний тег ProTool Var_2. Можно связать тег Var_2 с полем вывода и
отображать его значение на экране.

Создание скрипта
1. Прежде всего, создайте в ProTool связанный с PLC тег Var_1 и
отметьте для него Read Continuously (Постоянное Чтение) на
закладке Options (Опции).

2. Тег Var_2 не нужно связывать с PLC (<no PLC>).

3. Нажмите Scripts (Скрипты) в окне процесса.

4. На закладке General (Общие) выберите опцию Function (Функция).

5. В поле Name (Название) введите DegreesCelsius.

6. В поле Description (Описание) введите краткое описание функции,
например, Перевод или Из Фаренгейта в Цельсий.

7. Введите Fahrenheit в поле ввода параметров и нажмите кнопку Add
(Добавить).
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8. Перейдите на закладку Script Text (Текст скрипта).

9. Введите текст скрипта.

 DegreesCelsius = (Fahrenheit –32)*5/9

10. Для компиляции скрипта нажмите кнопку Compile (Компиляция).

 Ниже показано диалоговое окно Текст Скрипта с написанным и
скомпилированным скриптом.

 

Использование скрипта
1. В окне проекта выберите тег Var_1 и перейдите на закладку Functions

(Функции).

2. На событие Value Change (Изменение Значения) с помощью кнопки
Add (Добавить) назначьте скрипт DegreesCelsius.

3. В качестве входного параметра Fahrenheit укажите тег Var_1
(определяется как [in](входной)).

4. Тег Var_2 определите как возвращаемое значение (определяется как
[out](выходной)).

 Ниже показан процесс назначения параметров.
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5. Click OK to conclude parameter input.

 The figure below shows the Functions tab together with the script.

 
6. Поместите на экранную форму поле вывода и свяжите с ним тег Var_2.

 Каждый раз при изменении тега Var_1 происходит выполнение скрипта,
запись результата в тег Var_2 и обновление поля вывода на экране.
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5.16 Работа в сети

Обзор
В данной главе Вы узнаете, как на операторском терминале отображать
информацию из других узлов сети в зависимости от ее конфигурации
через интерфейс OPC.

5.16.1 Работа в сети по OPC

Назначение
Системы на базе Windows обычно используемые на промышленных
компьютерах FI25 и FI45  поддерживают связь через Ethernet по TCP/IP и
OPC.

Таким образом, визуальное наблюдение и обработка данных одинаково
возможна как с помощью запросов системной информации, так и
используя архивацию данных процесса. Универсальные
информационные потоки гарантируют возможность наблюдения за
состоянием большинства процессов.

Что такое OPC?
OPC означает “OLE for Process Control” (использование механизма
Связывания и Внедрение Объектов (OLE) для Контролирования
Процессов) и является открытой системой. Она основывается на
технологии OLE/COM и DCOM и позволяет производить обмен данными
между приложениями PLC, шинными устройствами и офисными
приложениями.

Обмен информацией может осуществляться между устройствами
различных производителей через общедоступные интерфейсы:

•  OPC упрощает связь компонентов автоматизации различных
производителей с такими приложениями PC, как системы отображения
и офисными приложениями.

•  OPC стандартизирует связь вплоть до того, что любой сервер OPC и
любое приложение могут связываться и работать без каких–либо
трудностей.

Замечание.�Для разработки OPC Foundation ведущие компании,
занимающиеся промышленной автоматизацией, объединились вместе.
Дополнительную информацию об OPC Foundation можно найти по
следующему адресу в сети Internet: http://www.opcfoundation.org
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Требования
Так как обмен данными через OPC использует DCOM (Distributed
Component Object Model), в нем могут участвовать операторские
терминалы под управлением одной из перечисленных операционных
систем:

•  Windows 2000

•  Windows NT  4.0, Service Pack 5

OPC должен быть установлен на системе исполнения и выбран из списке
связующих компонентов.

OPC сервер должен располагаться в той же самой сети, в которой
находится OPC клиент или должен быть доступен через RAS (Remote
Access Service) (Сервис Удаленного Доступа).

Для того чтобы OPC клиент мог автоматически запустить OPC сервер и
установить с ним сеанс связи, клиенту должны быть назначены
соответствующие привилегии.

Обмен данными
Для отображения или проверки данных на операторском терминале, Вы
можете выбрать данные через OPC, как это делает OPC клиент,
запрашивая информацию у различных OPC серверов в сети.

Теги являются единицами обмена данными. Они адресуются
символьными названиями, назначаемыми им в диалоговом окне Tag (Тег).

Редактирование тегов можно осуществлять через сеть, например,
следующим образом:

•  Теги трендов могут отображаться на тренде.

•  Теги архивируются в архивные теги, а потом выполняется их
проверка.

Дополнительная информация
•  По структуре находится в главе Возможные Конфигурации

(Глава 5.16.2)

•  Может быть найдена в документе “Связь в системах на базе Windows.
Руководство пользователя“.
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5.16.2 Возможные конфигурации

Для связи по каналу OPC, в ProTool/Pro RT существует COM интерфейс,
позволяющий производить обмен данными между программируемыми
контроллерами или системами автоматизации.

Операторский терминал может быть использован и как OPC сервер и как
OPC клиент. В роли клиента, операторский терминал может максимально
соединяться с восемью различными серверами.

Операционная система OPC Сервер OPC Клиент

Windows NT  4.0,Service
Pack 5

X X

Windows 2000 X X

Конфигурация с операторского терминалом в роли OPC клиента
Ниже показан пример конфигурации, в которой операторский терминал
выступает в роли OPC клиента:

ProTool RT
( Клиент )

WinCC ( Сервер 1 ) WinCC ( Сервер 2 ) ProTool RT
( Сервер )

Конфигурация, в которой операторский терминал используется в качестве OPC
клиента
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Конфигурация с операторского терминалом в роли OPC сервера
Ниже показан пример конфигурации, в которой операторский терминал
выступает в роли OPC сервера:

SIMATIC

SIMATIC S7-300

SIMATIC S7-400

ProTool RT
( Сервер  )

ProTool RT
( Сервер  )

WinCC ( Клиент )

Конфигурация, в которой операторский терминал используется в качестве OPC
сервера
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5.16.3 Пример доступа к тегам по сети через OPC

Структура/Конфигурация
Операторский терминал FI25 используется в качестве OPC клиента.

В диалоговом окне OPC Connection (Соединение OPC), выберите
ассоциированный OPC сервер, OPC.SimaticNET, и укажите сетевое имя
компьютера.

FI25: ProTool RT
( Клиент )

Simatic.NET
( Сервер )

WinCC ( Сервер ) ProTool RT
( Сервер )

Пример конфигурации
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Конфигурирование тегов
Сконфигурируйте следующие теги:

1. VAR_4 в качестве переменной тренда:

 Type (Тип):      FLOAT (ПЛАВАЮЩИЙ)

 Item Name (Название элемента):   S7:[CPU416–2DP|S7–OPC–
Server|CP_L2_1:]DB100,REAL0,1

2. VAR_5 как тег поля вывода:

 Type (Тип):      SHORT (КОРОТКОЕ ЦЕЛОЕ):

 Item Name (Название элемента):   S7:[CPU416–2DP|S7–OPC–
Server|CP_L2_1:]MB0

Отображение на операторском терминале
 И тренд, и поле вывода получают данные OPC сервера.
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5.17 Конфигурирование иностранных языков

Обзор
В данной главе содержится информация о том, что необходимо знать для
создания проекта с интерфейсом пользователя на иностранном языке.

Можно создавать как одноязычные, так и многоязычные проекты. В
многоязычном проекте, Вы можете выбирать:

•  делать поддержку нескольких языков на OP и предоставлять
пользователю возможность переключения между языками с помощью
определенной клавиши

•  для указанной OP загружать только один язык

5.17.1 Системные требования для иностранных языков

В зависимости от языка Вашей системы Вы, можете конфигурировать
практически все иностранные  языки без необходимости изменения
настроек системы.

Исключения составляют языки со специфическим набором символов
такие, как Греческий, Польский, Русский, Словацкий, Чешский и
Венгерский. Для возможности использования перечисленных языков,
необходимо установить их поддержку в системе Windows 95 (Control Panel
(Панель Управления)→ Software (Установка и удаление программ)→
Windows Setup (Установка Windows)→ Language Support (Многоязыковая
Поддержка)→ Details (Состав)). В Windows NT этого делать не
обязательно.

Замечание
Если программное обеспечение времени исполнения установлено на
одном компьютере, а программа конфигурации – на другом, т.е. обработка
и конфигурация производится на разных компьютерах, то, возможно, Вам
придется перезагрузить языковую поддержку на обеих машинах.

Вместо этого, можно просто полностью установить Windows на одном из
этих языков.

Замечание
Инсталляционный компакт диск ProTool содержит поддержку для языков,
не входящих в стандартную поставку Windows, таких как Албанский,
Болгарский, Румынский, Турецкий, и т. д. в директории WINLANGS. Более
подробная информация находится в файле MULLANGO.INF.

Для создания проекта на Азиатских языках, в любом случае необходима
Азиатская система Windows. Необходимую информацию по этому
вопросу можно найти в разделе Требования к конфигурированию
азиатских языков (Глава 5.17.7).
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5.17.2 Язык пользовательского интерфейса и языка проекта

Язык пользовательского интерфейса и языка проекта
В основном, нужно различать два различных уровня отображения:

•  Язык пользовательского интерфейса ProTool.

 Это язык, на котором отображается текст в пунктах меню и диалоговых
окнах. Выбор данного языка осуществляется в установке ProTool.

•  Язык проекта для операторского терминала.

 Это язык, на котором отображается текст на операторском терминале.
В качестве этого языка может выступать любой из доступных на
конфигурационной рабочей станции.

 Следующие объекты содержат текст, зависящий от языковых настроек:

− Сообщения о событиях

− Аварийные сообщения

− Экранные формы

− Рецепты

− Текстовые списки

− Подсказки

Два языковых уровня полностью не зависят друг от друга. Например,
можно создать проект на французском языке с английскими настройками
ProTool, или наоборот.

Язык пользовательского интерфейса

Язык редактирования

До 3-х
языков
проекта

-

Уровни языков в ProTool
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Количество языков проекта на операторском терминале
Для любого проекта текст можно сохранять на любых языках. Можно
даже одновременно загрузить на операторский терминал 32 языка для
данного проекта. Пользователь сможет переключаться между этими 32
языками.

Для этого необходимо сконфигурировать функцию Language (Язык).

Язык редактирования
Язык проекта, на котором производиться редактирование текста данного
проекта, называется языком редактирования.

Строка статуса и строка состояния показывают текущий язык
редактирования.

Базовый язык
Один из языков проекта может использоваться в качестве базового
языка. Отличающиеся части текста можно создать, используя базовый
язык, а потом использовать их как основу для перевода на другие языки.

5.17.3 Конфигурируемые языки

Основные требования
ProTool предоставляет возможность конфигурирования языков на
использование Латиницы, или Русской и некоторых Азиатских раскладок.

Сначала необходимо установить достаточное количество языков в
Windows, или переставить Windows на другом языке (обратитесь к
разделу Системные требования для иностранных языков
(Глава 5.17.1)).

Системные сообщения
Системные сообщения на Вашем операторском терминале могут
отображаться на следующих языках:

•  Китайский (PRC)

•  Китайский (Тайвань)

•  Чешский

•  Датский

•  Английский

•  Финский

•  Фламандский
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•  Французский

•  Немецкий

•  Греческий

•  Венгерский

•  Итальянский

•  Корейский

•  Норвежский

•  Польский

•  Португальский

•  Русский

•  Испанский

•  Шведский

•  Турецкий

При установке другого языка, все системные сообщения отображаются на
английском языке. Редактировать же системные сообщения в ProTool
запрещено.

5.17.4 Раскладка клавиатуры, зависящая от языка

Языковая зависимость
Символы на клавиатуре PC зависят от языка. Например, ни немецкие, ни
французские специальные символы не доступны на клавиатуре с
английской раскладкой. Даже буквы располагаются немного по–разному.

При изменении языка редактирования в ProTool, меняется раскладка
клавиатуры в соответствии с выбранным языком.

Вспомогательное окно раскладки клавиатуры
Для наглядного представления о назначении тех или иных клавиш, в
ProTool отображается специальное вспомогательное окно, показывающее
текущую раскладку клавиатуры.

Сразу видно, где располагается нужная клавиша.

Кроме того, символы можно печатать простыми нажатиями мыши.
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Пример окна раскладки клавиатуры с раскладкой для французского языка

Зависимая от языка клавиатура автоматически скрывается при возврате
на текущий язык Windows. Данное окно можно активизировать
самостоятельно, выбрав меню View (Вид)→ Keyboard (Клавиатура).

5.17.5 Справочный текст

При создании многоязыкового проекта, обычно весь текст пишется на
родном языке. Если после этого происходит изменение языка
редактирования, все текстовые поля станут пустыми.

ProTool предоставляет удобные функции работы с со справочными
текстами, так что Вы имеете основу для перевода. В диалоговых окнах,
можно просмотреть оригинал текста на базовом языке, нажав на
специальную кнопку. Также можно отобразить дополнительное окно со
справочным текстом с помощью панели инструментов или выбрав меню
View (Вид)→ Reference Text (Справочный Текст).

Справочный текст

В редакторе Вы можете переводить фрагменты отображаемого в окне
справочного текста не переключаясь с одного языка на другой.
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5.17.6 Действия по созданию многоязыкового проекта

Порядок
Общий подход следующий:

•  Настроить язык, отличный от выбранного при установке ProTool.

 (Пример: ProTool установлен на немецком, а Вы хотите создать проект
на французском.)

•  Также вы хотите продавать проект в разных странах на
соответствующих языках.

 (Пример: вы посылаете машину в Германию, Англию и Францию и
хотите, чтобы текстовая информация отображалась там на языках
указанных стран.)

•  Вы поставляете проект в многоязыковую страну.

 (Пример: вы посылаете машину в Швецию.Вы хотите, чтобы у
оператора была возможность выбирать между немецким, французским
и итальянским языками.)

В любом случае, сначала необходимо реализовать проект на одном
языке. В дальнейшем, этот язык будет использоваться как базовый язык
для перевода на любой другой

Шаги
Конфигурирование иностранных языков состоит из следующих шагов:

1. Удовлетворите необходимым системным требованиям.

2. Определите языки, которые Вы хотите сконфигурировать (выберите
меню System (Система)→ Language Assignment (Назначение языков)).

3. Выберите первый язык редактирования (выберите меню Edit
(Правка)→ Languages (Языки)). Создайте и протестируйте весь проект
на одном языке, перед тем как переводить фрагменты текста на другой
язык.

4. Установите раскладку клавиатуры (меню System (Система)→ Fonts
(Шрифты))

5. Сконфигурируйте смену языка  (только если есть необходимость
одновременного использования нескольких языков).

6. Выполните перевод фрагментов текста. Для этого смените язык
редактирования (choose Edit → Languages). В качестве базового языка
выберите язык, на котором был создан проект (меню Edit (Правка)→
Languages (Языки)).
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7. Выберите языки для загрузки на определенный операторский терминал
(меню System (Система)→ Language Assignment (Назначение
языков)). Вы можете выбрать единственный язык, и, напротив, до трех
языков одновременно.

8. Скомпилируйте проект.

9. Загрузите проект на операторский терминал.

Более подробное описание находится в онлайновой помощи ProTool.

Замечание
При изменении конфигурации, выполненной с использованием
многоязыковой поддержки, постарайтесь не перемещать поля в
событийных и аварийных сообщениях. Так как нет постоянной привязки
поля к его расположению в тексте, вместо перемещения отдельных
полей, двигайте фрагменты текста целиком.

5.17.7 Требования к конфигурированию азиатских языков

Азиатские Windows
Требованием для создания проекта на азиатском языке является
использование азиатской системы Windows, так как необходимая
раскладка клавиатуры можно найти только в таких системах.

Для упрощения ввода азиатских символов, в таких системах существует
"Input Method Editor" (IME) (Входной Редактор Метода) используемый для
транслитерации текста. При этом виртуальная клавиатура ProTool не
доступна пользователю.

Даже компиляция должна выполняться в азиатской системе, в противном
случае при компиляции язык проекта будет игнорироваться.

В некоторых случаях, проект на азиатском языке можно загрузить на
неазиатскую операционную систему.

Для этого необходимо, чтобы файлы *.fud и *.fwd, создаваемые при
компиляции проекта на азиатской системе находились в той же самой
директории, что и файл проекта *.pdb. Конфигурационный файл *.pdb
может быть открыт только перед операцией загрузки, но более
изменяться не должен.
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Совет
Большинство проектов являются многоязыковыми и используют,
например, английскую редакцию азиатского языка. В этом случае,
сначала можно создать и оттестировать проект на не азиатской
операционный системе. Только после завершения этапа тестирования,
можно прейти на азиатскую систему и конфигурировать,
компилировать и выполнять загрузку азиатского текста.

Это применяется в случаях, когда необходимо использовать на одной
машине две системы с азиатским и неазиатским языком, или работать на
сетевых компьютерах с указанными языковыми настройками.

5.17.8 Ограничения проектов на азиатских языках

В настоящее время поддерживаются языки: Китайский (PRC), Китайский
(Тайвань) и Корейский .

Конфигурация памяти
По возможности, умеренно пользуйтесь разными наборами символов.
Использование дополнительных наборов символов уменьшает
количество памяти, доступное проекту. Каждый загруженный размер
шрифта является дополнительным набором символов.

Для каждого набора символов выделяется 64 kB в конфигурационной
памяти, что соответствует приблизительно 1900 различным китайским
символам. Если Вы настроите больше китайских символов, произойдет
ошибка превышения максимально допустимого количества символов. В
то же самое время, список наиболее редко использованных символов в
конфигурации является выходным.

Специальные символы
Специальные символы – это символы с ASCII кодом, большим 127,
например, ã, ±, ä, è, ó.

При использовании не китайского набора символов в тексте на азиатских
операционных системах, не настраивайте специальные символы, так как
в следующих случаях они отображаются некорректно:

•  в текстовых полях или полях ввода/вывода для отображения которых
был выбран не китайский набор символов

•  в символьных именах объектов, отображаемых, например, в заголовке
окна
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Не азиатские проекты под управлением азиатских Windows NT
При создании проекта на азиатской системе для не азиатского языка,
например, немецкого, необходимо запретить редактирование
специальных символов, содержащихся в диалоговых окнах, которые
выводятся в случае ошибки системы – например, текст подсказки или
названия кнопок.

Во избежание подобных проблем, можно сделать следующее:

•  Использования не азиатской системы Windows.

•  Редактирования фрагментов текста во внешнем приложении и
копирования измененного фрагмента обратно в проект ProTool.

•  Записи в системный реестр, в переменную
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Font
Assoc\ AssociatedCharSet, кодов символов, которым должно быть
присвоено значение "no" “нет”.

 Для того чтобы данные изменения вступили в силу, необходимо
выполнить перезагрузку системы.

Внимание
Данное изменение может повлиять на работу других приложений.
Поэтому, после завершения работы проекта в системном реестре
необходимо восстановить прежние значения.

Сообщения
Все системные сообщения также доступны на азиатских языках.

Номер сообщения, его статус (Active (Активное), Cleared (Удаленное),
Acknowledged (Подтвержденное)), время и группа подтверждения в
азиатской конфигурации заменяется однобайтовыми символами.

Сообщения с азиатскими символами не могут участвовать в процессах
экспорта/импорта в ProTool.

Печать на операторском терминале
При использовании символьного языка, все задания на печать выводятся
на принтер в графическом режиме.
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Длина поля
Длина полей зависит от ширины используемых символов. При
использовании азиатского набора символов, количество символом в поле
может быть уменьшено за счет двойной ширины символа.
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Тестирование проектов

Введение
Из данной главы Вы узнаете как

•  создавать исполняемый файл проекта

•  загружать исполняемый файл (и, возможно, исходный файл) в
операторский терминал,

•  производить имитацию проекта

•  тестировать проект, и

•  закачивать проект из операторского терминала.
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6.1 Тестирование проектов

Когда Вы завершили разработку всего Вашего проекта или отдельных
самодостаточных частей внутри него, начинается  фаза тестирования.

Следует проделать следующие действия:

1. Выполните компиляцию проекта — иными словами, создайте из
проекта файл, который может быть запущен в операторском
терминале.

2. Загрузите проект, т.е. скопируйте его в тот каталог, из которого он будет
запущен. Каталог может находиться в конфигурационном компьютере
или в операторском терминале.

 Процедура загрузки исполняемого файла в операторский терминал
зависит от типа Windows–ориентированного операторского терминала:

− Загрузка в операторские терминалы с Windows CE, например,
MP270.

− Загрузка в системы на базе PC, такие, как OP37/Pro, FI45.

3. Для тестирования проекта без PLC Вам понадобится среда
исполнения ProTool/Pro, которая включает программу имитации.

 Запустите имитатор и укажите подходящие тестовые значения.

4. Для запуска проекта выберите File → Test → Start Runtime (Файл →
Тест → Запустить среду исполнения) из меню, или нажмите символ:

5. Если при тестировании проекта Вы обнаружили ошибки, исправьте их и
начните снова с шага 1.

Замечание
Если Вы в качестве PLC Вы используете SIMATIC S5 или S7,
сконфигурируйте теги просмотра/изменения, например для того, чтобы
протестировать определенные теги в программе PLC.
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6.2 Загрузка исполняемого файла (PC)

Замечание
Эта процедура относится, в частности, к таким PC, как FI25 или OP37/Pro.

Варианты загрузки
Вы можете загрузить файл проекта с конфигурационного компьютера в
операторский терминал следующим образом:

•  Прямое соединение (только для систем с Windows 95/98 )

 Прямое соединение наиболее предпочтительно на этапе ввода в
эксплуатацию и тестирования.

 Доступ к нему осуществляется из меню Start (Пуск) на OP37/Pro в
Programs → Accessories→ PC Direct Connection. (Программы →
Стандартные → Прямое соединение). Если данный пункт меню на
конфигурационном компьютере отсутствует, поддержка прямого
соединения устанавливается в Control Panel → Network (Панель
Управления → Сеть) с установочного CD Windows.

•  Загрузка с диска

 Для OP37/Pro стандартной является загрузка с диска.

 В меню выберите File → Settings → Download... (Файл → Настройки →
Загрузка…), укажите диск A:\ в поле Destination Directory (Целевой
каталог). Исполняемый файл архивируется и записывается на одну
или несколько дискет, с которых он будет разархивирован на целевом
устройстве.

•  Сетевое соединение

 Если конечное устройство (например, PC) и конфигурационный
компьютер находятся в одной сети, Вы можете загрузить исполняемый
файл установив сетевое соединение с целевым устройством.

Загрузка невозможна
Если соединение с операторским терминалом не может быть
установлено, в окне системных сообщений выводится соответствующее
сообщение. Проверьте физическое соединение между конфигурационным
компьютером и операторским терминалом.
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6.3 Загрузка исполняемого файла проекта (Windows
CE)

Замечание
Этот метод относится, в частности, к таким Windows CE системам, как
MP270.

Основные действия
Для Windows CE систем операторский терминал должен быть в Режиме
Загрузки. В случае начального запуска в эксплуатацию операторский
терминал автоматически запускается в режиме загрузки. Вы можете
перезапускать операторский терминал для каждой последующей
операции загрузки или сконфигурировать функцию Change_mode.

Перед началом процедуры загрузка необходимо выполнить следующие
действия:

1. Определите настройки загрузки:
Выберите последовательный интерфейс (RS232) или MPI.

2. Нажмите кнопку Edit (Правка) для того, чтобы появилось диалоговое
окно для выбора интерфейса на конфигурационном компьютере.

3. В случае MP270, определите, будете ли Вы также использовать
исходный файл (*.pdz).

4. Выберите File → Download (Файл → Загрузить) из меню.

 Как только соединение с операторским терминалом будет установлено,
выберите тип носителя. Возможные типы носителя зависят от
конкретного операторского терминала.

 Результат: файл проекта загружен.

Загрузка невозможна
Если соединение с операторским терминалом не может быть
установлено, в окне системных сообщений выводится соответствующее
сообщение. Проверьте физическое соединение между конфигурационным
компьютером и операторским терминалом.
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6.4 Имитация проекта

Назначение
Имитационная программа моделирует PLC если его нет или он не
присоединен. Имитационная программа — это отдельная программа,
которая устанавливается вместе со средой исполнения.

Какие части проекта можно имитировать?
С помощью имитатора Вы можете моделировать следующие части
проекта:

•  Теги

•  Указатели на области данных, которые организованы как битовые
поля, например, сообщения о событиях, область передачи трендов.
(Другими словами, не могут имитироваться: номер экранной формы,
почтовый ящик задач и тип date and time)

Запуск имитатора
Для этого на вашем компьютере должно быть установлено
конфигурационное ПО ProTool и среда исполнения.

Основные действия
В программе имитации тегам и/или указателям на области данных
назначаются параметры, и затем они активизируются.

1. Создайте проект точно так же, как Вы создавали при наличии PLC.

2. Сохраните и произведите компиляцию Вашего проекта.

3. Запустите имитатор при помощи пункта меню File → Test → Start
Simulator (Файл → Тест → Запустить имитатор) из меню, или
нажмите на символ:

 Замечание
Если Вы запустите имитатор без предварительной компиляции
проекта, компиляция будет запущена автоматически.

4. Когда Вы первый раз запускаете проект, имитатор запускается с новой,
пустой таблицей имитации. Если Вы уже создали таблицу имитации
для этого проекта, она будет открыта.

5. Все настройки, которые Вы выполнили в проекте Вы можете сохранить
в таблице имитации (*.sim). Выберите File → Save (Файл →
Сохранить) в имитаторе и укажите имя для таблицы имитации.

 Вы сможете потом открыть эту таблицу и повторно осуществить
имитацию проекта, если он не был перед этим изменен.
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6. Запустите среду исполнения используя пункт меню File → Test → Start
Runtime (Файл → Тест → Запустить среду исполнения) или нажмите
на символ:

 Переключайтесь между имитатором и текущим проектом, если Вы
хотите наблюдать изменение какого–либо значения.

Дополнительная информация
Дополнительную информацию о программе имитации Вы сможете найти в
ее Справке или в руководстве "Среда исполнения ProTool/Pro.
Руководство пользователя" (ProTool/Pro Runtime User's Guide)
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6.5 Закачивание проектов

Использование
При успешном осуществлении процедуры загрузки исполняемый файл
помещается в операторский терминал . Если Вы хотите использовать
данные проекта для дальнейшей разработки проекта или для анализа
ошибок, они должны оставаться на конфигурационном устройстве.

На MP270 (или на Windows CE устройствах с подходящим размером
памяти или возможностью расширения памяти CF платой) Вы можете
хранить не только откомпилированный проект, но и исходный код проекта,
так что он может быть закачан из операторского терминала.

Преимущество: при этом Вы сможете в дальнейшем анализировать и
изменять существующую конфигурацию, даже если первоначальное
устройство программирования недоступно или исходный файл (*.pdb)
проекта уже не существует в конфигурационном устройстве.

Требования
•  В операторском терминале должно быть достаточно свободного места.

•  В операторском терминале должно быть указано место хранения
исходного файла. Для файла проекта и исходного файла могут быть
назначены различные области хранения: внутренняя flash–память или
PC плата (см. техническое руководство).

•  Файл проекта должен быть закачан вместе с исходным файлом.

Что происходит во время процедуры загрузки и закачивания1?
При загрузке исходного файла конфигурация архивируется из исходного
формата (*.pdb) и загружается как *.pdz файл в операторский
терминал. При закачивании файл разархивируется в ProTool. Вы должны
назначить новому проекту имя на конфигурационном устройстве.

Замечание
Закачанный и разархивированный файл проекта (*.pdb) может быть
открыт только в ProTool той же версии или выше, что и программа, в
которой проект был создан.

                                                  
1 В технической литературе на данный момент нет общепринятых вариантов лаконичного
перевода английских терминов upload (загружать в удаленный компьютер) и download
(загружать из удаленного компьютера). В данном руководстве для обозначения этих
терминов используются слова закачивать и загружать, соответственно. (Прим.
переводчика)
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Предостережение
ProTool не может проверить, принадлежит ли в действительности исходный
файл в операторском терминале конфигурации, которая в нем открыта. Если
Вы совершили загрузку без одновременной загрузки исходного файла,
данные старого проекта могут все еще оставаться на операторском
терминале. Возможно, что данные не принадлежат текущему проекту.
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6.6 Что такое теги просмотра/изменения?

Назначение
В среде исполнения Вы можете пользоваться прямым доступом на
чтение–запись из операторского терминала в  PLC (SIMATIC S5 и
SIMATIC S7) и его периферию.

Это означает, что Вы можете с легкостью использовать операторский
терминал для мониторинга и управления операндами программы PLC без
необходимости подключения программирующего устройства или PC к
PLC.

Это предоставляет большие преимущества на этапах тестирования и
ввода системы в эксплуатацию.

Требования:
Для получения прямого доступа к значениям в PLC во время исполнения,
должны быть соблюдены следующие условия:

•  в качестве PLC должен использоваться SIMATIC S5 или SIMATIC S7

•  Вы должны иметь сконфигурированные теги просмотра/изменения на
экранной форме.

Тег просмотра/изменения
На рисунке приведен пример тега просмотра/изменения (Status/Force) на
операторском терминале:

Тег просмотра/изменения: основная структура поля

Статус В колонке Status Value (Состояние значения) Вы можете
просматривать текущие значения отображаемых операндов
PLC.

Управление
(Тег
изменения)

В колонке Control Value (Управляющее значение) введите
значение, которое будет записано в адресное поле операнда.
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6.7 Функции обеспечения поддержки сервисного
обслуживания

В Вашем проекте Вы должны обеспечить средства управления, которые
облегчат обслуживание во время запуска и исполнения.

Рекомендуется расположить эти средства управления на отдельной
экранной форме, и обеспечить их защиту паролем. Таким образом Вы
предотвратите изменение основных настроек операторами, не
являющимися обслуживающим персоналом.

Сервисные функции
Использование функций может облегчить следующие задачи при запуске
или во время исполнения проекта:

•  Вызов Панели Управления Windows CE (на MP270)

 Вы можете использовать Панель Управления Windows CE для
настройки принтера, даты/времени или форматирования FLASH
памяти.

•  Изменение режима функционирования

 Во время исполнения проекта режим функционирования обычно
установлен в ONLINE. Для тестирования проекта без подключения
PLC, режим функционирования должен быть установлен в OFFLINE,
для передачи нового проекта в MP270 — в download mode (режим
загрузки).

•  Изменение языка

 Если в проекте присутствует несколько языков, Вы можете выбрать
язык, требуемый в данном конкретном случае, при запуске или во
время исполнения.

•  Вывод версии программного обеспечения

 Персоналу горячей линии поддержки необходимо знать версию ПО
установленных компонентов ProTool для эффективной обработки
ваших запросов.

Вы можете найти примеры использования этих функций ProTool в
Справке.
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Документирование и управление
проектами

Введение
В данной главе дается детальный обзор многочисленных функций для
печати, документирования, управления и архивирования данных Вашего
проекта, которые предоставляет ProTool.

7
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7.1 Документирование проектов

7.1.1 Распечатка данных проекта

Функция печати
ProTool обеспечивает всестороннюю поддержку функций печати, доступ к
которым производится через  пункт меню File → Print (Файл → Печать).
ProTool формирует подробные отчеты для документирования всех,
относящихся к проекту данных, таких, как экранные формы, сообщения,
теги, таблицы символов и т.д.

Функция печати в ProTool

Этот способ обеспечивает простоту документирования всего Вашего
проекта. Распечатка последних данных может быть также очень полезна
при конфигурировании.

Совет
В качестве альтернативы функции печати при конфигурировании
можно использовать удобную функцию анализа перекрестных ссылок
(см. Извлечение информации проекта (Retrieving project information)
(Глава 4.8)).
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Главы
ProTool подразделяет распечатки по главам, отсортированным по темам в
соответствии с типами объектов. Например, одна глава содержит все
определения, относящиеся к экранным формам, другая содержит список
всех тегов, а третья перечисляет весь встречающийся в проекте
текстовые или графические списки.

Вы можете печатать несколько глав сразу или по одной.

Отчеты
ProTool предоставляет Вам простой способ организации распечаток в
соответствии с Вашими требованиями.

•  Вы можете выбрать для распечатки отдельную главу или страницу.

•  Вы можете устанавливать порядок, в котором следуют главы.

•  Вы можете выбирать, какие данные выводить в конкретной главе.

•  Вы можете настраивать поля, определять собственные верхние и
нижние колонтитулы и встраивать свою графику в обложку.

Эти настройки хранятся в отчете. Часто используемые отчеты уже
присутствуют в ProTool, но Вы также можете создать свои. Все отчеты
являются общими для всех проектов.

Каждый раз перед печатью Вы выбираете, в соответствии с каким отчетом
будет производиться распечатка.

7.1.2 Ограничения при печати

Драйверы принтера
Обратите внимание на ограничения при использовании некоторых
драйверов принтера:

•  С драйверами CANON печать конфигурации может быть невозможна.
Процесс печати в данном случае будет прекращен.

•  На лазерных принтерах Apple не печатается первая строка. Эта
проблема не возникает с драйверами для HP LaserJet III, PostScript
или с PostScript-принтерами.

Набор символов ASCII
На некоторых принтерах бывает недостаточно одной лишь настройки
набора символов ASCII в конфигурации. Удостоверьтесь, что набор
символов ASCII установлен также и в принтере.
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7.2 Пример создания индивидуально настроенного
отчета

Цель
Вы хотите напечатать все данные, используемые в Вашем проекте. В
отличие от установок по умолчанию, Вы  хотите использовать на обложке
не графику ProTool, а логотип вашей компании, который Вы уже
использовали в вашем проекте под именем LOGO. Вы также хотите
оставить поле для написанных от руки комментариев по правой стороне
отпечатка.

Выполните следующие действия:
1. Откройте проект, из которого Вы хотите печатать данные.

2. Выберите File → Print (Файл → Печать) в меню.

3. В диалоговом окне Print (Печать) в разделе Reports (Отчеты)
выберите отчет Complete (Полный). В списке Contents (Содержимое)
Вы увидите список отдельных глав в том порядке, в котором они будут
выведены.

 

 

4. Нажмите кнопку Preview (Предварительный просмотр). Вы увидите,
как будет выглядеть Ваш отпечаток. Вы хотите заменить графику
первой страницы (обложки) логотипом Вашей компании, и сделать
правое поле шире.
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5. Выйдите из предварительного просмотра, нажав кнопку Print (Печать).

6. Чтобы произвести нужные изменения, нажмите на кнопку Reports
(Отчеты). Появится соответствующее диалоговое окно.

 

7. Для изменения поля нажмите кнопку Page (Страница).
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8. Введите нужное значение для правого края в поле Right (Правое),
например, 3 для 3-х см. Если понадобится, Вы здесь также можете
задать текст верхних и нижних колонтитулов.

 

9. Подтвердите изменения, нажав OK. Вы возвратитесь в диалоговое
окно Reports (Отчеты).

10. Для изменения обложки выберите Cover (Обложка) в списке Contents
(Содержание) и затем нажмите кнопку Parameters (Параметры).

11. В диалоговом окне Cover (Обложка) выберите изображение LOGO с
логотипом вашей компании в разделе Graphic (Графика).

12. Нажмите два раза OK, пока не вернетесь к диалоговому окну Print.

 Вы изменили настройки для отчета, названного Complete. Изменения
будут видны позднее, при печати других проектов.

13. Наконец, нажмите OK для запуска процесса печати.
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7.3 Управление проектами

7.3.1 Управление проектами в интегрированном варианте

Если Вы интегрировали ProTool в STEP 7 при инсталляции, используйте
"SIMATIC Manager" для управления Вашими проектами. Вы сможете
затем копировать, перемещать, сохранять резервные копии и
восстанавливать Ваши проекты точно таким же способом, как Вы это
делали в STEP 7. Для получения дальнейшей информации обратитесь к
документации по SIMATIC Manager.

Замечание
Менеджер Проектов (Project Manager) ProTool становится недоступен,
если Вы произвели интеграцию. Данные ProTool более не могут
рассматриваться независимо, так как они уже связаны с проектом STEP 7,
и они теперь должны редактироваться с помощью Менеджера.

7.3.2 Управление проектами в автономном варианте

Project Manager
Если Вы инсталлировали ProTool в автономном варианте, то есть Вы
работаете  не под STEP 7, Вы можете использовать удобный,
дружественный Project Manager (Менеджер Проектов), встроенный в
ProTool, вместо SIMATIC Manager.

Использование
С Project Manager можно легко:

•  создавать резервные копии проектов, в том числе и на несколько
дискет

•  восстанавливать резервные копии проектов

•  открывать проекты

•  удалять проекты
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Вызов
Project Manager запускается выбором пункта меню File→ Project Manager
(Файл → Менеджер Проектов). Когда Вы вызываете Project Manager в
первый раз, появляется диалоговое окно Find (Поиск). Там Вы можете
указать, в каких дисках и каталогах должен осуществляться поиск файлов
ProTool. В Project Manager отображаются только те проекты, которые
находятся в этих каталогах.

Диалоговое окно Find (Поиск)

При следующем вызове Project Manager его окно будет выглядеть в
соответствии с произведенными настройками.
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Отображение

Менеджер проектов

В левой части Project Manager Вы увидите иерархическую структуру всех
проектов, находящихся в каталогах для поиска. Здесь Вы можете выбрать
проект для открытия, удаления, или резервного копирования.

В центре окна находится подробная информация о выбранном в списке
проекте.

С помощью кнопок в правой части Вы можете добавлять каталоги в
список каталогов для поиска (кнопка Find (Поиск)), производить
повторный поиск (кнопка Update (Обновить)) и сортировать проекты в
списке по различным критериям, например, project name (имя проекта),
device type (тип устройства), creation date (дата создания) и т.д.(кнопка
Sort (Сортировать)).
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Системные ограничения

Введение
В данной главе дается краткий обзор системных ограничений
операторских терминалов на базе Windows.

A
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A.1 Системные ограничения

Приведенный ниже список системных ограничений позволяет определить,
удовлетворяет ли им  Ваш проект, или нет.

Указанные максимальные значения не суммируются — другими словами,
Вы можете сконфигурировать 4000 сообщений, только если Вы не
используете никаких других объектов. Тем не менее, 4000 сообщений и
200 экранных форм, каждая с 40 графическими объектами не могут
использоваться одновременно.

В дополнение к указанным ограничениям должны приниматься во
внимание использующиеся конфигурация и оперативная память.

Если проект не удовлетворяет заданным ограничениям, при его
компиляции появляется соответствующее сообщение, а также
информация о текущих системных ограничениях.

Тип объекта TP170A MP270 OP37/Pro Все PC
FI25/FI45

Теги 100 2048 2048 2048 ***)

Сообщения (число) 100 4000 4000 4000

• Текст сообщений
(число символов)

70 70 70 70

• Размер буфера
сообщений

– 512 1024 1024

• Очередь сообщений о
событиях

16 250 500 500

Экранные формы 20 200 300 300

• Полей на одну экранную
форму

20 200 400 400

• Тегов на одну экранную
форму

20 200 400 400

• Статический текст 100 10 000 30 000 30 000

• Графические объекты 20 1000 2000 2000

• Сложных объектов на
одну экранную форму (e. g.
гистограмма)

5 10 40 40

• Тренды – 400 800 800

• Графические списки *) – 400 400 400

• Текстовые списки *) – 400 400 400

• Число позиций в списках
текста или графики

– 256 256 256

Рецепты – 100 1000 1000
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Тип объекта TP170A MP270 OP37/Pro Все PC
FI25/FI45

• Позиций на один рецепт – 500 ***) 500 ***) 500 ***)

• Записей данных – 100 **) 5000 **) 5000 **)

Архивы – 20 40 40

Соединения 1 6 8 8

Скрипты Visual Basic®/
число строк

– 50
20

50
100

50
100

Память проекта 256 kB 1 MB – –

*)
**)
***)

Вместе, только 500 текстовых и графических списков
В зависимости от используемого носителя.
В зависимости от числа лицензированных тегов.

Пример: требования к памяти для записей данных на MP270
Требования памяти для каждого рецепта (в kB)
рассчитывается с учетом трех слагаемых D1 + D2
+ D3.

Где:

 D1 = [(число входов x 20) + 4]: 1024

 D2 = [(число записей x 12) + 4]: 1024

 D3 = [число записей x (длину записей + N) + 4]: 1024

 Округляйте D1, D2 и D3 до следующего целого.

Где N:

 Имя записи < 13 символов: N = 12

 Имя записи > 12 символов: N = 40

Замечание
Во встроенной flash-памяти может храниться до 64 kB.
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Документация SIMATIC HMI

Введение
Документация SIMATIC HMI состоит из группы руководств, инструкций и
справочных систем и рассчитана на различные целевые аудитории. В
данной главе дается обзор этой документации.

B
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B.1 Документация по ProTool

Серия устройств SIMATIC HMI представляет собой обширное семейство
текстовых дисплеев, операторских  панелей, сенсорных панелей и систем
на базе Windows для эффективного мониторинга и управления
различными механизмами. Производительность и удобство этих
устройств тщательно подбирались, чтобы удовлетворять
индивидуальным требованиям, предъявляемым к ним.

Операторские терминалы SIMATIC HMI

Большим преимуществом является то, что Вы можете конфигурировать
все эти устройства с помощью единого конфигурационного пакета.

•  ProTool для систем на базе Windows (ProTool for Windows-based
systems) (Глава B.1.1)

•  ProTool для графических дисплеев (ProTool for graphics displays)
(Глава B.1.2)

•  ProTool для текстовых дисплеев (ProTool for text–based displays)
(Глава B.1.3)
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B.1.1 ProTool для систем на базе Windows

В руководстве ProTool – Конфигурирование систем на базе Windows
объясняется, как конфигурировать следующие плоские панельные
дисплеи, операторские терминалы на базе PC и сенсорные панели:

•  Системы с Windows® CE

− TP170A

− MP270

•  Системы с Windows® 95/98, Windows® 2000 или Windows® NT:

− OP37/Pro

− FI25

− FI45

− PC670

− PC670T

− Стандартные PC

Пример: OP37/Pro

B.1.2 ProTool для графических дисплеев

В руководстве ProTool – Конфигурирование графических дисплеев
объясняется, как конфигурировать следующие графические дисплеи,
операторские терминалы и сенсорные панели:
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•  Операторские панели

− OP25

− OP27

− OP35

− OP37

•  Сенсорные панели

− TP27

− TP37

•  Устройства C7

− C7-626  (OP25 с интегрированным S7 CPU)

Пример: TP37

B.1.3 ProTool для текстовых дисплеев

В руководстве ProTool – Конфигурирование текстовых дисплеев
объясняется, как конфигурировать следующие текстовые операторские
терминалы:

•  Операторские панели
− OP3
− OP5
− OP7
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− OP15A
− OP15C
− OP17

•  Текстовые дисплеи

− TD17

•  Устройства C7
− C7-621  (OP3 с интегрированным S7 CPU)
− C7-623  (OP5 с интегрированным S7 CPU)
− C7-624  (OP15 с интегрированным S7 CPU)
− C7-633  (OP7 с интегрированным S7 CPU)
− C7-634  (OP17 с интегрированным S7 CPU)

Пример: OP7
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B.2 Обзор документации SIMATIC HMI

Это руководство — часть документации SIMATIC HMI. Таблица,
приведенная ниже, объясняет, где и какую информацию следует искать.

Документация Целевая
аудитория

Содержание

Первые шаги с ProTool

Краткое описание

Новички Руководство шаг за шагом
объясняет как создавать и
конфигурировать

•  экранные формы с
различными элементами

•  переключения между
экранными формами

•  сообщения.

Имеются руководства для:

•  Текстовых дисплеев: OP3,
OP5, OP7, OP15, OP17

•  Графических дисплеев:
OP25, OP27, OP35, OP37,
TP27, TP37

•  Систем на базе Windows-:
например,: TP170A, MP270,
OP37/Pro, FI25, FI45

ProTool

Конфигурирование
систем на базе
Windows

Руководство
пользователя

Программисты Описывает работу с пакетом
конфигурирования ProTool/Pro.
Содержит

•  информацию по установке,

•  основные принципы
конфигурирования,

•  детальное описание
конфигурируемых объектов и
функций.

Данное руководство относится к
системам на базе Windows.
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ProTool

Конфигурирование
графических дисплеев

Руководство
пользователя

Программисты Описывает работу с пакетом
конфигурирования ProTool/Pro.
Содержит

•  информацию по установке,

•  основные принципы
конфигурирования,

•  детальное описание
конфигурируемых объектов и
функций.

Данное руководство относится к
операторским терминалам с
графическим дисплеем.

ProTool

Конфигурирование
текстовых дисплеев

Руководство
пользователя

Программисты Описывает работу с пакетом
конфигурирования ProTool/Pro.
Содержит

•  информацию по установке

•  основные принципы
конфигурирования

•  детальное описание
конфигурируемых объектов и
функций.

Данное руководство относится к
операторским терминалам с
текстовым дисплеем.

ProTool

онлайновая справка

Программисты Описывает среду разработки при
конфигурировании в ProTool.
Содержит

•  контекстно–зависимую
справочную информацию

•  детальные инструкции и
примеры

•  детальные описания

•  все сведения, приведенные в
руководстве пользователя.

ProTool/Pro Runtime

Руководство
пользователя

Инженеры–
пусконаладчики,
Пользователи

Описывает среду исполнения
ProTool/Pro Runtime. Содержит
информацию о

•  инсталляции пакета
визуализации ProTool/Pro
Runtime

•  подготовке и работе с ПО в
системах на базе Windows..
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Защита от копирования

Начальное руководство

Инженеры–
пусконаладчики,
Пользователи

Пакет визуализации ProTool/Pro
Runtime защищен авторскими
правами. Руководство описывает
установку, восстановление и
удаление авторизаций.

Примеры применений

Начальное руководство

Новички ProTool снабжен примерами
конфигураций и
соответствующими программами
для PLC. Руководство описывает
как

•  загрузить примеры в
операторский терминал и PLC

•  запустить примеры

•  улучшить связь с PLC, чтобы
она соответствовала Вашему
конкретному приложению.

TP170A
Техническое
руководство

MP270
Техническое
руководство

OP37/Pro
Техническое
руководство

TP27/TP37
Техническое
руководство

OP27/OP37
Техническое
руководство

OP25/OP35/OP45
Техническое
руководство

OP7/OP17
Техническое
руководство

OP5/OP15
Техническое
руководство

TD17
Техническое
руководство

Инженеры–
пусконаладчики,
Пользователи

Содержит информацию об
устройстве и основах
функционирования. Описывает

•  инсталляцию и подготовку к
работе

•  внутреннее устройство

•  связь PLC, принтера и
программатора,

•  режимы работы

•  правила эксплуатации

•  стандартные экранные
формы, поставляемые с
операторским терминалом и
их использование

•  опции монтажа, техническое
обслуживание и замена
запасных частей.
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OP3
Техническое
руководство

Инженеры–
пусконаладчики,
Пользователи,
Программисты

Описывает устройство OP3,
основы ее функционирования и
связь с SIMATIC S7.

Связь

Руководство
пользователя

Программисты Содержит информацию о
подключении текстовых и
графических дисплеев к
следующим PLC:

•  SIMATIC S5

•  SIMATIC S7

•  SIMATIC 500/505

•  другие

Описывает

•  конфигурацию и параметры,
необходимые для
подсоединения этих
устройств к PLC и сети

•  Области пользовательских
данных, используемых для
обмена между операторским
терминалом и PLC

Связь в системах на
базе Windows

Руководство
пользователя

Программисты Содержит информацию о
подключении систем на базе
Windows к следующим PLC:

•  SIMATIC S5

•  SIMATIC S7

•  SIMATIC 505

•  OPC

•  Allen Bradley PLC–5/SLC 500

•  Mitsubishi FX

•  Telemecanique TSX

Описывает

•  конфигурацию и параметры,
необходимые для
подсоединения этих
устройств к PLC и сети

•  Области пользовательских
данных, используемых для
обмена между операторским
терминалом и PLC
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Другие PLC

онлайновая справка

Программисты Содержит информацию о
подключении к PLC таких
устройств, как:

•  OPC

•  Mitsubishi

•  Allen Bradley

•  Telemecanique

•  Modicon

•  Omron

•  SIMATIC WinAC

При инсталляции драйверов
устанавливаются только
имеющие к ним
непосредственное отношение
статьи онлайновой справки..

ProAgent для OP

Руководство
пользователя

Программисты Описывает опциональный пакет
для диагностики
технологического процесса
ProAgent для OP и TP:

•  конфигурирование
диагностических функций,
специфических для каждой
системы

•  обнаружение, локализация и
нахождение причины
неполадки, и ее устранение,

•  модификация стандартных
диагностических экранных
форм, поставляемых в
составе пакета.

ProAgent/Pro

Руководство
пользователя

Программисты Описывает опциональный пакет
для диагностики
технологического процесса
ProAgent для систем на базе
Windows:

•  конфигурирование
диагностических функций,
специфических для каждой
системы

•  обнаружение, локализация и
нахождение причины
неполадки, и ее устранение,

•  модификация стандартных
диагностических экранных
форм, поставляемых в
составе пакета.
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Сокращения

Обзор
В данной документации использованы сокращения, которые имеют
следующие значения:

ANSI American National Standards Institute
Национальный Институт Стандартизации США

ASCII American Standard Code for Information Interchange
Американский стандартный код обмена информацией

CPU Central Processing Unit
Центральный процессор

CSV Comma Separated Values
Значения, разделяемые запятой

HMI Human Machine Interface
Человеко–машинный интерфейс

LED Light-emitting diode
Светодиод

MP Multi-panel
Мультипанель

MPI Multipoint Interface (SIMATIC S7)
Многоточечный интерфейс (SIMATIC S7)

OLE Object Linking and Embedding
Связывание и внедрение объектов

OP Operator panel
Операторская панель

OPC OLE for Process Control
OLE для управления процессами

PC Personal Computer
Персональный компьютер

PLC Programmable logic controller
Программируемый логический контроллер

PPI Point to Point Interface (SIMATIC S7)
Интерфейс “точка–к–точке”

C
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RAM Random access memory (working memory)
Память с произвольной выборкой (рабочая память)

TP Touch Panel
Сенсорная панель
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Глоссарий  

— А —

Аварийное сообщение (Alarm message)
Представляет на операторском терминале информацию, касающуюся
ошибок функционирования механизма или системы, подключенной к PLC.
Текст сообщения может также содержать текущие значения
контролируемых параметров.

Так как аварийные сообщения указывают на ненормальное состояние
системы, они подлежат подтверждению.

Аварийные сообщения: область указателя (Alarm messages: area
pointer)

Для каждого бита этой области данных Вы можете задать аварийное
сообщение. Биты соответствуют номерам сообщений в возрастающем
порядке.

Как только PLC выставляет бит в данной области, операторский терминал
распознает прибытие соответствующего аварийного сообщения. И
наоборот, операторский терминал считает сообщение “убывшим” при
сбросе бита в PLC.

Адресное мультиплексирование (Address multiplexing)
При использовании адресного мультиплексирования параметры адреса
изменяются как функция значения мультиплексируемого тега. Таким
образом, Вы можете обращаться к нескольким областям памяти
адресного пространства PLC (S7 CPU) при помощи одного тега, а не
задавать отдельный тег для каждого адреса.

Архив (Archive)
Область памяти запоминающего устройства, в которой могут храниться
сообщения и теги. Размер архива определяется в среде разработки
ProTool.

— Б —

Базовый текст (Reference text)
В многоязыковых проектах базовый текст является основой для
переводов на другие языки. Базовый текст не подлежит редактированию.
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Базовый язык (Reference language)
В многоязыковых проектах базовый язык (базовый текст) является
основой для перевода текстов на другие языки.

Блоки (Units)
Блок — это секция в S7-PDIAG, последовательность шагов в S7-GRAPH и
граф состояний в S7-HiGraph.

Блоки являются объектами диагностики процесса, осуществляемой при
помощи определений ошибок. Для каждого блока может быть задано
несколько определений ошибок. Блоки могут быть физическими
объектами процесса (например, пресс или штамп), которые в свою
очередь характеризуются некоторыми перемещениями (например,
вперед/назад, вверх/вниз).

Блоки выполняют иерархическое структурирование представления
процесса. Они могут хранить данные, разделяемые всеми иерархически
подчиненными объектами. В качестве подчиненных объектов могут
выступать, например, другие блоки или перемещения

В каждом блоке может содержаться одно или несколько действий.

Буфер обмена (Clipboard)
Область памяти конфигурационного компьютера, используемая пакетом
ProTool при выполнении операций “cut” (“вырезать”), “copy” (“скопировать”)
и “paste” (“вставить”).

Буфер сообщений (Message buffer)
Область памяти операторского терминала, в которой могут храниться
события сообщений в хронологическом порядке в соответствии со
временем их прибытия. Сообщения о событиях и авариях хранятся в
отдельных буферах сообщений.

— В —

Восстановить (Restore)
Используя команду “Restore”(“Восстановить”) Вы можете считать данные,
сохраненные ранее при помощи функции "Backup“ ("Резервировать“)

— Г —

Гистограмма (Bar graph)
Служит для представления значений, получаемых от PLC, в виде
прямоугольных областей. Этот способ применяется для отображения
уровней или другой служебной информации, например, на операторских
терминалах.
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Глобальная функция (Global function)
Глобальные функции не относятся ни к какому конкретному объекту, а
привязаны к определенным событиям. Если, например, Вы определяете
функцию установки бита Set Bit в качестве глобальной функции с
условием Enter Value (Ввод значения), бит устанавливается каждый раз
при вводе значения вне зависимости от выбранного поля.

Глобальный тег (Global tag)
Тег процесса, связанный с PLC. Глобальные теги имеют фиксированные
адреса в PLC. Операторский терминал осуществляет доступ к данным
адресам для чтения и записи данных.

Графический список (Graphic list)
Список, устанавливающий соответствие между значениями тега и
графическими элементами. Это позволяет, например, отображать в поле
вывода операторского терминала не число, а соответствующий ему
графический элемент.

Групповое подтверждение (Group acknowledgement)
Во время конфигурирования каждое аварийное сообщение может быть
включено в состав группы подтверждения. При подтверждении
аварийного сообщения одновременно подтверждаются все остальные
аварийные сообщения той же группы.

Группы подтверждения (Acknowledgement groups)
При конфигурировании Вы можете включать несколько аварийных
сообщений в группу подтверждения. После подтверждения первого
сообщения, одновременно подтверждаются все остальные сообщения,
относящиеся к данной группе. Это позволяет, например, одновременно
подтвердить аварийное сообщение о причине неполадки, и все
сообщения о последующих сбоях (групповое подтверждение)

— Д —

Дата/время: область указателя (Date/time: area pointer)
Операторский терминал записывает в эту область данных дату и время
посредством задач PLC. Эти данные могут быть обработаны программой
PLC.

Действия (Actions)
Действия являются компонентами терминала. В ходе управления,
действия служат для контроля одного исполнительного механизма.

В программной терминологии действие представляет собой

•  сеть в программе LAD/CSF/STL

•  шаг в программе S7–GRAPH

•  состояние в программе S7–HiGraph
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Динамические атрибуты (Dynamic attributes)
При помощи динамических атрибутов можно, например, задавать цвета
полей ввода/вывода в соответствии со значениями тега, а также
устанавливать или сбрасывать признаки мигания и отображения
содержимого поля.

— З —

Загрузка (Download)
Вы можете использовать данную функцию для пересылки исполняемого
файла проекта на операторский терминал. Предварительно, при помощи
стандартного кабеля, необходимо подсоединить терминал к
конфигурационному компьютеру.

Задача PLC (PLC job)
Задачи PLC могут использоваться для активизации функций
операторского терминала, например, отображения экранной формы.

Запрос тренда (Trend request)
Эта область указателей может использоваться PLC для определения
тренда, отображаемого на операторском терминале в текущий момент
времени.

— И —

Иконка (Icon)
Растровый графический элемент фиксированного размера, назначенный,
например, контекстно–зависимой кнопке для пояснения ее
предназначения.

Импортировать (Import)
Используя в ProTool функцию импорта, Вы можете загрузить ранее
экспортированный текстовый файл в Ваш проект. Экспортирование
текстов можно производить, например, с целью их перевода на другой
язык во внешнем текстовом редакторе.

Индикатор сообщений (Message indicator)
Графический символ, отображаемый на операторском терминале в
случае наличия хотя бы одного сообщения.

— К —

Кнопка (Button)
Элемент управления, отображаемый на экране операторского терминала.
Кнопки на операторских терминалах, оборудованных сенсорным экраном,
чувствительны к прикосновениям.
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Компилировать (Compile)
Компиляция означает создание исполняемого файла проекта, который Вы
можете загрузить в операторский терминал. Во время компиляции
производится проверка проекта на наличие ошибок.

Контекстно–зависимая клавиша (Soft key)
Функциональная кнопка на операторском терминале с локальным
присвоением. Функция, вызываемая контекстно–зависимой кнопкой,
может варьироваться в зависимости от отображаемой в текущий момент
экранной формы.

Координирование (Coordination)
Эта область данных может использоваться PLC для опроса статуса
операторского терминала, например:

•  Запуск операторского терминала

•  Текущий режим работы

•  Готовность к связи

— Л —

Локальный тег (Local tag)
Тег не связанный с PLC. Локальные теги доступны только в операторском
терминале.

— М —

Масштаб (Zoom)
Используется для уменьшения или увеличения изображения экранной
формы на конфигурационном компьютере.

— Н —

Направляющая линейка (Guide line)
Вы можете задать горизонтальную направляющую линейку для каждой из
двух осей Y для того, чтобы получить возможность быстро оценить
отклонения реальных значений от их уставок.

Начальное значение (Start value)
Значение, присваиваемое тегу после загрузки нового проекта или после
удаления буфера. Вы можете изменять начальное значение.

Невидимая кнопка (Invisible button)
Кнопка, которая видна только во время конфигурирования, но не во время
исполнения. Компоненты экранной формы, на которые наложены скрытые
кнопки, могут управляться щелчком мыши (в системах на базе Windows)
или нажатием (сенсорный экран).
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Номер экранной формы: область указателя (Screen number: area
pointer)

В этой области данных операторский терминал хранит информацию о
текущей экранной форме. Вы можете проанализировать ее в программе
PLC, например, для вызова другой экранной формы.

— О —

Области указателей (Area pointers)
Задаваемые пользователем области памяти PLC. Данные области
используются для обмена данными между PLC и операторским
терминалом.

Синоним: пользовательская область данных.

Область передачи тренда 1 (Trend transfer area 1)
Эта область данных используется для активизации трендов. Как только
программа PLC устанавливает связанный с трендом бит и
коммуникационный бит тренда в области передачи тренда, операторский
терминал обнаруживает выполнение условия активизации и, в
зависимости от настроек Вашего проекта, считывает либо одно значение,
либо весь буфер.

Область передачи тренда 2 (Trend transfer area 2)
Эта область данных необходима при использовании трендов с
переключаемым буфером. Она имеет точно такую же структуру, как и
область передачи тренда 1.

Объект (Object)
Составляющая часть экранной формы или сообщения. В зависимости от
типа, объекты служат для отображения или ввода текста или числовой
информации на операторском терминале.

Онлайновая справка (Online Help)
При конфигурировании онлайновая справка ProTool предоставляет Вам на
экране контекстно–зависимую информацию.

Операторская панель (Operator panel)
Конфигурируемый операторский терминал, используемый для контроля и
управления различными механизмами и системами.

Остаток буфера (Remaining buffer)
Конфигурируемый параметр буфера сообщений. При переполнении
буфера операторский терминал удаляет события сообщений до тех пор,
пока их количество не станет равно заданному остатку буфера.
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Ось X (X axis)
Горизонтальная координатная ось на графике тренда. Может иметь
маркировку, например, в виде времени или параметра тренда.

Ось Y (Y axis)
Вертикальная координатная ось на графике тренда. Для каждого графика
тренда Вы можете задавать до двух осей Y.

— П —

Пароль (Password)
Символьная строка, которая должна быть введена на операторском
терминале для активизации защищенных функций. Каждому паролю
присваивается определенный уровень пароля.

Переключаемый буфер (Switch buffer)
Второй буфер, который Вы можете создать для тренда профиля. Пока
операторский терминал считывает значения тренда из первого буфера,
PLC уже записывает новые значения во второй буфер. Когда
операторский терминал осуществляет чтение из второго буфера, PLC
записывает первый. Переключаемый буфер служит для предотвращения
перезаписи значений PLC в период чтения тренда операторским
терминалом.

Перекрестная ссылка (Cross–reference)
Перекрестные ссылки определяют, какие объекты проекта ссылаются друг
на друга. Если, например, Вы собираетесь удалить переменную, то по
перекрестной ссылке можно узнать, где в проекте эта переменная
используется.

Перемещения (Movements)
Перемещения относятся к последовательностям процесса, которые могут
отслеживаться при помощи определений ошибок в диагностике процесса.
Для каждого перемещения может быть задано несколько определений
ошибок. Перемещение может содержаться в блоке и представлять
реальное движение части физического объекта технологического
процесса (например, пресс перемещается вверх и вниз)

Перемещения определяются в S7-PDIAG использованием в блоке UDT
"movement".

Переходы (Transitions)
Переход определяет условие продвижения от одного шага к другому
внутри последовательности шагов.

Переходы встречаются только в S7-GRAPH и S7-HiGraph

Период обновления (Update time)
Сумма времен опроса, пересылки и обработки.
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Подсказка (Help text)
Конфигурируемая дополнительная информация о сообщениях, экранных
формах и полях. Подсказка может, например, содержать информацию о
причине сбоя и методах его устранения.

Подтвердить (Acknowledge)
Подтверждая аварийное сообщение, Вы удостоверяете то, что приняли
его во внимание. После этого, сообщение больше не отображается на
экране операторского терминала. Вы можете подтверждать сообщения на
операторском терминале сами, или они могут быть подтверждены PLC.

Если Вы включаете аварийные сообщения в группы подтверждения, Вы
можете подтверждать несколько сообщений одновременно.

Подтверждение OP (OP Acknowledgement)
Данная область указателей используется операторским терминалом для
оповещения PLC о том, какие аварийные сообщения были подтверждены
на операторском терминале.

Подтверждение PLC (PLC Acknowledgement)
Данная область указателей используется PLC для оповещения
операторского терминала о том, какие аварийные сообщения были
подтверждены PLC.

Пользовательская область данных (User data area)
Область данных PLC, задаваемая пользователем. Применяется для
обмена данными между PLC и операторским терминалом.

Синоним: область указателей.

Почтовый ящик задач (Job mailbox)
PLC использует эту область данных для передачи задач PLC в
операторский терминал с целью выполнения определенных функций,
например, отображения экранной формы.

Поле ввода (Input field)
Позволяет пользователю вводить значения, которые затем передаются в
PLC.

Поле вывода (Output field)
Отображает на операторском терминале текущие значения, полученные
от PLC.

Предупреждение переполнения (Overflow warning)
Сообщение, которое выводится на операторском терминале, как только
размер остатка буфера достигает или переходит заданное критическое
значение.
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Прибытие сообщения (Message arrival)
Момент времени, когда сообщение было сгенерировано PLC или
операторским терминалом.

Привязка светодиодов (LED assignment)
PLC использует эту область данных для управления светодиодами,
расположенными в функциональных клавишах операторского терминала.

Протоколирование сообщений (Message logging)
Распечатка сообщений, осуществляемая одновременно с их
отображением на дисплее операторского терминала.

— Р —

Распечатка экрана (Print Screen)
Твердая копия содержимого экранной формы. Открытые окна не
изображаются.

Резервирование (Backup)
Функция резервирования “Backup” используется для создания архивных
копий проектов, создаваемых на операторском терминале. Архивные
данные могут быть считаны при помощи функции "Restore"
(“Восстановить”)

— С —

Система (System)
Аппаратная платформа для исполняемого файла проекта. Она включает

•  PLC

•  операторский терминал

•  принтер

Скорость передачи (Baud rate)
Скорость передачи данных, задаваемая в бит/с.

Событие (Event)
Функции активируются наступлением определенных событий, например,
нажатием или отпусканием какой–либо кнопки. События могут быть
заданы в виде функции объекта.
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Событие сообщения (Message event)
Хранятся в хронологическом порядке в архиве сообщений операторского
терминала. К ним относятся:

•  Прибытие сообщения

•  Подтверждение сообщения

•  Убытие сообщения

Сообщение о событии (Event message)
Представляет на операторском терминале информацию, описывающую
состояние устройства или системы подключенной к PLC. Текст сообщения
может также содержать текущие измеренные значения.

Сообщения о событиях: область указателя (Event messages: area
pointer)

Для каждого бита этой области данных Вы можете задать сообщение о
событии. Биты соответствуют номерам сообщений в возрастающем
порядке.

Как только PLC выставляет бит в данной области, операторский терминал
распознает прибытие соответствующего сообщения о событии. И
наоборот, операторский терминал считает сообщение “убывшим” при
сбросе бита в PLC.

Стандартный тактовый импульс (Standard clock pulse)
Стандартный тактовый импульс операторского терминала является
основным фактором, определяющим, какой период обновления Вы
можете задать, устанавливая цикл опроса тега. Изменяя стандартный
тактовый импульс, Вы меняете цикл опроса всех тегов проекта.

Супервизор (Supervisor)
Пользователь с правами активизации функций высшего уровня пароля.
Супервизор имеет доступ ко всем функциям операторского терминала.

— Т —

Таймаут выхода из системы (Log off time)
Конфигурируемое время, по истечении которого уровень пароля
сбрасывается в ноль, если операторский терминал не использовался.
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Тег (Tag)
Определенная область памяти, в которую можно записать и из которой
можно считать данные. Чтение/запись могут производиться как из/в PLC,
так и из/в операторский терминал. В зависимости от того, привязан тег к
PLC или нет, различают “глобальные” и “локальные” теги.

Текстовый или графический список (Text or graphic list)
Обобщающее название для текстового и графического списков.
Текстовый или графический список сопоставляет текстовую строку или
графический элемент каждому значению тега.

Текстовый список (Text list)
Текстовый список сопоставляет текстовую строку каждому значению тега.
Это означает, например, что вместо числа в поле вывода Вы можете
отображать соответствующий ему текст.

Тип поля (Field type)
Тип поля определяет, позволяет ли объект осуществлять ввод и вывод
числовых значений или символьных строк.

Тренд (Trend)
Тренд непрерывно отображает на операторском терминале в виде линии
или гистограммы значения, поступающие от PLC. В зависимости от типа
получения значений тренда, различают тренды реального времени и
тренды профиля.

Тренд профиля (Pattern trend)
Тип тренда, в котором при установке активирующего бита все его
значения считываются из PLC и отображаются на операторском
терминале в виде кривой. Тренды профиля подходят для отображения
быстрых изменений в случаях, когда важно отразить общую тенденцию
(профиль) тренда, а не конкретные значения.

Тренд реального времени (Realtime trend)
Тип тренда, в котором только одно значение считывается из PLC и
обновляется на экранной форме при каждом цикле или моменте
активизации. В случае если заданное количество значений измеряемого
параметра не достигается, каждое новое значение перезаписывает самое
раннее.

Тренды реального времени подходят для отображения непрерывных
изменений.

— У —

Убытие сообщения (Message departure)
Момент, когда сообщение было отозвано PLC.
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Уровень пароля (Password level)
Права использования операторского терминала могут быть ограничены
для определенных пользователей или групп пользователей. Для этого
отдельным функциям и управляющим элементам присваиваются
иерархически задаваемые уровни пароля.

Уровень пароля, связанный с каждым из паролей, предоставляет права
выполнять на операторском терминале функции, соответствующие
данному или более низкому уровню пароля.

Уставка (Limit value)
Конфигурируемые параметры тега, определяющие диапазон значений.
Попытка задать значение, выходящее за указанный диапазон, может
вызвать следующие эффекты на операторском терминале:

• Поле ввода
введенное значение не принимается

• Поле вывода
значения отображаются другим цветом

• Тренд/Гистограмма
значения отображаются другим цветом

— Ф —

Фиксированное окно (Fixed window)
Окно, всегда появляющееся в верхней части экрана операторского
терминала. Вы можете отрегулировать его высоту. Так как содержимое
фиксированного окна не зависит от отображаемой в данный момент
экранной формы, Вы можете отображать в нем важные теги процесса или,
например, дату и время.

Функциональная кнопка (Function key)
Кнопка на операторском терминале, которой может присваиваться
конфигурируемая функция.

Кнопка с глобально присвоенной функцией инициирует вызов одной и той
же функции независимо от экранной формы, отображаемой в данный
момент.

Функциональная кнопка с локальным присвоением (контекстно–зависимая
кнопка, softkey) может выполнять различные функции для разных
экранных форм.

— Ц —

Цвет изображения (Foreground color)
Цвет изображения, например, у поля вывода определяет цвет выводимых
численных значений или символьных строк. Цвет изображения может
либо задаваться фиксировано, либо динамически изменяться в
зависимости от значения тега.
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Цвет фона (Background color)
Цвет фона, например, у поля вывода может либо задаваться
фиксировано, либо динамически изменяться в зависимости от значения
тега.

Цикл опроса (Acquisition cycle)
Цикл опроса определяет временной интервал, за который PLC производит
обновление значения тега. При нулевом цикле опроса тег обновляется
только в тех случаях, когда на операторском терминале отображаются
экранные формы, сообщения или рецепты, содержащие данный тег.

Цикл опроса кратен стандартному тактовому импульсу.

— Э —

Экранная форма (Screen)
Экранная форма отображает на операторском терминале все логически
связанные данные о технологическом процессе, некоторые из которых
могут быть изменены. Экранные формы составляются из статических и
динамических элементов.

К статическим элементам относятся текст и графика, к динамическим —
поля ввода и вывода.

Экспортировать (Export)
Вы можете экспортировать сконфигурированные сообщения в текстовый
файл, например, для их перевода на другой язык во внешнем текстовом
редакторе.

Используя в ProTool функцию импорта, Вы можете потом загрузить
текстовый файл в Ваш проект.

— Я —

Язык редактирования (Editing language)
Язык, на котором пишутся тексты проекта.

— —

CPU
Сокращение от central processing unit (центральный процессор).

Flash–память (Flash memory)
Программируемая память, содержимое которой электронным способом
может стираться и перезаписываться посегментно.

OP
Сокращение от operator panel — операторская панель.
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PLC
Сокращение от programmable logic controller — программируемый
логический контроллер.

ProTool/Pro
ProTool/Pro представляет собой

•  Графический пакет конфигурирования всего семейства SIMATIC HMI и
стандартных PC.

•  Среду исполнения для систем на базе Windows.
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Информация о проекте, 4-21
Использование внутренних тегов
скрипта и тегов ProTool, 5-146

Использование ресурсов, 5-87

К
Категория цвета, 5-11
Классы отображения, 5-80
выбор, 5-82

Кнопка, 5-24
Кнопка статуса, 5-25
Колонки обзора сообщений, 5-71
Комбинирование нескольких функций,

5-95
Коммуникационные области
сообщений, 5-76
опциональные, 5-76

Комплект поставки ProTool, 2-5
Конвертирование проекта, 4-13
Контекстно–зависимая клавиша, 5-21
Конфигурационное ПО, 2-2
Конфигурация, 5-155

OPC, 5-155
выбор классов отображения, 5-82
установка процедуры оповещения, 5-

82
Конфигурация защиты доступа
обзор, 5-140

Конфигурация области аварийных
сообщений, 5-65

Конфигурирование
сообщения ALARM_S, 5-84

Конфигурирование подсказок
пользователя, 5-135

Конфигурирование смены цвета, 5-136
Конфигурирование списка паролей, 5-
142

Конфигурирование элементов
отображения, 5-14

Конфигурирование элементов
управления, 5-14

Копирование, 4-15

Л
Линейное масштабирование тегов, 5-

39
Локальная функциональная клавиша,

5-21
Локальные функциональные клавиши
задание иконки (обзор), 5-135
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М
Маркировка функциональных клавиш

(обзор), 5-135
Мигание поля (обзор), 5-136
Мигание светодиода (Обзор), 5-137
Минуты, 5-33
Мультиплексирующий тег, 5-42

Н
Назначение клавиатуры
языковая зависимость, 5-162

Настройки для классов сообщений, 5-
63

Невидимая кнопка
обзор, 5-24

Номер сообщения, 5-60
Номер страницы (объект экранных
форм), 5-56

Нотация, 1-4

О
Обзор рецепта?, 5-118
Обзор сообщения
обзор, 5-71

Обзор устройств, конфигурируемых в
ProTool, B-2

Обновление содержимого
операторского терминала, 5-86

Обновление тегов, 5-38
Объекты ProTool, 5-145
Объекты ProTool, которые могут
использоваться в скриптах, 5-145

Объекты в окне проекта, 4-4
Объекты экранных форм, 5-5, 5-56
номер страницы, 5-56

Ограничения, 7-3
Ограничения VBScript, 5-147
Ограничения проектов на азиатских
языках, 5-166

Окно сообщений, 5-73
Окончание работы, 5-140
Окончание работы с операторским
терминалом
обзор, 5-140

Операторская панель, B-2
Оповещение о режиме работы, 5-59
Оповещение о состоянии процесса, 5-

59
Определение цветов, 5-11
Особенности функций преобразования,

5-97
Откат, 4-17, 4-19
Отладка скриптов ProTool, 5-146
Отмена, 4-17, 4-19
Отображение
текущие значения, 5-19

Отображение данных тренда (пример),
5-157

Отображение данных тренда через
интерфейс OPC (пример), 5-157

Отображение и установка времени, 5-
13

Отображение и установка даты, 5-13
Отображение класса сообщения, 5-71
Отображение объектов
обзор, 5-136

Отображение сообщений, 5-73
Отображение сообщений на
операторском терминале, 5-73

Отображение текущих значений, 5-19
Отображение/сокрытие объектов
обзор, 5-136

Отчет, 5-57
обзор, 5-54

П
Параметры функции, 5-94
Пароль
функции, 5-142

Первые шаги, 2-6
Переключаемый буфер, 5-48
Переключатели, 5-27
Перекрестные ссылки (обзор), 4-20
Перемещение объектов
обзор, 5-139

Пересылка
запись, 5-130

Печать, 7-3
данные проекта, 7-2
пример, 7-4

Планировщик, 5-53



Предметный указатель

ProTool: Конфигурирование систем на базе Windows
Версия от 12/99 I-5

Повтор, 4-17
Повторить, 4-19
Поддержка, 1-5
Подпрограмма (пример), 5-148
Подтвердить сообщения, 5-63
Подтверждение, 5-89
Подтверждение сообщения, 5-63
Поле ввода
обзор, 5-20

Поле вывода
обзор, 5-19

Пользовательские функции, 5-96
Поля вывода, 5-19
Последовательность обхода, 5-137
Почтовый ящик данных, 5-126
Почтовый ящик данных (указатель
области), 5-129

Предоставление обзора подсказки, 5-
135

Пример
смена и отображение текущего
режима работы, 5-99

создание индивидуально
настроенной распечатки, 7-4

Пример подпрограммы, 5-148
Пример функции, 5-150
Присвоение авторизации оператора
обзор, 5-140

Проект, 4-5, 4-13, 4-14, 6-2, 6-5
закачка, 6-7
имитация, 6-5
конвертирование, 4-13
конвертирование OP37/Pro в MP270

(пример), 4-14
конвертирование для PC (пример), 4-
14

принципиальные аспекты, 4-2
создание, 4-5
тестирование, 6-2

Протоколирование собщений, 5-69
Процедура
функция (пример), 5-150

Процедура оповещения
ALARM_S, 5-78
установка, 5-82

Процедура, подпрограмма (пример), 5-
148

Прямая пересылка
запись, 5-130

Р
Работа в сети, 5-153
Работа в сети по OPC, 5-153
Разбиение дисплея операторского
терминала, 4-10

Разделяемая база данных
импортиование текстов сообщений,

5-85
Распечатка сообщений, 5-62, 5-63
Распечатка сообщений ALARM_S, 5-89
Редактирование записи, 5-118
Рекомендации по использованию
данного руководства, 1-2

Рецепт, 5-128, 5-132
запись, 5-115
конфигурирование, 5-126, 5-132
обзор, 5-115
определение структуры, 5-126
почтовый ящик данных, 5-126
пример, 5-115
синхронизация с PLC, 5-128
совместимость, 5-131

Рецепты, 5-121, 5-131
сценарии приложения, 5-121

Руководство пользователем, 5-135

С
Сброс, 4-19
Сенсорные панели, B-2
Сервисное обслуживание
функции, 6-10

Серия устройств SIMATIC HMI, B-2
Сетевая конфигурация OPC, 5-155
Системные ограничения, A-2
Системные сообщения, 5-66
Системные сообщения (пример), 5-67
Системные требования для
иностранных языков, 5-159

Системы на базе Windows, B-2
Событие сообщения, 5-71
События для активизации функций, 5-

92
Соглашения
шрифты, 1-4

Создание иконок для функциональных
клавиш (обзор), 5-135

Создание отчета (пример), 5-57
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Создание проекта, 4-5
Сокращения, C-1
Сокрытие объектов
обзор, 5-136

Сообщения, 5-75
архивирование, 5-108
использование ресурсов, 5-87
коммуникационные области, 5-76
конфигурация области аварийных
сообщений, 5-65

переполнение, 5-59
подтверждение, 5-89
редактирование аварийных
сообщений, 5-62

свойства, 5-62
структура, 5-60

Список выбора
обзор, 5-20

Справочная информация, 5-60
Стандартный тактовый импульс, 5-39
Статический текст
обзор, 5-16

Стиль, 5-60
Строка сообщений, 5-73
Суперпользователь, 5-140

Т
Таблица символов
обновление, 3-5

Тактовый импульс активизации, 5-48
Тег
Просмотра/Изменения, 6-9

Тег изменения, 6-9
Тег просмотра, 6-9
Теги, 5-34, 5-35, 5-38, 5-39, 5-40
архивирование, 5-110
граничные значения, 5-35
десятичные позиции, 5-40
линейное масштабирование, 5-39
масштабирование, 5-39
начальное значение, 5-35
обновление, 5-38
определение, 5-34
рецепт, 5-126
свойства, 5-35

Теги в скриптах, 5-146
Текст
статический, 5-16

Текст сообщения, 5-60

Текстовые дисплеи, B-2
Текстовые и графические списки, 5-45
Текстовые списки, 5-45
Текстовый или графический список
рецепт, 5-126

Тип устройства, 4-21
Типы объектов в окне проекта, 4-4
Требования к памяти, 4-21
Тренд профиля, 5-22, 5-48
Тренд реального времени, 5-22, 5-48
Тренды
обзор, 5-48

У
Указатели областей, 5-76
Указатель области
почтовый ящик данных, 5-129

Управление проектами
автономный режим, 7-7
интегрированный режим, 7-7

Уровень пароля, 5-140
Установка процедуры оповещения, 5-

82
Установка указателей областей, 4-7
Установка шрифтов, 5-12

Ф
Фиксирующаяся кнопка, 5-25
Фильтрация сообщений, 5-63
Функции, 5-75, 5-130, 5-142
архивирования, 5-113
изменение значений, 5-44
оповещение, 5-62
отображения сообщений, 5-75
пароль, 5-142
сервисное обслуживание, 6-10

Функциональная клавиша, 5-21
Функциональные клавиши
задание иконки (обзор), 5-135

Функция (пример), 5-150
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Ц
Цвета, 5-11
Цвета по умолчанию, 5-11
Цвета проекта, 5-11
Цикл опроса, 5-39
Цифровые часы, 5-33

Ч
Часы, 5-33

Э
Экземпляр DB, 3-5
Экран рецепта, 5-125

Я
Язык пользовательского интерфейса,

5-160
Язык проекта, 5-160
Язык редактирования, 5-160
Языки, 5-160, 5-166
конфигурируемые, 5-161
системные сообщения, 5-161
создание многоязыкового проекта, 5-
164

стандартные экраны, 5-161
требования к конфигурированию
азиатских языков, 5-165

Языки системных сообщений, 5-161
Языковая зависимость
назначение клавиатуры, 5-162
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